ApplicationXtender
Workflow
Version Number 5.30

ADMINISTRATOR’S GUIDE
Preface........................................................................................................................................................................... ix

Chapter 1  Introduction to ApplicationXtender Workflow
Introduction .................................................................................................................. 1-2
What is a Business Process? .................................................................................. 1-3
What is a Workflow? ............................................................................................... 1-3
Workflow Customers ............................................................................................... 1-3
Workflow Performers ............................................................................................ 1-3
Workflow Observers ............................................................................................... 1-3
Workflow Rules ....................................................................................................... 1-4
Ad hoc Workflow .................................................................................................... 1-4
The ApplicationXtender Workflow Environment .................................................. 1-5
Preliminary Considerations .................................................................................... 1-5
Specifications and Requirements .......................................................................... 1-5
Recommended Server Specifications .................................................................... 1-5
Recommended Workstation Specifications ............................................................ 1-6
ApplicationXtender Workflow Host Applications .................................................. 1-9
ApplicationXtender ................................................................................................. 1-9
ApplicationXtender Workflow Standalone Client .................................................. 1-10
ApplicationXtender Workflow Web Access ............................................................. 1-11

Chapter 2  Installing ApplicationXtender Workflow
Introduction ................................................................................................................. 2-2
ApplicationXtender Workflow Installation Components ....................................... 2-4
Microsoft SQL Server ............................................................................................. 2-6
Windows 2000 Server ............................................................................................. 2-7
Microsoft 2000 Server Service Pack ...................................................................... 2-7
Microsoft Exchange Server and Client .................................................................... 2-8
Contents

Installing ApplicationXtender Workflow on a Single Computer ... 2-9
Installing ApplicationXtender Workflow on Multiple Computers 2-11
Installing the ApplicationXtender Workflow Process Manager ..... 2-13
Installing ApplicationXtender Workflow on a Server Machine ..... 2-21
  Starting Setup.......................................................................... 2-21
  Accepting the Licence Agreement ....................................... 2-22
  Entering Required Organization Information.................... 2-23
  Setting the Destination Location ........................................ 2-25
  Selecting the Installation Type................................. 2-25
  Selecting Features to be Installed ..................................... 2-27
  Configuring ApplicationXtender Workflow for the Web ..... 2-29
  Configuring the Automated Task Manager Properties.... 2-32
  Completing the Installation ................................................ 2-32
Installing ApplicationXtender Workflow on a Client Machine ..... 2-34
Uninstalling ApplicationXtender Workflow ............................. 2-37
  Uninstalling ApplicationXtender Workflow from the Client Machine.............................. 2-37
  Uninstalling ApplicationXtender Workflow from the Server.. 2-37
  Uninstalling the ApplicationXtender Workflow Process Manager .................................. 2-40
Upgrading ApplicationXtender Workflow .............................. 2-42
Installing the ApplicationXtender Workflow Standalone Client.... 2-43
  Uninstalling the ApplicationXtender Workflow Standalone Client .................................. 2-48

Chapter 3 Using the Process Administrator

Starting the Process Administrator ................................. 3-2
Administrator Main Window .............................................. 3-4
Administrator Menu Bar .................................................... 3-5
  Server Menu Commands ........................................... 3-5
  Edit Menu Commands ................................................ 3-34
  Organization Menu Commands .................................. 3-38
  Help Menu Commands .................................................. 3-71
Importing User Identities ................................................. 3-73
Import Identities from Windows NT ................................. 3-73

ApplicationXtender Workflow Administrator's Guide
Chapter 4 Using the ApplicationXtender Workflow Administrator

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>4-2</td>
</tr>
<tr>
<td>Opening ApplicationXtender Workflow Administrator</td>
<td>4-3</td>
</tr>
<tr>
<td>Toolbar Buttons</td>
<td>4-4</td>
</tr>
<tr>
<td>Action Menu</td>
<td>4-5</td>
</tr>
<tr>
<td>View Menu</td>
<td>4-9</td>
</tr>
<tr>
<td>Choosing Columns</td>
<td>4-9</td>
</tr>
<tr>
<td>Customizing MMC Views</td>
<td>4-11</td>
</tr>
<tr>
<td>Common Features in the AppXtender Workflow Administrator...</td>
<td>4-12</td>
</tr>
<tr>
<td>New Window from Here</td>
<td>4-12</td>
</tr>
<tr>
<td>Refresh</td>
<td>4-12</td>
</tr>
<tr>
<td>Export List</td>
<td>4-12</td>
</tr>
<tr>
<td>Help</td>
<td>4-13</td>
</tr>
<tr>
<td>About</td>
<td>4-14</td>
</tr>
<tr>
<td>Managing AppXtender Workflow Servers through the AppXtender Workflow Administrator</td>
<td>4-15</td>
</tr>
<tr>
<td>Connect</td>
<td>4-16</td>
</tr>
<tr>
<td>Disconnect</td>
<td>4-17</td>
</tr>
<tr>
<td>Database Cleanup</td>
<td>4-18</td>
</tr>
<tr>
<td>Server Properties</td>
<td>4-18</td>
</tr>
<tr>
<td>Managing Business Processes Using the AppXtender Workflow Administrator</td>
<td>4-27</td>
</tr>
<tr>
<td>Navigation</td>
<td>4-27</td>
</tr>
<tr>
<td>Applying Filters</td>
<td>4-27</td>
</tr>
<tr>
<td>Removing Filters</td>
<td>4-35</td>
</tr>
<tr>
<td>Business Process Properties</td>
<td>4-35</td>
</tr>
<tr>
<td>Managing Business Process Instances</td>
<td>4-56</td>
</tr>
<tr>
<td>All Node</td>
<td>4-57</td>
</tr>
<tr>
<td>Completed Node</td>
<td>4-57</td>
</tr>
<tr>
<td>In Progress Node</td>
<td>4-58</td>
</tr>
<tr>
<td>Archived Node</td>
<td>4-58</td>
</tr>
<tr>
<td>Reports Node</td>
<td>4-59</td>
</tr>
<tr>
<td>Users Node</td>
<td>4-60</td>
</tr>
<tr>
<td>Working with Business Process Instances</td>
<td>4-60</td>
</tr>
<tr>
<td>Managing Reports</td>
<td>4-65</td>
</tr>
<tr>
<td>Managing Users</td>
<td>4-76</td>
</tr>
<tr>
<td>User Reconciliation</td>
<td>4-77</td>
</tr>
</tbody>
</table>
Contents

User Reassignment................................................................. 4-86
Changing Task Priority.......................................................... 4-87
Exiting the AppXtender Workflow Administrator.............. 4-89

Chapter 5  Using the ApplicationXtender Workflow Import Utility
Introduction...................................................................................... 5-2
Starting the ApplicationXtender Workflow Import Utility ...... 5-3
Monitored Directories................................................................. 5-4
  Adding Monitored Directory Configurations...................... 5-4
  Deleting Monitored Directory Configurations .................... 5-6
  Modifying Monitored Directory Configurations................. 5-7
  Batch Imports ............................................................................ 5-7
ApplicationXtender Workflow Import Utility Service........... 5-9
  Starting the ApplicationXtender Workflow Import Utility Service ........................................................................ 5-9
  Stopping the ApplicationXtender Workflow Import Utility Service ........................................................................ 5-9
Error Logs .................................................................................. 5-10
  Log Levels................................................................................ 5-10

Chapter 6  Using the ApplicationXtender Monitor
Introduction...................................................................................... 6-2
Starting the ApplicationXtender Monitor .................................... 6-3
File Menu .......................................................................................... 6-5
  Settings Dialog Box .................................................................. 6-6
Help Menu ........................................................................................ 6-8
  ApplicationXtender Monitor Polling Intervals ....................... 6-9
Monitoring Services...................................................................... 6-12
  Start Monitoring .................................................................... 6-12
  Stop Monitoring .................................................................... 6-14
  Attaching a Script .................................................................. 6-14
  Detaching a Script .................................................................. 6-15
  Refreshing the Error List ....................................................... 6-16
  Clearing the Error List ......................................................... 6-16
Exiting the ApplicationXtender Monitor .............................. 6-17

Chapter 7  Managing ApplicationXtender Workflow Web Access
Starting the ApplicationXtender Workflow Web Access
Administration Site ........................................................................ 7-2
Logging Out of the ApplicationXtender Workflow Web Access
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator’s Site</td>
<td>7-4</td>
</tr>
<tr>
<td>Configuring AppXtender Workflow Web Access Settings</td>
<td>7-5</td>
</tr>
<tr>
<td>Saving Settings</td>
<td>7-6</td>
</tr>
<tr>
<td>Configuring Workflow Settings</td>
<td>7-7</td>
</tr>
<tr>
<td>Configuring ApplicationXtender Web Access Settings</td>
<td>7-9</td>
</tr>
<tr>
<td>Configuring the Impersonation Account</td>
<td>7-10</td>
</tr>
<tr>
<td>Configuring Page Visibility</td>
<td>7-11</td>
</tr>
<tr>
<td>Managing User Profiles</td>
<td>7-12</td>
</tr>
<tr>
<td>Managing Sessions</td>
<td>7-14</td>
</tr>
<tr>
<td>Monitoring Transactions</td>
<td>7-15</td>
</tr>
<tr>
<td>Viewing ASP .NET Errors</td>
<td>7-17</td>
</tr>
<tr>
<td>Viewing Transaction Errors</td>
<td>7-20</td>
</tr>
</tbody>
</table>

### Appendix A  Modifying Report Presentation
- Introduction                                                        | A-2  |
- WfxRpt.tpl                                                           | A-4  |
- WfxTemp.xsl                                                          | A-6  |

### Appendix B  Integrated Security
- Implementing Integrated Security for AppXtender Workflow            | B-2  |
- Implementing Integrated Security for AppXtender Workflow Web Access | B-3  |
- Configuring IIS for Integrated Security                              | B-3  |
- Editing the Web.Config File                                          | B-5  |

## Index
- i-1
This guide provides instructions on how to install and configure the ApplicationXtender Workflow software.

As part of an effort to improve and enhance the performance and capabilities of its product line, EMC from time to time releases revisions of its hardware and software. Therefore, some functions described in this ApplicationXtender Workflow User’s Guide may not be supported by all revisions of the software or hardware currently in use. For the most up-to-date information on product features, refer to your product release notes. If a product does not function properly or does not function as described in this ApplicationXtender Workflow User’s Guide, please contact your EMC representative.

**Audience**

The information in this guide is intended for system administrators who are responsible for installing software and maintaining the servers and clients on a network. Operators who monitor the daily backups may also find this manual useful.

**Organization**

Here is a list of where information is located in this guide.

<table>
<thead>
<tr>
<th>Table 1</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chapter</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Chapter 1, <em>Introduction to ApplicationXtender Workflow</em></td>
<td>Provides an introduction to ApplicationXtender Workflow and its components.</td>
</tr>
<tr>
<td>Chapter 3, <em>Using the Process Administrator</em></td>
<td>Provides instructions for configuring and using the Process Administrator.</td>
</tr>
</tbody>
</table>
Preface

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4, Using the ApplicationXtender Workflow Administrator</td>
<td>Provides instructions for configuring and using the ApplicationXtender Workflow Administrator.</td>
</tr>
<tr>
<td>Chapter 5, Using the ApplicationXtender Workflow Import Utility</td>
<td>Provides instructions for configuring and using the ApplicationXtender Workflow Import Utility.</td>
</tr>
<tr>
<td>Chapter 6, Using the ApplicationXtender Monitor</td>
<td>Provides instructions for configuring and using the ApplicationXtender Monitor.</td>
</tr>
<tr>
<td>Chapter 7, Managing ApplicationXtender Workflow Web Access</td>
<td>Provides instructions for configuring and using the ApplicationXtender Workflow Web Access Administration site.</td>
</tr>
<tr>
<td>Appendix A, Modifying Report Presentation</td>
<td>Provides instructions for modifying a report presentation.</td>
</tr>
<tr>
<td>Appendix B, Integrated Security</td>
<td>Provides instructions for configuring integrated security.</td>
</tr>
</tbody>
</table>

Related Documentation

Post-release information is contained in the Release Notes for this product. This document is available by clicking the Product Documentation link at customernet.documentum.com. Refer to the web site periodically to view the latest Release Notes. You must have a Technical Support account to access the product documentation on this site. If you do not already have a Technical Support account, request one at support. documentum.com/support/access/dmRegistration.asp.

Related documents include:

- ApplicationXtender Workflow User’s Guide
- ApplicationXtender Workflow Web Access User’s Guide
- ApplicationXtender Workflow Process Builder Guide
- ApplicationXtender Workflow Basic Language Guide

Most of the documents are in Adobe Acrobat Portable Document Format (PDF), and can be viewed by downloading and installing the Adobe Acrobat Reader. The Reader is available in the /viewers/acroread directory on the EMC® Documentation Suite CD-ROM, or directly from Adobe at www.adobe.com. To install and use the Reader on the preferred platform, refer to the instructions in the CD-ROM’s /viewers/acroread/readme.txt file or at the Adobe web site.

Conventions Used in This Guide

EMC uses the following conventions for notes, cautions, warnings, and danger notices.

ApplicationXtender Workflow Administrator’s Guide
A note presents information that is important, but not hazard-related.

**CAUTION**

A caution contains information essential to avoid data loss or damage to the system or equipment. The caution may apply to hardware or software.

**Typographical Conventions**

EMC uses the following type style conventions in this guide:

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AVANT GARDE</strong></td>
<td>Keystrokes</td>
</tr>
<tr>
<td><strong>Palatino,</strong></td>
<td>◆ Dialog box, button, icon, and menu items in text</td>
</tr>
<tr>
<td><strong>bold</strong></td>
<td>◆ Selections you can make from the user interface, including buttons, icons,</td>
</tr>
<tr>
<td></td>
<td>options, and field names</td>
</tr>
<tr>
<td><strong>Palatino,</strong></td>
<td>◆ New terms or unique word usage in text</td>
</tr>
<tr>
<td><strong>italic</strong></td>
<td>◆ Command line arguments when used in text</td>
</tr>
<tr>
<td></td>
<td>◆ Book titles</td>
</tr>
<tr>
<td><strong>Courier,</strong></td>
<td>Arguments used in examples of command line syntax.</td>
</tr>
<tr>
<td><strong>italic</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Courier</strong></td>
<td>System prompts and displays and specific filenames or complete paths. For</td>
</tr>
<tr>
<td></td>
<td>example: working root directory [/user/emc]:</td>
</tr>
<tr>
<td></td>
<td>c:\Program Files\EMC\Symapi\db</td>
</tr>
<tr>
<td><strong>Courier,</strong></td>
<td>◆ User entry. For example:</td>
</tr>
<tr>
<td><strong>bold</strong></td>
<td>symmpoll -p</td>
</tr>
<tr>
<td></td>
<td>◆ Options in command line syntax</td>
</tr>
</tbody>
</table>

**Where to Get Help**

For questions about technical support, call your local sales office or service provider.
If you have a valid EMC service contract, contact EMC Customer Support at:

North America, 1-877-534-2867
Canada, and
Latin America:
Europe, Middle +800-EMC2-EMC2
East, and (+800-3622-3622)*
Africa:
Asia Pacific and +800-EMC2-EMC2 (+800-3622-3622)
Japan:

*Please see dialing instructions on the EMC web site at:
http://customernet.documentum.com/support/access_numbers.htm

Follow the voice menu prompts to open a service call and select the applicable product support.
This chapter provides an overview of ApplicationXtender (AppXtender) Workflow.

- Introduction ........................................................................................................... 1-2
- The ApplicationXtender Workflow Environment .............................................. 1-5
- ApplicationXtender Workflow Host Applications .............................................. 1-9
- ApplicationXtender Workflow Web Access ....................................................... 1-11
Introduction

A workflow system interacts with other software on your computer to automate business processes that, in the past, may have been carried out according to written, memorized, or verbal procedures.

For example, an accountant performing accounts payable tasks for a company knows that when a purchase request is received, there is a specific set of appropriate responses to the request. Either the accountant sends a purchase order back to the person making the request, or they inform the person that the request is refused and explain why. In some cases, they may need to check the request with the supervisor of the person making the request, or with their own supervisor.

If this process was automated using AppXtender Workflow, the purchase request document might arrive attached to an item in the accountant’s Workbox. The choices of how that document should be processed would be available in a drop-down list in the item’s Work On dialog box. The accountant would view the purchase request in AppXtender, import or scan the purchase order into AppXtender, and then choose to send both items back to the person who issued the request.

Understanding how a workflow system works requires an understanding of the concepts central to AppXtender Workflow. A description of each of the concepts is provided in this chapter.

This chapter also provides a description of the AppXtender Workflow environment, which provides you with information regarding hardware and software requirements, supporting software and operating systems, third-party components, database and mail servers.

The concepts behind the Web-enabled version of AppXtender Workflow (ApplicationXtender Workflow Web Access) are also described in this chapter. A description of the AppXtender Workflow Web Access environment, hardware and software requirements, supported software, operating systems, databases, and browsers are provided in this chapter.
What is a Business Process?
A business process is a collection of interactions, or workflows, through which work is transacted for a particular purpose. Rules are set to create a defined sequence for the flow of work within a business process.

What is a Workflow?
A workflow is an interaction between a “customer” and a “performer” involving a request and a response (or series of responses) to that request.

For example, if you are making a purchase request to the accountant in the example described above, you are the customer and the accountant is the performer for an accounting purchase request approval workflow.

In another example, if the accountant needed approval for the request from the accounting supervisor, he or she would start another workflow by requesting that approval. That workflow would be a supervisory accounting purchase request approval workflow. The accountant would be the customer and the supervisor would be the performer in that workflow.

These actions are available to the customer, performer, and observer in each workflow, which is predetermined by the business process map installed on your AppXtender Workflow Server. For questions regarding the workflows that involve you specifically and your role in those workflows, contact your system administrator.

Workflow Customers
A workflow customer is the person who starts a workflow by requesting that a task be performed.

Workflow Performers
A workflow performer is the person(s) who responds to a customer’s request, either by carrying out the requested action, asking for clarification on the request, passing the work on to another performer, or refusing the request.

Workflow Observers
A workflow observer can view details of a business process instance and track its progress through the business process. Observers can also add comments to an instance. For example, a manager or supervisor, as an observer, can view the progress of an instance that has been routed to one of the employees they supervise.
Workflow Rules

A workflow rule defines what happens in response to actions taken within a workflow. Rules are what determine the routing of work from one workflow to another within a business process. When a business process is automated, the person mapping the process decides what will happen in each possible instance.

Ad hoc Workflow

AppXtender Workflow has a feature that allows for the addition of unanticipated steps to a business process. If you need to request work that is not built into the workflow, you can start an Ad hoc workflow. In the accounting scenario above, for example, a particular request might affect the budgets for more than one department, and the accountant might need to contact more than one person for approval. The accountant would start an Ad hoc Workflow and send the appropriate item to the required participants of the workflow.
The ApplicationXtender Workflow Environment

The AppXtender Workflow environment consists of a combination of hardware and software necessary to workflow-enable ApplicationXtender applications. The software is comprised of the AppXtender Workflow software components together with several items of supporting software running on a Windows-based operating system.

For more information, see the following sections:

- Preliminary Considerations on page 1-5
- Specifications and Requirements on page 1-5
- Recommended Server Specifications on page 1-5
- Recommended Workstation Specifications on page 1-6

Preliminary Considerations

It is recommended that the required server software components be installed on a standalone server rather than on a Primary Domain Controller or a Backup Domain Controller.

Specifications and Requirements

There are certain minimum specifications and requirements to run ApplicationXtender Workflow successfully. The following sections describe the minimum server and workstation specifications and requirements for AppXtender Workflow implementations.

Recommended Server Specifications

The following specifications are recommended for a successful AppXtender Workflow implementation.

**Database Server Specifications**

The following hardware specifications are recommended for AppXtender Workflow database servers:

- Pentium IV, 2 GHz
- 1 GB of RAM
- 40 GB of free hard disk space

The following operating systems are supported for AppXtender Workflow database servers:

- Windows 2000 Server (Service Pack 4)
- Windows 2000 Advanced Server (Service Pack 4)
Introduction to ApplicationXtender Workflow

- Windows 2003

The following database is supported for AppXtender Workflow database servers:

- SQL Server 2000

**Process Manager Server Specifications**

The following hardware specifications are recommended for AppXtender Workflow Process Manager servers:

- Pentium IV, 2 GHz
- 1 GB of RAM
- 40 GB of free hard disk space

The following operating systems are supported for AppXtender Workflow Process Manager servers:

- Windows 2000 Server (Service Pack 4)
- Windows 2000 Advanced Server (Service Pack 4)
- Windows 2003

**Web Server Specifications**

The following hardware specifications are recommended for AppXtender Workflow web servers:

- Pentium IV, 2 GHz
- 1 GB of RAM
- 40 GB of free hard disk space

The following operating systems are supported for AppXtender Workflow web servers:

- Windows 2000 Server (Service Pack 4)
- Windows 2000 Advanced Server (Service Pack 4)
- Windows 2003

The following web servers are supported:

- IIS 5.0
- IIS 6.0

**Recommended Workstation Specifications**

Minimum workstation specifications vary depending on which host application is used. The following host applications are available:
Introduction to ApplicationXtender Workflow

The following hardware specifications are recommended for the client machine using AppXtender Workflow in AppXtender or AppXtender Workflow Standalone Client.

- Pentium IV
- 256 MB of RAM
- 165 MB of free hard disk space

The following operating systems are supported.

- Windows 2000 Professional (Service Pack 4)
- Windows 2003
- Windows XP Professional

CAUTION

To take advantage of all features available in AppXtender Workflow 5.30, it is recommended that you use a correlating version of ApplicationXtender and ApplicationXtender Web Access.

The following hardware specifications are recommended for the client machine using AppXtender Workflow Web Access:

- Pentium III
- 128 MB of RAM

The following operating systems are supported for the client machine using AppXtender Workflow Web Access:

- Windows 2000 Professional (Service Pack 4)
- Windows 2003
- Windows XP Professional

The following internet browser is supported for the client machine using AppXtender Workflow Web Access:

- Internet Explorer 6.0
Mail Server Requirements

AppXtender Workflow supports Internet (SMTP/POP3) Mail or MS Exchange Server 5.5

Mail configuration is only necessary if SendMail is built into your process map.

If your AppXtender Workflow installation is intended only for evaluation, or for doing application development, the mail server used by the Process Manager can be installed on the same machine as the other components of AppXtender Workflow. However, mail servers, particularly Microsoft Exchange Server, demand considerable memory and processing time, and thus performance will not be optimal with this setup.

It is assumed throughout this guide that your mail server is already installed and running on a separate machine from the machine(s) where you will install the software components of AppXtender Workflow. It is also assumed that your intended AppXtender Workflow users already have email accounts.

An email account for the Process Manager is not required for the system to function. However, an email account for the Process Manager is needed if your users will be initiating business processes via email and/or you want email messages to be sent automatically at particular moments of a business process, such as a notification to users when there is new work in their agendas.

Third-Party Components

The following is a list of third-party components that are installed automatically with AppXtender Workflow. These components are provided on the AppXtender Workflow installation CD.

- MDAC 2.5 (Service Pack 2)
- MDAC 2.7 for Windows XP Professional only
- Microsoft Management Console (MMC) 1.2
- Microsoft Scripting Engine 5.6 (required for debugging capabilities of the AppXtender Workflow Debugger and the AppXtender Workflow Automated Task Manager)
- Microsoft Script Debugger (required for the AppXtender Workflow Debugger and the AppXtender Workflow Automated Task Manager)
ApplicationXtender Workflow Host Applications

The host applications for AppXtender Workflow include ApplicationXtender, ApplicationXtender Workflow Standalone Client, and ApplicationXtender Workflow Web Access.

AppXtender Workflow directly interacts with ApplicationXtender, which is a content management system that allows you to move large amounts of content. AppXtender provides the means to create, enhance, store, retrieve, and output any type of electronic content. AppXtender Workflow documents are stored and retrieved from ApplicationXtender.

For more information, see the following sections:

- ApplicationXtender on page 1-9
- ApplicationXtender Workflow Standalone Client on page 1-10
- ApplicationXtender Workflow Web Access on page 1-11

ApplicationXtender

AppXtender is a content management system that allows your organization to move a large amount of content online in a cost-effective manner. AppXtender provides the means to create, enhance, store, retrieve and output any type of electronic content, optimizing the management and processing of vast amounts of data.

The highest level of organization in AppXtender is the application, which is designed by you (as the system administrator). Applications contain documents. Documents consist of one or more pages. Each document has an index, which acts as a label for the documents. Pages consist of one or more page versions. For more information, refer to the ApplicationXtender Core Components Guide and ApplicationXtender User’s Guide.

The following diagram represents organization of content in ApplicationXtender.
The ApplicationXtender Workflow Standalone Client application is a standalone version of AppXtender Workflow that allows you to have access to full AppXtender Workflow functionality without using AppXtender as a document viewer. The AppXtender Workflow Standalone Client application hosts the Workbox, allowing you to add and remove file system files to the system.

Features in the AppXtender Workflow Standalone Client application are limited in comparison to those in AppXtender. These limitations include, but are not limited to, modifying or annotating documents as you would have been able to do in AppXtender.
ApplicationXtender Workflow Web Access

ApplicationXtender Workflow Web Access enables users to perform AppXtender Workflow-based tasks without the additional installation of software on their machines.

AppXtender Workflow Web Access functionality centers on the Workbox, which provides access to a variety of functions, including the ability to view, delete, start, and work on instances of business processes. You also have the ability to configure Workbox display settings.
This chapter describes procedures for installing ApplicationXtender (AppXtender) Workflow components:

- Introduction ................................................................. 2-2
- ApplicationXtender Workflow Installation Components .......... 2-4
- Microsoft SQL Server ...................................................... 2-6
- Windows 2000 Server .................................................... 2-7
- Microsoft Exchange Server and Client ............................... 2-8
- Installing ApplicationXtender Workflow on a Single Computer 2-9
- Installing ApplicationXtender Workflow on Multiple Computers 2-11
- Installing the ApplicationXtender Workflow Process Manager 2-13
- Installing ApplicationXtender Workflow on a Server Machine 2-21
- Installing ApplicationXtender Workflow on a Client Machine 2-34
- Uninstalling ApplicationXtender Workflow .......................... 2-37
- Upgrading ApplicationXtender Workflow ............................ 2-42
- Installing the ApplicationXtender Workflow Standalone Client 2-43
Installing ApplicationXtender Workflow

Introduction

This chapter describes procedures for installing the following ApplicationXtender Workflow components:

- **AppXtender Workflow Process Administrator** allows you to centrally administer AppXtender Workflow server(s) and users. For more information, see *Using the Process Administrator* on page 3-1.

- **AppXtender Workflow Process Manager** is a service that performs the actions requested by business process participants. For more information, see *Installing the ApplicationXtender Workflow Process Manager* on page 2-13.

- **AppXtender Workflow for ApplicationXtender** (AppXtender) component provides access to the AppXtender Workflow system from within ApplicationXtender. For more information, see *Introduction* on page 1-2 and the *ApplicationXtender Workflow User’s Guide*.

- **AppXtender Workflow for the Web (ApplicationXtender Workflow Web Access)** component enables users to perform AppXtender Workflow-based tasks without the additional installation of software on their machines. For more information, see *Managing ApplicationXtender Workflow Web Access* on page 7-1 and the *ApplicationXtender Workflow Web Access User’s Guide*.

- **AppXtender Workflow for ApplicationXtender Reports Management** component provides access to the AppXtender Workflow to allow the creation of business processes while generating AppXtender Reports Mgmt reports. For more information, refer to the *ApplicationXtender Reports Management Administrator’s Guide*.

- **AppXtender Workflow Administrator** component allows you to centrally administer the AppXtender Workflow system and users. For more information, see *Using the ApplicationXtender Workflow Administrator* on page 4-1.

- **AppXtender Workflow Import Utility** allows users to configure a directory to be monitored for files which will initiate a new workflow instance with that file attached. For more information, see *Using the ApplicationXtender Workflow Import Utility* on page 5-1.
AppXtender Workflow Automated Task Manager component supplements the scripting capabilities of the AppXtender Workflow Process Builder by allowing you to use VBScript or JScript to perform the tasks that you would have performed using a Process Builder Script in the past. AppXtender Workflow Automated Task Manager also supports the use of COM objects in the workflow system. For more information, refer to the ApplicationXtender Workflow Process Builder Guide.

AppXtender Workflow Debugger component allows you to develop, test, and deploy AppXtender Workflow scripts and COM objects. For more information, refer to the ApplicationXtender Workflow Process Builder Guide.

AppXtender Workflow Process Builder allows you to create a Business Process map for a AppXtender Workflow system. For more information, refer to the ApplicationXtender Workflow Process Builder Guide.

ApplicationXtender Workflow Standalone Client utilizes AppXtender Workflow functionality without using ApplicationXtender to display documents. For more information, refer to the ApplicationXtender Workflow User’s Guide.

This chapter is intended to provide detailed instructions for the most common configurations of AppXtender Workflow and to illustrate the general principles of a AppXtender Workflow installation. Upon learning these general principles, you will understand how to configure AppXtender Workflow in any number of different ways and how to expand or reconfigure your AppXtender Workflow installation in the future, should the need arise. This chapter also provides necessary information for installing and upgrading AppXtender Workflow and the ApplicationXtender Workflow Standalone Client.
The AppXtender Workflow installation process requires that several key steps be completed in order for the AppXtender Workflow system to function correctly. You must perform the following, at minimum, for AppXtender Workflow to work properly:

- Make sure SQL Server is installed and configured properly. For more information, see Microsoft SQL Server on page 2-6.
- Install the required components for the AppXtender Workflow Process Manager. For more information, see Installing the ApplicationXtender Workflow Process Manager on page 2-13.
- Install the required components for AppXtender Workflow server. For more information, see Installing ApplicationXtender Workflow on a Server Machine on page 2-21.
- Install AppXtender Workflow client components. For more information, see Installing ApplicationXtender Workflow on a Client Machine on page 2-34.

The following table provides a list of available AppXtender Workflow components per executable and specifies which components are required or optional. This table can be used to ensure that all required AppXtender Workflow components have been installed.

<table>
<thead>
<tr>
<th>Executable</th>
<th>Available Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>WfXPM.exe</td>
<td>• AppXtender Workflow Process Manager (required)</td>
</tr>
<tr>
<td></td>
<td>• Database Creation/Updates (required)</td>
</tr>
<tr>
<td></td>
<td>• Process Administrator (required)</td>
</tr>
<tr>
<td></td>
<td>• Import Names Utilities (optional)</td>
</tr>
<tr>
<td></td>
<td>• Notification Services (optional)</td>
</tr>
</tbody>
</table>
Installing ApplicationXtender Workflow

For more information regarding installation of AppXtender Workflow components, see *Installing ApplicationXtender Workflow on a Server Machine* on page 2-21.

---

### Table 2-1 AppXtender Workflow Components

<table>
<thead>
<tr>
<th>Executable</th>
<th>Available Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>WfXServer.exe</td>
<td>• Administrator (required)</td>
</tr>
<tr>
<td></td>
<td>• AppXtender Workflow for ApplicationXtender (optional)</td>
</tr>
<tr>
<td></td>
<td>• AppXtender Workflow for ApplicationXtender Web Access (optional)</td>
</tr>
<tr>
<td></td>
<td>• AppXtender Workflow for ApplicationXtender Reports Management (optional)</td>
</tr>
<tr>
<td></td>
<td>• Automated Task Manager (optional)</td>
</tr>
<tr>
<td></td>
<td>• AppXtender Workflow Debugger (optional)</td>
</tr>
<tr>
<td></td>
<td>• AppXtender Workflow Import Utility</td>
</tr>
<tr>
<td>WfXClient.exe</td>
<td>• ApplicationXtender Workflow Standalone Client (optional)</td>
</tr>
<tr>
<td></td>
<td>• ApplicationXtender Workflow Process Builder Personal Edition (optional)</td>
</tr>
</tbody>
</table>
Microsoft SQL Server

Perform the following tasks to install and configure Microsoft SQL Server:

1. Install SQL Server.
2. Install the most recent SQL Server service pack.
3. Open the SQL Enterprise Manager. Right-click the server and select Properties. The SQL Server Properties (Configure) page appears. Enable the Connections tab and set the Maximum concurrent user connections to the number of concurrent AppXtender Workflow users plus 15.

If you are using SQL Server for other purposes, be sure to allow for enough for those users as well.

4. Write down the MSSQLServer service log on account. You will need this log on information during AppXtender Workflow setup.
   Account: ______________________
   Password: _____________________

If you are installing AppXtender Workflow Process Manager and SQL Server on separate computers, you must use a domain account. If you are installing them on the same computer, it is acceptable to use the local system account.

5. Stop, then restart the MSSQLServer service.
Windows 2000 Server

It is probable that Windows 2000 Server is already installed and running on the machine where you will install the components of AppXtender Workflow. Make sure you complete the following tasks on your computer:

- Install the TCP/IP network protocol in addition to any other network protocols required by your network (if not done already).
- Specify the IP address, subnet mask, DNS addresses, and default gateway, using information provided by your network administrator or ISP (if not done already).
- Create a Windows 2000 login account and give it both local and domain administrative privileges. Give this account the right to "Log on as a service" (from the Windows User Manager for Domains; go to Policies, select User Rights and click on Show Advanced User Rights). This account will be used to start both the AppXtender Workflow Process Manager and the AppXtender Workflow Admin Agent (optionally) services and will be specified as the Primary Windows 2000 Account for the Exchange mail account you will create in Microsoft Exchange Server and Client on page 2-8.

Microsoft 2000 Server Service Pack

The Windows service pack must be reinstalled after any subsequent installation of a Microsoft software product since subsequent installations will overwrite the service pack files. Be sure to install at least Service Pack 4.
Microsoft Exchange Server and Client

Mail configuration is only necessary if SendMail is built into your process map.

Create a mailbox for the AppXtender Workflow Process Manager on the machine running Exchange Server. Specify the Primary Windows 2000 Account of this mailbox as the one you created earlier to start the AppXtender Workflow Process Manager (at the end of Windows 2000 Server on page 2-7).

Microsoft Outlook must be installed on the machine where you are installing the AppXtender Workflow Process Manager. Create a profile (for example: “wfxagent”) for the AppXtender Workflow Process Manager on this machine corresponding to the mailbox you created above.
Installing ApplicationXtender Workflow on a Single Computer

In a single computer installation, all AppXtender Workflow components are installed on one computer. Performance will not be optimal given the resource-intensive tasks carried out by the various server applications. This is particularly true if your Windows 2000 Server installation is a Primary Domain Controller (PDC); since the PDC is required to perform additional tasks, such as maintaining and replicating the domain's security accounts database and performing network login authentications. Therefore, this configuration is not recommended for normal production purposes. The minimum recommended hardware for this configuration is a 100Mhz Pentium processor, 128 MB of RAM, and a 2GB hard drive.

The following steps must be performed, at minimum, in sequential order for AppXtender Workflow to be installed on a single machine:

1. Install and configure MS SQL Server. For more information, see Microsoft SQL Server on page 2-6.

2. Install the following components from the AppXtender Workflow Process Manager setup (WfxPM.exe):
   - AppXtender Workflow Process Manager
   - Database Creation/Updates
   - Process Administrator.

   For more information, see Installing the ApplicationXtender Workflow Process Manager on page 2-13.
3. Change the AppXtender Workflow Process Manager service log on information to match the MSSQLServer service log on information. For more information, see Microsoft SQL Server on page 2-6.

When you are installing AppXtender Workflow Process Manager and SQL Server on the same computer, it is acceptable to use a local system account.

4. Install Administrator components from the AppXtender Workflow Server setup (WfxServer.exe). For more information, see Installing ApplicationXtender Workflow on a Server Machine on page 2-21.

5. If you are using Workflow for ApplicationXtender, on the License Server, install the Workflow for ApplicationXtender component from the AppXtender Workflow Server setup (WfxServer.exe). For more information, see Installing ApplicationXtender Workflow on a Server Machine on page 2-21 and Selecting Features to be Installed on page 2-27.

- Install the Workbox using the ApplicationXtender Updater on each client computer. For more information, see Installing ApplicationXtender Workflow on a Client Machine on page 2-34.

6. If you are using Workflow with ApplicationXtender Web Access, on the Web server, install the Workflow for the Web component from the AppXtender Workflow Server setup (WfxServer.exe). For more information, see Installing ApplicationXtender Workflow on a Server Machine on page 2-21 and Selecting Features to be Installed on page 2-27.
Installing ApplicationXtender Workflow on Multiple Computers

A multiple computer installation, (with SQL Server, the AppXtender Workflow Process Manager, AppXtender Workflow administration components, and AppXtender Workflow Server components installed on separate computers), offers improved performance.

While your AppXtender Workflow installation can use a single Process Manager engine for a single SQL database server, putting the Process Manager on its own computer can offer substantial performance improvement.

To run the AppXtender Workflow Process Manager service on a different server from your SQL Server, you must install Process Manager Database Creation/Updates on the SQL Server by choosing Custom installation type while running AppXtender Workflow Process Manager setup wizard.

In addition to its several “housekeeping” and monitoring threads, the Manager can run multiple transaction threads. You can set the number of these threads by using the AppXtender Workflow Process Administrator and selecting Server, then Configure Manager. With multi-threading, transactions from several different business processes can be processed in parallel, improving throughput. (Transactions from a single business process will still be processed sequentially.)

The following steps must be performed, at minimum, for AppXtender Workflow to be properly installed on multiple computers.

1. Perform the following on your SQL Server computer:
   - Install and configure SQL Server. For more information, see Microsoft SQL Server on page 2-6.
   - Install the Database Creation/Updates component from the AppXtender Workflow Process Manager setup (WfxPM.exe). For more information, see Installing the ApplicationXtender Workflow Process Manager on page 2-13.

2. On your AppXtender Workflow Process Manager computer, install the AppXtender Workflow Process Manager (WfxPM.exe). For more information, see Installing the ApplicationXtender Workflow Process Manager on page 2-13.
When you are installing AppXtender Workflow Process Manager and SQL Server on separate computers, you must use a domain account.

3. Perform the following on your administrative computer:
   - Install the Process Administrator component from the AppXtender Workflow Process Manager setup (WfxPM.exe). For more information, see Installing the ApplicationXtender Workflow Process Manager on page 2-13.
   - Install the Administrator component from the AppXtender Workflow Server setup (WfxSetup.exe). For more information, see Installing ApplicationXtender Workflow on a Server Machine on page 2-21 and Selecting Features to be Installed on page 2-27.

4. If you are using Workflow with ApplicationXtender, on the License Server computer, install the Workflow for ApplicationXtender component from the AppXtender Workflow Server setup (WfxServer.exe). For more information, see Installing ApplicationXtender Workflow on a Server Machine on page 2-21 and Selecting Features to be Installed on page 2-27.
   - Install the Workbox using the ApplicationXtender Updater on each client computer. For more information, see Installing ApplicationXtender Workflow on a Client Machine on page 2-34.

5. If you are using Workflow with ApplicationXtender Web Access, on the Web server, install the Workflow for the Web component from the AppXtender Workflow Server setup (WfxServer.exe). For more information, see Installing ApplicationXtender Workflow on a Server Machine on page 2-21 and Selecting Features to be Installed on page 2-27.
Installing the ApplicationXtender Workflow Process Manager

The procedure that follows describes installation of the AppXtender Workflow Process Manager transaction manager and the AppXtender Workflow Process Administrator.

The AppXtender Workflow Process Manager installation process follows standard Windows setup wizard rules, with prompts that guide you through the installation process.

To install the AppXtender Workflow Process Manager engine:

1. Close all open applications.
2. Obtain the installation files for ApplicationXtender Workflow Process Manager. You have the following options:
   - Download the Workflow_5.30.xxx.zip file from one of the following locations to a temporary directory on your computer:
     - The Documentum download center (https://documentum.subscribenet.com)
     - The FTP site (ftp.emc.com\Software\AppXtender5.30\WfX_CD\AppXtenderWorkflow)
     Extract the installer zip file to the temporary directory. If you download multiple products, download all of them to the same temporary directory.
   - Insert the ApplicationXtender Workflow 5.30 setup CD-ROM into your CD-ROM drive.
3. In the temporary directory or CD-ROM drive, navigate to and run WfXPM.exe.
4. A dialog box appears indicating that you are about to install AppXtender Workflow Process Manager. Click Yes to continue. The Welcome page appears.
5. Click Next. The User Information page appears.
6. Enter your Name and Company name in the text boxes. Click Next. The Setup Type page appears.

7. You can perform one of the following:
   - If you select the Compact option, you will install only the Process Manager and Database Creation/Update components. Choose the Compact option, if you wish to remotely administer the AppXtender Workflow Server.
If you select the Custom option, you will be able to install specific Process Manager components. For example, the Custom option can be used to install only Process Manager Administrator for remote administration. The following table describes each of the available AppXtender Workflow Process Manager components:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppXtender Workflow Process Manager</td>
<td>Installs the AppXtender Workflow transaction manager. Process Manager is a service that performs the actions requested by business process participants (required).</td>
</tr>
<tr>
<td>Process Administrator</td>
<td>Installs the AppXtender Workflow Process Administrator, which provides the ability to manage users and business process (required). It is the only tool available to install a business process.</td>
</tr>
<tr>
<td>Import Names Utility</td>
<td>Installs the Import Names utility, which allows you to import identities into the Process Administrator (optional).</td>
</tr>
<tr>
<td>Notification Services</td>
<td>Installs the Notification Services component of the Process Manager (optional).</td>
</tr>
<tr>
<td>Database Creation/Updates</td>
<td>Creates/updates the AppXtender Workflow database (required).</td>
</tr>
</tbody>
</table>

8. To change the default Destination Directory, click Browse to navigate to a new directory, and click OK to return to the Setup Type page. Click Next to proceed with the installation. The Process Manager Database Server page appears.

10. Select Standard Security (SQL Server Authentication) and click Next. The Process Manager Database Name page appears.
11. Type the database name (default is wfx) and click Next. The first Process Manager page (for the wfx database) appears.

12. Configure the database settings and click Next to continue with the installation. The second Process Manager Database page (for the wfxarch database) appears.
13. The wfxarch database is used for archiving business process instances that are no longer active. Click Next to accept the default settings and continue with the Process Manager installation wizard. The Messaging Interface Options page appears.

14. You can perform one of the following:

- If you are not using SendMail in your process map, select None.
If you are using the SMTP/POP Messaging Interface, select the SMTP/POP radio button and click Next. The Messaging Interface dialog box appears. Enter the E-Mail Address, SMTP Server name, POP3 Server Name, POP3 Account Name, Password, and Timeout in seconds.

Figure 2-9  Messaging Interface Page for SMTP/POP Dialog Box

If you are using the Exchange MAPI Messaging Interface, select the Exchange MAPI radio button and click Next. The Messaging Interface dialog box appears. Enter Profile Name, Exchange Server Name, and Manager Mailbox address.

Figure 2-10  Messaging Interface Page for MAPI Dialog Box

15. Click Next. The Select Program Folder page appears.
16. Leave the default ApplicationXtender Workflow program folder selected and click Next. The Proceeding with Selected Options page appears.

17. Verify that the configuration options described in the Current Settings box are correct (use the Back button to return to and correct any incorrect items). Click Next to proceed with the installation. The Process Manager Setup screen appears and the AppXtender Workflow Process Manager begins to install.

18. When setup has finished, the Setup Complete page appears.

![Setup Complete Page](image)

**Figure 2-11** Setup Complete Page

19. To run the Administrator, enable the corresponding check box (disable the check box if you do not wish to run the Administrator) and then click Finish.
Installing ApplicationXtender Workflow on a Server Machine

The AppXtender Workflow installation process follows standard Windows setup wizard rules, with prompts that guide you through the installation process. For detailed procedures, follow the instructions contained in each of the following sections:

- Starting Setup on page 2-21
- Accepting the Licence Agreement on page 2-22
- Entering Required Organization Information on page 2-23
- Setting the Destination Location on page 2-25
- Selecting the Installation Type on page 2-25
- Selecting Features to be Installed on page 2-27
- Configuring the Automated Task Manager Properties on page 2-32
- Completing the Installation on page 2-32

Starting Setup

This procedure allows you to begin the setup process.

To begin the setup process:

1. Obtain the installation files for ApplicationXtender Workflow Server. You have the following options:
   - Download the Workflow_5.30.xxx.zip file from one of the following locations to a temporary directory on your computer:
     - The Documentum download center (https://documentum.subscribenet.com)
     - The FTP site (ftp.emc.com\Software\AppXtender5.30\WfX_CD\AppXtenderWorkflow)
   - Insert the 5.30 ApplicationXtender Workflow setup CD-ROM into your CD-ROM drive.

2. In the temporary directory or CD-ROM drive, navigate to and run WfXServer.exe.
3. Depending on your situation, either the Welcome page or the Application Maintenance page appears.
   - If you have never installed AppXtender Workflow, or any of its components, the Welcome page will appear. Click Next to continue with the installation.
   - If you have previously installed AppXtender Workflow, or any of its components, the Application Maintenance page will appear. Enable the Modify radio button and click Next to continue with the installation.

![ApplicationXtender Workflow Server Setup - Application Maintenance Page](image)

**Figure 2-12** ApplicationXtender Workflow Server Setup - Application Maintenance Page

The License Agreement page appears.

**Accepting the Licence Agreement**

The License Agreement page allows you to read and accept the Software License Agreement.
Figure 2-13 ApplicationXtender Workflow Server Setup - License Agreement Page

To continue the setup process:

1. Read the license agreement.

2. You can perform one of the following:
   - Enable the I accept the license agreement option. Click Next to continue with the installation. The Required Information page appears.
   - Enable the I do not accept the license agreement option. If you do not accept the terms of the License Agreement, you must click Cancel to terminate the installation.

Entering Required Organization Information

The Required Information page allows you to provide your full name and the name of your organization. This page also allows you to choose whether to install the application for anyone who uses this computer or only for you.
Figure 2-14 ApplicationXtender Workflow Server Setup - Required Information Page

To continue the setup process:

1. Enter your Full Name in the respective text box.
2. Enter your Organization name in the respective text box.
3. You can perform one of the following:
   - To install AppXtender Workflow for anyone who uses this computer, select the Anyone who uses this computer option.
   - To install AppXtender Workflow for yourself, select Only for me option.

   If your user account does not have administrative rights and you are logged on locally, these options are not available.

4. Click Next to continue with the installation. The Destination Folder page appears.

   If AppXtender Workflow detects another Content Management product(s) already installed on the computer, the setup wizard will use the same destination directory as the other Content Management product(s) and the Destination Folder page will not appear. Instead, the Select Installation Type page will appear. If this is the case, move on to Selecting the Installation Type on page 2-25.
Setting the Destination Location

The Destination Folder page allows you to customize the ApplicationXtender Workflow installation directory.

![ApplicationXtender Workflow Server Setup - Destination Folder Page](image)

To continue the setup process:

- You can perform one of the following:
  - If the destination folder listed is the one you want to use, click Next to continue with the installation.
  - If the destination folder listed is not the one you want to use, click Browse and choose the directory to use. Click OK to return to the Destination Folder page and click Next to continue with the installation.

The Select Installation Type page appears.

Selecting the Installation Type

The Select Installation Type page allows you to choose the type of installation that you need. You can choose a typical, complete, or custom installation.
To continue with the setup process:

- Select the type of installation that you want to use. You have the following options:
  - Typical - installs the Automated Task Manager, Workflow Debugger, Administrator, Workbox, and Import Utility. Click Next to continue. The Automated Task Manager Properties page appears as described in Configuring the Automated Task Manager Properties on page 2-32.
  - Complete - installs all AppXtender Workflow components. Click Next to continue. The Workflow for the Web Properties page appears as described in Configuring AppXtender Workflow for the Web on page 2-29.
  - Custom - allows you to choose which AppXtender Workflow components to install. Click Next to continue. The Select Features page appears as described in Selecting Features to be Installed on page 2-27.

To install ApplicationXtender Workflow Web Access, you must select either the custom or complete installation type.

For a complete list and descriptions of all AppXtender Workflow components, see Installing ApplicationXtender Workflow on page 2-1.
Installing ApplicationXtender Workflow on a Server Machine

Selecting Features to be Installed

The Select Features page allows you to include or exclude specific ApplicationXtender Workflow components from the installation.

Your features list may be different depending on your system configuration.

Figure 2-17 ApplicationXtender Workflow Server Setup - Select Features Page

To include or exclude components:

1. Decide which component(s) you want to include or exclude. The following table describes each of the available components:

Table 2-3 AppXtender Workflow Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Allows you to administer the AppXtender Workflow system and users (required).</td>
</tr>
<tr>
<td>Workflow for the Web</td>
<td>Provides access to the Workflow system using a web browser (optional).</td>
</tr>
<tr>
<td>Workflow for ApplicationXtender Reports Management</td>
<td>Provides access to the Workflow system within AppXtender Reports Mgmt (optional).</td>
</tr>
<tr>
<td>Automated Task Manager</td>
<td>Supplements the scripting capabilities of the AppXtender Workflow Process Builder (optional).</td>
</tr>
<tr>
<td>Workflow Debugger</td>
<td>Allows you to develop, test, and deploy AppXtender Workflow scripts and COM objects (optional).</td>
</tr>
</tbody>
</table>
2. You can select AppXtender Workflow component(s) by clicking on the down arrow of the Feature drop-down list. A list with your choices appears.

3. For each selected component you want to include, you can perform one of the following:
   • To install the selected component, select Will be installed on local hard drive.
   • To install the selected component and all subcomponents, select Entire feature will be installed on local hard drive.
   The icon in front of the selected component will change accordingly to indicate your selection.

4. For each selected component you want to exclude, select Entire feature will be unavailable. The icon in front of the selected component will change accordingly to indicate your selection.

5. If, after changing components to be installed, you would like to reset the components to their default, click Reset.

6. To find out how much space is required for the installation, click the Disk Cost button. The ApplicationXtender Workflow Server Setup disk cost dialog box will display each drive of the workstation where the component(s) will be installed, its available disk space, and the amount of space required for the installation. If there is not enough space available on the drive where you’re trying to install AppXtender Workflow, it will be highlighted.

### Table 2-3  AppXtender Workflow Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow for ApplicationXtender</td>
<td>Provides access to the Workflow system within ApplicationXtender Document Manager (optional).</td>
</tr>
<tr>
<td>Import Utility</td>
<td>Provides the ability to import documents into AppXtender Workflow directly from the file system (optional).</td>
</tr>
</tbody>
</table>
Installing ApplicationXtender Workflow on a Server Machine

To exit the AppXtender Workflow Setup Disk Cost dialog box, click OK.

7. After you have finished selecting which component(s) to install, click Next to continue with the installation. The page that appears next depends on the component(s) you installed.

- If you installed the Workflow for the Web component, the Workflow for the Web Properties page appears. For instructions, see Configuring AppXtender Workflow for the Web on page 2-29.

- If you installed the Automated Task Manager component, the Automated Task Manager Properties page appears. For instructions, see Configuring the Automated Task Manager Properties on page 2-32.

- If you installed both the Automated Task Manager component and the Workflow for the Web component, the Workflow for the Web Properties page appears first.

- If you did not install either of these components, the Ready to Install the Application page appears. For instructions, see Completing the Installation on page 2-32.

Figure 2-19 ApplicationXtender Workflow Server Setup Disk Cost Dialog Box

To exit the AppXtender Workflow Setup Disk Cost dialog box, click OK.

If you elected to install ApplicationXtender Workflow Web Access, then the Workflow for the Web Properties page appears allowing you to configure your Workflow server information.
Installing ApplicationXtender Workflow

To configure the Workflow Server:
1. In the Server text box, enter the name of your AppXtender Workflow server.
2. In the Database text box, enter the name of the AppXtender Workflow database.

To configure the impersonation account:
1. In the Username text box, enter your domain and user name.
2. In the Password text box, enter the password for the entered username.
3. Click Next. A dialog box appears prompting you to enter the awsadmin password.
4. Enter the awsadmin password. Click OK. The ApplicationXtender Web Access Settings page appears.

![Figure 2-22 ApplicationXtender Workflow Setup - ApplicationXtender Web Access Settings Page](image)

The ApplicationXtender Web Access settings are only necessary if you intend to connect to an ApplicationXtender Web Access server.

To configure the ApplicationXtender Web Access settings:

1. In the Web Access URL text box, enter the URL for your AppXtender Web server.
2. For the web service account, enter a AppXtender Web user name and password in the respective text boxes.

   This information may be entered or changed using the ApplicationXtender Workflow Web Access Administrator’s site after installation.

3. Click Next. The page that appears depends on the components you chose to install:

   - If you elected to install the Automated Task Manager component, the Automated Task Manager Properties page appears. For instructions, see Configuring the Automated Task Manager Properties on page 2-32.
Installing ApplicationXtender Workflow

- If not, the Ready to Install page appears. For instructions, see Completing the Installation on page 2-32.

Configuring the Automated Task Manager Properties

The Automated Task Manager Properties page allows you to specify a log on account to be used with the Automated Task Manager. The person performing the installation (or the person logged in to the computer where the installation is being performed) must have administrative privileges for the setup to configure the log on account information.

![Automated Task Manager Properties Page](image)

To continue the setup process:

1. In the User Name text box, enter the log on account user name. Use the domain\user name format.
2. In the Password text box, enter the password.
3. Click Next to continue with the installation. The Ready to Install page appears.

Completing the Installation

The Ready to Install the Application page allows you to change any previously selected settings and components, as well as complete the installation process. If you installed the Database Updates component, you will be prompted to specify the ‘wfxadmin’ password.
To continue the setup process:

1. To change any previously selected settings and/or components, you can click the Back button to display previous pages in the setup wizard.

2. Click Next to continue with the installation. The Updating System page appears and AppXtender Workflow begins installing the components you selected.

3. Wait for AppXtender Workflow to finish the installation process. The Finished page appears.

4. Click Finish to exit the setup wizard.

5. An Installer Information dialog box may appear recommending that you restart your computer. If you receive this message, click Yes to restart your computer. If you do not restart your computer, AppXtender Workflow may not run properly.
Installing ApplicationXtender Workflow on a Client Machine

After you have completed the server installation of the Workbox component on the License Server, you must install the Workbox on every client computer. To install the Workbox, you must run the Check for Updates utility. For more information regarding the Check for Updates utility, refer to the ApplicationXtender Core Components Guide.

To install the Workbox on a client computer:

1. Start and log into ApplicationXtender Document Manager. For instructions, refer to the ApplicationXtender Core Components Guide.
2. From the Utilities menu, select Check for Updates or right-click on a data source, and select Check for Updates. The ApplicationXtender Updater dialog box appears, displaying the Workbox package.

   ![ApplicationXtender Updater Dialog Box](image)

   **Figure 2-24 ApplicationXtender Updater Dialog Box**

3. Make sure the Workbox check box is selected. If the Workbox check box is not selected, the Workbox will not install.
4. Click Continue. The Welcome page appears.
5. Click Next. The License Agreement page appears.
6. You have the following options:

- Enable the I accept the license agreement option and click Next. The Select Features page appears. Move onto the next step.
- Enable the I do not accept the licence agreement option and click Cancel. The installation is canceled.
7. Using the Feature drop-down list, select which components you would like to install. You have the following options:


8. Click Next. The Updating System page appears.

9. After all features have been installed, the Finished page appears. Click Finish to exit the setup.
Uninstalling ApplicationXtender Workflow

You can uninstall AppXtender Workflow if you no longer need to use it on a particular computer.

Close all open applications. It is particularly important that you exit all AppXtender Workflow-related applications. Also, make sure that other users are not accessing the AppXtender Workflow server from other computers while you are uninstalling.

See the following sections for information about uninstalling specific AppXtender Workflow components.

- Uninstalling ApplicationXtender Workflow from the Client Machine on page 2-37
- Uninstalling ApplicationXtender Workflow from the Server on page 2-37
- Uninstalling the ApplicationXtender Workflow Process Manager on page 2-40

Uninstalling ApplicationXtender Workflow from the Client Machine

To uninstall the Workbox from a client machine, perform the following procedure.

To remove AppXtender Workflow from a client machine:

1. From the Windows Start menu, select Settings, then Control Panel. From the Control Panel, select Add/Remove Programs.
2. Select ApplicationXtender Workflow Workbox from the list of programs, and click the Remove button. A confirmation message appears. Click Yes to continue.
3. After the ApplicationXtender Workflow Workbox has been uninstalled from the client machine, the Finished page appears.
4. Click Finish to exit the wizard.

Uninstalling ApplicationXtender Workflow from the Server

You can uninstall each AppXtender Workflow component separately or uninstall all AppXtender Workflow components simultaneously.

To remove AppXtender Workflow from the server:
1. From the Windows Start menu, select Settings, then Control Panel. From the Control Panel, select Add/Remove Programs. Select ApplicationXtender Workflow Server from the list of programs.

2. You can perform one of the following:
   - To uninstall all components simultaneously, click the Remove button. The Updating System page appears (see step 7).
   - To uninstall specific component(s) separately, click the Change button. The Application Maintenance page appears.

3. Enable the Modify radio button. The Select Features page appears.

Figure 2-27 ApplicationXtender Workflow Server Setup - Application Maintenance Page
Uninstalling ApplicationXtender Workflow

4. Decide which component(s) you want to remove. For a complete list components, see ApplicationXtender Workflow Installation Components on page 2-4.

5. You can choose to uninstall specific component(s) by clicking the down arrow of the Feature. The Feature drop-down list appears.

6. For the component(s) you wish to uninstall, select Entire Feature will be unavailable. Click Next. The Updating System page appears.

7. After AppXtender Workflow component(s) have been removed, the Finished page appears.

8. Click Finish to exit the wizard.

9. An Installer Information dialog box may appear recommending that you restart your computer. If you receive this message, click Yes to restart your computer. If you do not restart your computer, AppXtender Workflow may not uninstall properly.
Uninstalling the ApplicationXtender Workflow Process Manager

The ApplicationXtender Workflow Process Manager must be uninstalled separately from other AppXtender Workflow components.

To uninstall the Process Manager:

1. From the Start menu, select Settings, then Control Panel. From the Control Panel, select Add/Remove Programs. Select ApplicationXtender Workflow Process Manager from the list of programs, and click the Remove button. The Confirm File Deletion dialog box appears.

2. Click the Yes button. The Remove Programs from Your Computer page appears.

3. Click OK to exit the wizard. The Process Manager is uninstalled.

Database Cleanup

After uninstalling AppXtender Workflow Process Manager, you should delete logins and databases. You must delete the user logins manually, as described below.

To run database cleanup:

1. Run SQL Enterprise Manager. In the Server Manager window, select the SQL server to which AppXtender Workflow was connected.

2. Expand “Database Devices” and delete the four AppXtender Workflow devices. If you have not changed the default names for these devices, they are called: wfxarcdb, wfxarclg, wfxdb, and wfxlg.

3. Next, expand “Logins.” Delete the four AppXtender Workflow-related logins: awsadmin, awsmanger, awuser, and awxusr. (Do not delete probe, repl_publisher, repl_subscriber, or sa, which are built-in SQL logins.) If you are using Standard Security, you must also delete each of your user logins here.

4. You may now delete the entire Process Manager folder.

There are four AppXtender Workflow SQL files that need to be deleted: wfxdb.dat, wfxlg.dat, wfxarchdb.dat, and wfxarclg.dat. These files are contained in a subdirectory called DATA whose default location is the Process Manager folder. If the location has not been changed, these files are deleted when you delete the Process Manager folder. If the DATA
Installing ApplicationXtender Workflow

subdirectory was installed to a different directory, go to that directory and delete the DATA subdirectory. To retain your data, be sure to back up the databases before deleting them.
Upgrading ApplicationXtender Workflow

To upgrade to from WorkflowXtender version 4.60 or 4.61 to ApplicationXtender Workflow version 5.30, the previous version must first be uninstalled. The AppXtender Workflow installation (WfXServer.exe) will automatically uninstall the previous version before installing version 5.30. This must be performed for both the server and client machines. For more information regarding uninstalling AppXtender Workflow from the server, see Uninstalling ApplicationXtender Workflow from the Server on page 2-37. For more information regarding installation of AppXtender Workflow on a client machine, see Uninstalling ApplicationXtender Workflow from the Client Machine on page 2-37.

By running the latest AppXtender Workflow version setup wizard you can automatically uninstall the previous version of AppXtender Workflow.
Installing ApplicationXtender Workflow Standalone Client

The ApplicationXtender Workflow Standalone Client utilizes full AppXtender Workflow functionality without using ApplicationXtender Document Manager to display documents. The ApplicationXtender Workflow Standalone Client installation wizard (WfXClient.exe) installs the document viewing container and the Workbox simultaneously.

To install the ApplicationXtender Workflow Standalone Client:
1. Close all open applications.
2. Obtain the installation files for ApplicationXtender Workflow. You have the following options:
   • Download the Workflow 5.30.xxx.zip from one of the following locations to a temporary directory on your computer.
     – The Documentum download center (https://documentum.subscribenet.com)
     – The FTP site (ftp.emc.com\Software\AppXtender5.30\WfX_CD\AppXtenderWorkflow)
   Extract the installer zip file to the temporary directory. If you download multiple products, download all of them to the same temporary directory.
   • Insert the ApplicationXtender Workflow 5.30 setup CD-ROM into your CD drive.
3. In the temporary directory or CD-ROM drive, navigate to and run the WfXClient.exe. The Welcome page appears.
4. Click Next to continue with the installation. The License Agreement Page appears.
5. Read the License Agreement. You can perform one of the following:

- Enable the I accept the license agreement option. Click Next to continue with the installation.
- Enable the I do not accept the license agreement option. If you do not accept the terms of the License Agreement, you must click Cancel to terminate the installation.

The User Information page appears.
6. Enter your Full Name in the text box.
7. Enter your Organization name in the text box.
8. You can perform one of the following:
   - To install the ApplicationXtender Workflow Standalone Client for anyone who uses this computer, enable the Anyone who uses this computer radio button.
   - To install the ApplicationXtender Workflow Standalone Client for yourself, enable the Only for me radio button.
9. Click Next to continue with the installation. The Destination Folder page appears.

If the ApplicationXtender Workflow Standalone Client setup wizard detects another Content Management product already installed on this computer, the setup wizard will use the same destination directory as the other Content Management product and the Destination Folder page will not appear.
10. You can perform one of the following:

- If the destination folder listed is the one you want to use, click Next to continue with the installation.

- If the destination folder listed is not the one you want to use, click Browse and choose the destination directory. Click OK to return to the Destination Folder page and click Next to continue with the installation.

The Select Installation Type page appears.
11. Choose the installation type that you want. You have the following options:
   - Typical - installs only the Standalone Client.
   - Custom - allows you to choose which components you want to install.

12. Click Next to continue. The page that appears depends on your installation type.
   - If you chose Typical or Complete, then the Ready to Install page appears. Move onto step 15.
   - If you chose Custom, then the Select Features page appears. Move onto the next step.
Installing ApplicationXtender Workflow

Figure 2-34 ApplicationXtender Workflow Standalone Client Setup - Select Features Page

13. Click the arrow next to each component (the Feature drop-down list appears) to choose whether it will be installed.

14. Click Next. The Ready to Install page appears.

15. To change any previously selected settings, you can click the Back button to display previous pages in the setup wizard.

16. Click Next to continue with the installation. The Updating System page appears.

   Wait for the ApplicationXtender Workflow Standalone Client setup wizard to finish the installation process. The Finished page appears.

17. Click Finish to exit the setup wizard. The ApplicationXtender Workflow Standalone Client is installed.

Uninstalling the ApplicationXtender Workflow Standalone Client

This section describes how to uninstall the ApplicationXtender Workflow Standalone Client.

To uninstall the ApplicationXtender Workflow Standalone Client:

1. You can perform one of the following:
Installing the ApplicationXtender Workflow Standalone Client

- From the Start menu, select Settings, the Control Panel. From the Control Panel, select Add/Remove Programs. Select ApplicationXtender Workflow Standalone Client from the List of Programs and click the Remove button. A confirmation message appears.
  
  Click Yes. The ApplicationXtender Workflow Standalone Client is removed from your computer.

- Double-click on the WfXClient.exe located in your ApplicationXtender Workflow Standalone Client installation directory. The Application Maintenance page appears.

  ![Figure 2-35](image)

  **Figure 2-35 ApplicationXtender Workflow Standalone Client Setup - Application Maintenance Page**

  2. Enable the Remove option and click Next to continue. The Uninstall page appears.

  3. Click Next to continue. The Updating System page appears.

  4. The ApplicationXtender Workflow Standalone Client files are removed from your computer. The Finished page appears.

  5. Click Finish to exit the setup wizard. The ApplicationXtender Workflow Standalone Client is uninstalled.
Installing ApplicationXtender Workflow
This chapter provides a systematic reference for each command on each menu provided by the ApplicationXtender (AppXtender) Workflow Process Administrator. This information is also available as online help, available from the Help menu of the Administrator.

- Starting the Process Administrator .................................................3-2
- Administrator Main Window...........................................................3-4
- Administrator Menu Bar.................................................................3-5
- Importing User Identities...............................................................3-73
Starting the Process Administrator

To start the Process Administrator:

1. From the Windows Start menu, select Program Files and then ApplicationXtender Workflow. From the AppXtender Workflow program group, select Process Administrator. The ApplicationXtender Workflow Administrator starts and the Connect To Server dialog box appears.

2. Enter the name of the Process Manager Server.

3. Enter your Process Administrator Username and Password in the text boxes, if you have one. (The default administrator’s user name is awsadmin with no password.)

4. Click OK.

If you are using Integrated Security, the name you enter in the Username field and your password depend on how you are connecting:

**Local server** - if the Manager you want to administer is running on the same machine as the Administrator, enter “SA” and no password.
Remote Administration - if the Manager you want to administer is running on another machine, enter your Windows login name without the domain prefix. This name must be listed as an AppXtender Workflow user name with administrator rights on the Manager. For more information, see Identities on page 3-39.

If the Manager is running with a SQL Server that was installed with the case-sensitive sort option, then the username field is case sensitive as well.
Using the Process Administrator

Administrator Main Window

The main window of the Administrator program appears when you start the AppXtender Workflow Process Administrator.

Figure 3-2  Administrator Main Window

In the main window, the tile bar identifies the server to which you are connected. You will also see a menu bar near the top of the window, a message area in the middle of the window, and a status bar at the bottom of the window.

The status bar provides the following information:

Table 3-1  Administrator Main Window Status Bar

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>AppXtender Workflow server is running (Started or Stopped).</td>
</tr>
<tr>
<td>Log Status</td>
<td>Shows if messages are being logged or the messages are paused.</td>
</tr>
<tr>
<td>Database</td>
<td>The name of the database currently in use.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user currently logged on to the Administrator.</td>
</tr>
</tbody>
</table>
**Administrator Menu Bar**

The menu bar at the top of the Administrator main window contains four pull-down menus. For more information, see:

- *Server Menu Commands* on page 3-5
- *Edit Menu Commands* on page 3-34
- *Organization Menu Commands* on page 3-38
- *Help Menu Commands* on page 3-71

**Server Menu Commands**

The Server menu provides these commands for managing the server and related server functions:

- *Connecting to a Server* on page 3-5
- *Disconnecting from a Server* on page 3-6
- *Starting the ApplicationXtender Workflow Manager* on page 3-7
- *Stopping the ApplicationXtender Workflow Manager* on page 3-7
- *Pausing/Resuming the ApplicationXtender Workflow Manager* on page 3-7
- *Configuring the ApplicationXtender Workflow Manager* on page 3-7
- *Configuring Your Mail Interface* on page 3-11
- *Archiving Instances* on page 3-13
- *Retrieving Archived Instances* on page 3-18
- *Scheduler* on page 3-21
- *Delayed Processes* on page 3-28
- *DLL Registry* on page 3-30
- *Import Names Registry* on page 3-32
- *Exit* on page 3-34

**Connecting to a Server**

You can connect to a server at any time.

To connect to a server:

1. From the Server menu, select Connect (if you are currently connected to a server this command will not be available; you must first disconnect). The Connect To Server dialog box appears.
Using the Process Administrator

If you have not previously connected to any AppXtender Workflow servers, the default Server name will be the server specified during installation and the default name in the Username field will be *awsadmin* (the initial password for *awsadmin* is blank). Thereafter, the name of the most recent user will appear in the Username field, and a list of all servers that have been accessed from this Administrator will appear in the Process Manager Server drop-down list.

2. Enter the name of the server (or select the server from the Server drop-down list).

3. Enter your username and password if different from those displayed.

4. Click OK. While the server connection is being made, the status bar displays the message, “Attempting to connect to database server. Please wait.” Once the connection is made, a message in the Administrator main window appears, specifying the name of your machine and the time and date.

In your system, there may be multiple Administrator programs on different machines and multiple Managers. Any Manager can be administered from any Administrator that has a valid network connection. To log on to any Administrator, you must have “Administrator” rights for that installation of the Manager on that machine.

**Disconnecting from a Server**

To disconnect from the server:

- From the Server menu, select Disconnect.
Disconnecting does not stop the Manager. While disconnected from the server, the available menu commands are limited.

To start the Process Manager:

- From the Server menu, select Start Manager.

When the Manager is started, a message is displayed in the Administrator main window and the status bar shows the current server status as “Started.”

To stop the Process Manager:

1. From the Server menu, select Stop Manager.
2. A confirmation message appears. Click OK to continue.

Any operations in progress, such as acts in a workflow, are completed, but no further transactions are processed until the server is restarted. A message is displayed in the Administrator main window and the status bar shows the current server status as “Stopped.”

Occasions when you might want to stop the Manager include when the SQL Server is down or when you want to upgrade DLLs associated with a business process.

To pause the processing of transactions:

- From the Server menu, select Pause.

This has the same effect as stopping the Manager but it is quicker to resume. Pausing can be useful when you need to use the Manager machine for some other purpose.

To resume processing:

- From the Server menu, select Resume.

When the Manager is in pause mode, a message is displayed in the Administrator main window and the status bar shows the current status as “Paused.” When the Manager has resumed processing, a message is displayed in the Administrator main window and the status bar shows the current server status as “Started.”

To set Tuning and Housekeeping parameters:

- From the Server menu, select Configure Manager. The Manager Configuration dialog box appears.
Using the Process Administrator

Figure 3-4 Manager Configuration Dialog Box

Tuning Tab
Specify values in the Tuning tab according to the following considerations:
- *Transaction Threads* on page 3-8
- *Business Process Definition Cache* on page 3-9
- *Business Process Instance Cache* on page 3-9
- *Workflow Cache* on page 3-9

Transaction Threads
The Manager dispatches one thread per transaction. The thread ends after processing the transaction. Manager uses a set of a fixed number of threads to manage transaction processing and interfacing with the email system.

The value you specify in this field is the number of threads that will be dedicated to transaction processing. The default number of transaction threads is 8, which is recommended for a machine with 64MB RAM. If you have a multi-processor machine with more memory, you may increase this value up to 32. However, there are some important considerations in deciding number of threads:

- **SQL Server connections** - The Manager interfaces with two databases and requires a constant number of SQL connections plus a variable number of SQL connections depending upon the number of transaction threads. Depending upon the transaction, each transaction thread may require up to 3 connections (for archive operations). These connections are created and destroyed dynamically. It is suggested that for a 5 client application, the minimum number of SQL server user connections be set to around 100.
◆ **SQL Deadlocks** - The AppXtender Workflow Enterprise Series 4.0 system uses a shared database architecture. The API queues transactions and the Manager processes them and outputs into process database tables (P* tables), which the API queries when queries are issued by the client application. This introduces occasional deadlocks in the SQL server. The Manager has a mechanism to detect and reply in the event of deadlocks. However, if the number of SQL server deadlocks is too high, the number of transaction threads may have to be reduced. You may also need to analyze the client application queries.

**Business Process Definition Cache**
When a business process definition is loaded, the Manager keeps it in the memory cache to improve performance. If the site has a constant number of business process definitions, specify that number in this field so those frequently used definitions will always be in memory.

The Manager uses Least Recently Used (LRU) algorithm to manage this cache. When the business process definition is modified, it is thrown out from cache. Increasing this number requires more memory. In addition, the amount of memory required depends on the size of the associated map (AWO) file.

**Business Process Instance Cache**
When a transaction happens in a business process instance, the Manager keeps it in the memory cache. This increases the transaction throughput on the same business process instance. For example, if many acts are taken in the same BP instance, keeping the instance in memory will increase the throughput.

The Manager uses LRU algorithm to manage this cache. When an error occurs in a transaction for a business process instance, that instance is thrown out from cache and fetched from the database for subsequent transactions. Increasing the number of BP instance requires more memory. In addition, the amount of memory required depends upon the size of the associated map (AWO) file and the data contained in the BP instance.

**Workflow Cache**
This cache is used exclusively to manage isolated ad hoc workflows (those not belonging to a business process instance). Those workflows can be single or group. The management of this cache is similar to that of Business Process Instance cache.
Whenever an API call commits a transaction, it is dispatched to the Transaction Thread.

Business Process definition information from the map as well as linking info (role mapping, organization calendar, DLL linking) is cached for performance in a section of the cache called the Business Process Definition Cache.

**Housekeeping Tab**
The Manager does two types of housekeeping: processed Q entry cleanup and the SQL server statistics.

All the transactions queued by the API are kept in the TXP* tables for transaction queries. These entries are cleared by the setting Server, then Manager Configuration, and Delete processed Q entries older than N days. If the value is 0 days, the Q entries are never cleared. Clearing the processed Q entry data periodically reclaimed database space.

To aid the SQL query optimizer in using the correct index, SQL recommends updating the table statistics. The Manager does this automatically after a fixed number of transactions are executed, or when the Manager is idling after processing some transactions. Please note that this is a time consuming operation for an online database.

To use the Housekeeping tab:
1. Click the Housekeeping tab to open the tab for setting Housekeeping parameters.
Using the Process Administrator

2. Specify a value in the field Delete processed Q entries older than the number of days.

When an API commits a transaction, it is queued in a table called TXPMAIN. When the transaction is processed, the resulting status is updated in TXPMAIN. This Q entry is not deleted by the manager when a transaction is processed, thus an application can query for the transaction status of a performed transaction. However, keeping these entries longer than they are needed wastes database space. Using this configuration option helps to reclaim the database space.

3. Specify a value in the field Update SQL Statistics every the number of transactions.

To perform correct query optimization after table inserts, SQL server requires that statistics on tables be updated with the command UPDATE STATISTICS. The Manager performs this for every 'n' number of transactions performed here to speed up API queries. Updating statistics takes time. If the number of transactions done in a short period is high, you can increase this number to scale according to use. Increasing it too much will degrade performance.

Configuring Your Mail Interface

Your mail interface must be configured in order to use the Send Mail process component in Process Builder. Meaning, if any business processes are designed to send e-mails, and this is not configured, that feature will not work. For more information, refer to the ApplicationXtender Workflow Process Builder Administrator’s Guide.

To set parameters for your mail interface:

- From the Server menu, Select Mail Configuration. The Mail Configuration dialog box appears.
Using the Process Administrator

Figure 3-6 Mail Configuration Dialog Box

Specify values in the Mail Configuration dialog box according to the following considerations:

Table 3-2 Mail Configuration Dialog Box

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail System</td>
<td>The available option will be the system specified during installation. If you have specified different mail systems during separate installations, you will have more than one option.</td>
</tr>
<tr>
<td>Disabled</td>
<td>Indicates current status of selected mail system.</td>
</tr>
<tr>
<td>Module Path</td>
<td>Indicates path of required module, aws_intn.dll.</td>
</tr>
<tr>
<td>MS Exchange</td>
<td>Option applies if mail system is MS Exchange.</td>
</tr>
<tr>
<td>Profile</td>
<td>Name of MS Exchange profile.</td>
</tr>
<tr>
<td>SMTP/POP3</td>
<td>Options apply if mail system is SMTP/POP3.</td>
</tr>
<tr>
<td>E-mail address</td>
<td>Administrator's return address for messages about undeliverable mail.</td>
</tr>
<tr>
<td>SMTP Server</td>
<td>Server name or IP address.</td>
</tr>
<tr>
<td>Port</td>
<td>Default port for SMTP Server is 25.</td>
</tr>
<tr>
<td>POP Account</td>
<td>Name specified in E-mail address.</td>
</tr>
<tr>
<td>POP3 Server</td>
<td>Server name or IP address.</td>
</tr>
<tr>
<td>Port</td>
<td>Default port for POP3 Server is 110.</td>
</tr>
</tbody>
</table>
Using the Process Administrator

Archiving Instances

You can use archiving to improve system performance by limiting the size of the main database. You can set multiple archiving definitions that establish how and when the records of business process instances are moved from the main database to the archive database.

Archive records include all business process properties, definitions for application data, form field attributes, workflows, process components and all other map elements. The APIs can do a full query on archived business process instances.

Use the archive function to create an archive definition for archiving specific business process instances, to modify the archive schedule, to delete a definition from the archive schedule, or to select an archive definition for immediate processing.

You can create and name multiple archive definitions that will each operate separately according to the parameters and schedules you set for each. However, all archive definitions function essentially the same way by moving records of instances from the main database to the archive database.

To create a new definition for archiving business process instances and add the definition to the archive schedule:

1. Select Archive Instances from the Server menu to open the Archive Schedule dialog box.

Table 3-2 Mail Configuration Dialog Box (continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>Password for the POP account.</td>
</tr>
<tr>
<td>Poll Interval</td>
<td>Interval (in seconds) between checks by Manager for mail pending to be processed.</td>
</tr>
<tr>
<td>Factory Ordinal</td>
<td>Entry point of module specified in Module Path field.</td>
</tr>
<tr>
<td>Debug Level</td>
<td>Applies to messages in Message window about errors during processing of mail.</td>
</tr>
<tr>
<td>Send Only</td>
<td>When checked, mail system will send mail but will not process incoming mail.</td>
</tr>
<tr>
<td>Time out</td>
<td>Duration in seconds that Manager will keep trying for a successful connection to get or send mail.</td>
</tr>
</tbody>
</table>
Using the Process Administrator

Figure 3-7  Archive Schedule Dialog Box

2. Click Add. The Add Archive Definition dialog box appears.

Figure 3-8  Add Archive Definition (General) Dialog Box

3. In the General tab of the Archive Definition dialog box, enter a name for the new Archive Definition.
4. In the Definitions field, specify whether the definition to apply to All Business Process definitions or select a Business Process name (from the drop-down list that contains all business process definitions installed on the currently connected server).

5. Select the Status parameters that should apply to your definition:
   • All Completed - instances that have cycled through to Closed
   • Terminated With Error - instances closed due to an error
   • Marked for Archive - instances marked for archive in the Business Process Instances dialog box (or through the API or a script command). For more information, see Retrieving Archived Instances on page 3-18.

6. In the Age field, specify a number of days (one or more) for Last Modified More Than. This will archive instances in which no acts have been taken by participants or by the system in the specified number of days. If the check box is not selected and no date is entered in this field, no age criterion is used.

   There are three check boxes for Status and one check box for Last Modified More Than. When setting a definition, you can select any combination of these four that suits your needs (you must select at least one). If you do select more than one, any definition that meets any selected criterion will be archived according to the schedule you set.

7. Click the Schedule tab to enter a recurrence schedule and start time.
8. Specify how often the archive definition should run. You can select Once for one time only or you can set archiving to recur on a regular basis by specifying the number of days in the Every field.

9. Specify when the archive definition should begin. To select a time and date, click the button to the right of the Start On list box. The Select Date and Time dialog box appears.

**CAUTION**

If you do not specify a schedule date, you will create an archive definition scheduled to run immediately. As soon as you click OK, you will see a confirmation dialog box.
Using the Process Administrator

10. Select the date and time and click OK. The Archive Definition (Schedule) dialog box reappears with the date and time you selected.

11. When finished, click OK. The list in the Archive Schedule dialog box will include the new archive definition by name and will show the next scheduled occurrence and whether or not the archive definition is active.

To deactivate an archive definition:
1. Select an archive definition in the Archive Schedule dialog box.
2. Deselect the check box in the Active column. The definition will remain inactive until you select the Active check box again.

To modify the archive schedule:
1. Select a definition in the Archive Schedule dialog box.
2. Click Modify.
3. Make any needed changes in the Modify Archive Definition dialog box.
4. Click OK to process your changes.

To delete a request from the archive schedule:
1. Select a definition in the schedule in the Archive Schedule dialog box.
2. Click Delete. A confirmation message appears.
3. Click OK to perform the deletion.

To archive instances now:

1. To process an archive definition immediately, select the archive request in the Archive Schedule dialog box
2. Click Do Now. A confirmation message appears.
3. Click OK to send the archive request to the queue.

Business process instances can also be marked for archive through the APIs or through scripts.

Retrieving Archived Instances

The records of business process instances that have been archived can be moved back to the main database with the Retrieve Instances command.

Select Retrieve Instances from the Server menu to open the Retrieve Instances dialog box, which provides a view of the archive database. From this dialog box you can select archived instances by business process, view instance information, delete instances, find instances, and select instances to be retrieved.

To select instances for viewing, deleting, or retrieving:

1. Select Retrieve Instances from the Server menu. The Retrieve Instances dialog box appears.

Figure 3-11 Retrieve Instances (General) Dialog Box
2. Select the appropriate definition from the Business Process Definition drop-down list. The selected definition’s instances appear in the Instances list.

3. Select instances with the usual mouse techniques or use the Select All button, or deselect all with the Select None button, or simultaneously deselect all the currently selected and select all the currently deselected with the Invert Selection button.

To view information about an instance:

1. Select the business process definition from the Business Process Definition drop-down list.

2. Select a single instance from the Instances list.

3. Click View. The Process tab of the Business Process Instance Information dialog box appears. For more information, see Viewing Instances on page 3-61.

![Business Process Instance Information - Process Tab](image_url)
Using the Process Administrator

4. After viewing information, click Close to return to the Retrieve Instances dialog box.

To delete instances from the archive database:

1. In the Retrieve Instances dialog box, select the Business Process definition for which you wish to delete instances.
2. Select the instance(s) to delete.
3. Click Delete to permanently remove the records of this instance from the archive database.

To find instances of a specific business process:

1. Select the business process definition from the Business Process Definition drop-down list.
2. Click Find to open the Find Instances dialog box.
Using the Process Administrator

3-21

Figure 3-14  Find Instance (General) Dialog Box

3. Enter a search string in the Find What field and press OK. Instances for which the name matches the search string are highlighted in the Instances list. If there are no instances that match, a “string not found” message appears.

To select instances for retrieval:

1. Select the business process definition from the Business Process Definition drop-down list and then select the instances to retrieve from the archive database.

2. Click OK. A request to retrieve the selected instances is sent to the server for processing.

Scheduler

You can schedule automatic initiation of events, meetings, reports, and other business processes that occur once or on a recurring basis. Select Scheduler from the Server menu to open the Scheduler Entries dialog box.
Using the Process Administrator

In Scheduler Entries dialog box, you can add a new entry to the schedule, modify an existing entry, or delete an entry from the schedule.

To add a new schedule entry for a one-time event:

1. Select Schedule from the Server menu. The Scheduler Entries dialog box appears.
2. Click Add to open the Add Schedule Entry dialog box.

Figure 3-15 Scheduler Entries (General) Dialog Box

Figure 3-16 Add Schedule Entry Dialog Box
3. Enter a name for the schedule entry in the Entry Name text box. This is the name that will appear in the list in the Schedule Entries dialog box.

4. Select the name of the business process definition using the Business Process Name drop-down list for the text box.

5. Enter a new name for the instance of the business process in the Instance Name field.

When the schedule entry causes recurring initiation of a business process instance, the same name is assigned to every instance, with a date and time string appended to it.

6. In the On Behalf Of drop-down list, select the identity of the user for whom the business process is being initiated. This list is limited to those identities assigned the organizational roles that are mapped to the business process roles that can initiate the business process, as defined in the AppXtender Workflow Process Builder.

7. Select Once.

8. Enter the Date and Time when you want the event to occur. (Click the button next to the Date field to view a calendar from which you can select a date.)

9. Check the Skip Events on Manager Restart box if you want any instances that were scheduled to be initiated while the Manager was down to be skipped when the Manager is restarted.

10. When finished, click OK. The new event is added to the list of schedule entries.

11. Click OK to close the Scheduler Entries dialog box.

To add a new schedule entry for a recurring event:

1. From the Scheduler Entries dialog box, click Add.

2. When the Add Schedule Entry dialog box appears, enter the appropriate information.

3. Click Recurring, and then click Frequency to open the Recurring dialog box.
Figure 3-17  Recurring (General) Dialog Box

4. Select a recurrence pattern from the Occurs drop down list. Your configurations are as follows:

- Day of the Week - Allows you to schedule an event to recur on a specific day of a specific week, such as the 2nd and 4th Monday in April, May, and June, when Day of Week is selected.

Figure 3-18  Recurring (Day of Week) Dialog Box
• Day of Month - Allows you to schedule an event to recur on a specific day of the month, such as the 1st and 15th of the month.

Figure 3-19 Recurring (General—Day of Month) Dialog Box

• Hourly - Allows you to schedule an event to recur on an hourly basis, such as every two hours between midnight and 8am and between 4pm and 8pm.

Figure 3-20 Recurring (General—Hourly) Dialog Box
Using the Process Administrator

- Daily - Allows you to schedule an event to recur on a daily basis, such as the every three days between May 15 and November 30.

![Figure 3-21 Recurring (General—Daily) Dialog Box](image1)

- Weekly - Allows you to schedule an event to recur on a weekly basis, such as every 5th week from January 1 through June 30.

![Figure 3-22 Recurring (General—Weekly) Dialog Box](image2)
Monthly - Allows you to schedule an event to recur on a monthly basis, such as every four months on the last day of the month from June 1, 1996 through December 31, 1998.

5. Enter a Start Date and an End Date.
   - Press the dotted button next to the Start Date or End Date fields to display a calendar from which you can select a date. The Select Date dialog box appears.

Select both a start date and an end date; click OK when done to redisplay the Recurring dialog box.
Using the Process Administrator

6. Select the initiation time for the event and choose the appropriate settings from the remaining list boxes and check boxes. The options for setting the recurrences of the event vary depending upon the type of recurrence selected.

7. From the On Non-Working Day list box, select how the event should be handled on non-working days (such as holidays and weekends). You can choose to skip the event, perform the event as scheduled, or move the event to the next working day.

8. When finished, click OK. The Add Schedule Entry dialog box reappears.

9. Click OK to close this dialog box. The new recurring event is added to the list of schedule entries in the Scheduler Entries dialog box.

To modify an existing schedule entry:

1. Select the schedule entry name from the Scheduler Entries dialog box and click Modify.

   The Modify Schedule Entry dialog box appears. This dialog box contains the same fields as the Add Schedule Entry dialog box. You can alter any field except the entry name and the business process name.

2. Make the required changes by typing over the existing information.

3. Click OK to return to the Scheduler Entries dialog box.

To delete an existing schedule entry:

1. Select the schedule entry name from the Scheduler Entries dialog box.

2. Click the Delete button.

3. In the confirmation message that appears, click Yes.

Delayed Processes

Instances of business processes can be delayed through the APIs. These instances are listed in the Delayed Processes dialog box. To change the time when a delayed process instance is initiated or to delete a delayed business process instance, select Delayed Processes from the Server menu.
Using the Process Administrator

The Delayed Processes dialog box lists all of the instances currently scheduled to be initiated. For each instance, the associated business process definition and initiation date are shown.

To change the initiation time of a delayed process:

1. Select a business process instance in the Delayed Process dialog box.
2. Click Modify Date to open the Select Date and Time dialog box.
3. Select the new date (day, month, and year) and time. Click OK.

To delete a delayed business process instance:

1. Select the instance in the Delayed Process dialog box.

3. Select the new date (day, month, and year) and time. Click OK.
Using the Process Administrator

2. Click Delete.
3. When finished, click Close.

**DLL Registry**

When developers create business process definitions in the Builder, they can specify external links to DLLs. Before you install a business process on the Manager, you must first register any DLLs called by that business process. Use the DLL Registry dialog box.

To register dynamic link library (DLL) files:
- Select DLL Registry from the Server menu.

![DLL Registry Dialog Box](image)

**Figure 3-27 DLL Registry Dialog Box**

To add DLL Modules to the registry:
1. Click Add to open the Register Dynamic Link Library dialog box.

![Register Dynamic Link Library Dialog Box](image)

**Figure 3-28 Register Dynamic Link Library Dialog Box**

2. Enter a name for the DLL in the Reference Name text box. This can be a more descriptive name than the file name.
3. In the Library File Path text box, enter the file name and path. You can also search for the specific DLL you want to add. Click the button next to the Library File Path to open the Browse Dynamic Link Library dialog box.

4. Select the appropriate DLL and click OK to return to the Register Dynamic Link Library dialog box.

5. Click OK to accept the DLL name and filename and add the DLL to the list of DLL modules in the DLL Registry dialog box.

To view DLL attributes:

1. Select a DLL in the DLL Registry dialog box.
2. Click Information to open the Library Attributes dialog box.

This dialog box lists all of the business processes that use the selected DLL. Internal file information from the DLL, the file version and the date (and time) on which the file was last modified, are also included.
To delete DLL Modules from the registry:

1. Select a DLL in the DLL Registry dialog box and click Delete. If the DLL is currently in use, the Delete button will be unavailable. The DLL is removed from the list in the dialog box.

2. Click Close to close the DLL Registry dialog box.

**Import Names Registry**

Users of applications in the AppXtender Workflow system must be registered identities. You can add identities with the Identities command from the Organization menu. For more information, see Identities on page 3-39. You can also register entire lists of identities from other systems with the Import Identities command from the Organization menu. For more information, see Import Identities on page 3-68. For any type of list, such as Microsoft Exchange Users, the Import Names Assistant uses a specific DLL file to interpret the list and import it into the AppXtender Workflow system.

The Administrator comes with several registered DLLs for importing users. If your user list is not one of these types, you can develop a DLL specifically for importing your user list. Once created, the import DLL must be registered before it can be used by the Import Names Assistant.

Select Import Names Registry from the Server menu to open the Import Names Registry dialog box for registering imported DLLs.
When you register an imported DLL, you need to select a file (Library File Name) and assign a Reference Name. The DLL Path is determined by the system and cannot be changed. The Module was registered on machine field shows the name of the machine which you are currently administering.

To add DLL Modules to the import names registry:

1. Click Add to open the Install Import Names Source dialog box.

2. Enter a Source Name (Reference Name) for the DLL.

3. Enter the path and filename of the DLL (Library File Name) in the DLL Name text box. You can also choose to browse the system for the specific DLL you want to register by clicking Browse.
4. Select the appropriate DLL and click OK. The Import Names Registry dialog box reappears. The DLL is added to the list of import DLL modules in the Import Names Registry dialog box.

5. Click Close to exit.

To delete DLL Modules from the import names registry:
1. Select a DLL from the Import Names Registry dialog box
2. Click Delete. A confirmation message appears.

   If the DLL is currently in use, the Delete button is unavailable.

3. Click Yes to confirm the deletion of the selected import DLL. The DLL is removed from the list in the Import Names Registry dialog box.

4. Click Close to exit.

**Exit**

To quit the Administrator:
- From the Server menu, select Exit.

**Edit Menu Commands**

The Edit menu provides commands for viewing, copying, and managing messages in the Process Administrator.

![Figure 3-33 Edit Menu](image)
The following table describes the available features for the Edit menu commands.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause Login/Resume</td>
<td>To pause or resume logging messages. For more information, see Pause/Resume Logging on page 3-35.</td>
</tr>
<tr>
<td>Logging</td>
<td></td>
</tr>
<tr>
<td>Filer</td>
<td>To set filter controlling display of messages to the main Administrator log windows. For more information, see Filter on page 3-35.</td>
</tr>
<tr>
<td>Copy</td>
<td>To copy selected messages to the clipboard. For more information, see Copy on page 3-36.</td>
</tr>
<tr>
<td>Clear</td>
<td>To clear the currently displayed messages from the Administrator log window. For more information, see Clear on page 3-36.</td>
</tr>
<tr>
<td>Copy To</td>
<td>To copy selected messages to a report file. For more information, see Copy To on page 3-36.</td>
</tr>
<tr>
<td>Find</td>
<td>To search for and find specific messages or text in the administrator log window. For more information, see Find on page 3-37.</td>
</tr>
</tbody>
</table>

**Pause/Resume Logging**

Pausing is useful when messages are scrolling quickly and you wish to freeze the screen to read the messages. In addition, if you scroll up to view previously displayed messages, any new messages coming in will bump the display forward unless logging is paused.

To temporarily pause the display of messages to the Administrator message window:

- From the Edit menu, select Pause Logging.

The display of messages will pause and you can focus on existing messages without the scrolling that occurs as new messages are added to the window.

To resume message logging:

- From the Edit menu, select Resume Logging.

Any messages that were suppressed during the pause will be displayed first.

While the Administrator is in pause logging mode, the “Log Status: Paused” message appears in the status bar.

**Filter**

You can control the types of messages displayed in the main Administrator log window.
To set a Filter:
1. From the Edit menu, select Filter. The Filter Messages dialog box appears.

![Filter Messages Dialog Box](image)

Figure 3-34  Filter Messages Dialog Box

2. You have the following options:
   - Show Actions and Errors
   - Show Errors Only
   The filtered messages are displayed in the Administrator log window.

**Copy** You can copy messages in the main Administrator window.

To copy a message:
1. Select a message to be copied.
2. From the Edit menu, select Copy.

**Clear** You can clear messages displayed in the Administrator window.

To clear a message:
- From the Edit menu, select Clear.

If all of the messages are cleared from the Administrator log window, you cannot select a specific message and clear it without removing the rest of the messages.

**Copy To** You can copy selected messages in the Administrator to a report file.

To copy selected messages to a report file:
1. From the Edit menu, select Copy To.
2. In the Copy To dialog box, enter the name of the file to which to save selected messages.

![Copy To Dialog Box](image)

**Figure 3-35 Copy To Dialog Box**

3. Click Save.

**Find**

You can search for a specific message that is displayed in the Administrator window.

To search for specific messages or text in the message window:

1. From the Edit menu, select Find.
2. In the Find dialog box, enter a text string.
3. Check the Match Case check box if relevant.
4. Click OK to locate the message text. The message text is highlighted in the main window.
5. Click Cancel to close the Find dialog box.

![Find Dialog Box](image)

**Figure 3-36 Find Dialog Box**
Using the Process Administrator

Organization Menu Commands

The Organization menu provides commands for managing organizational resources, such as user identities (including importing identities from names services), roles, business processes (including installing new business processes), and calendars for scheduling.

Figure 3-37 Organization menu

The following table describes the available commands in the Organization menu.

Table 3-4 Organization menu features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identities</td>
<td>To add, modify and remove users; and to assign access rights and passwords to workflow participants. For more information, see Identities on page 3-39.</td>
</tr>
<tr>
<td>Roles</td>
<td>To add, modify, delete, and print a listing of organizational roles. For more information, see Roles on page 3-49.</td>
</tr>
<tr>
<td>Business Processes</td>
<td>To add, modify, take on and off line, and delete business process definitions, to view information about business process instances; to extract the business process definition file (the.AWO file) from an installed definition. For more information, see Business Processes on page 3-52.</td>
</tr>
</tbody>
</table>
All users of a AppXtender Workflow application must be registered identities on the Manager server that is running that AppXtender Workflow application. Any identity logged on as an Administrator must be an established identity with Administrator rights for any Manager server that identity connects to.

Select Identities from the Organization menu to open the Identities dialog box for working with identities for your organization.
Every system automatically includes three identities. These identities do not have the privileges necessary to initiate business process instances.

- **Awsadmin** - This is the Admin agent. This user is not counted against your available site licenses.
- **Awsmanager** - This is the AppXtender Workflow Manager. This user is not counted against your available site licenses.
- **Awsuser** - This is a user included for backwards compatibility. If your AppXtender Workflow system has never used earlier versions, you can delete this identity.

When you add a new identity, you must enter an identity name. You can also set up the user’s SQL login ID, authentication (authorization rights), password, and roles in the General tab of the Identities dialog box.

Other organizational information (such as telephone, department, e-mail address etc.) can be added on the Information and Mail tabs.

Use the Custom Attributes tab to add any other categories of information that might be convenient, such as membership in a certain work group or project team.

To add identities, you need to either be logged in as the SQL Administrator (sa) or provide the SQL Administrator password. If you are not logged in as sa, you are prompted for the SQL Administrator password. Enter it when prompted.

To add an identity:

1. In the Identities dialog box, click Add to open the Define Identity (General tab) dialog box.
2. In the General tab, enter the following information:
   - Name - Enter the user's name
   - SQL Login ID - Enter the user’s DB login ID. To log into the SQL server, every AppXtender Workflow user must have a DB login ID; however, users may share the same DB login ID.
     
     If the ID you enter does not already exist, it will be created by the Manager and added to the database server.
   - OS Name - Enter the user’s domain and user name.
     
     This text box must be configured to use integrated security.
   - Authentication—Sets the user’s rights. You have the following options; you can setup the identity as:
     - A User (able to participate in AppXtender Workflow client applications),
     - An Administrator (able to use the AppXtender Workflow Administrator utilities)
     - Both a User and an Administrator.

3. Click Set Password to open the Set Password dialog box for setting or changing the identity’s password. This password is used when logging into an AppXtender Workflow client application or on to the Process Administrator the default is no password.
Using the Process Administrator

4. Type the new password for the user in both fields and click OK to return to the Define Identity (General tab) dialog box. There is no validation or display of the old password.

5. Click Roles in the Define Identity dialog box to open a dialog box for assigning organizational roles to the identity.

6. Select one or more roles in the Organizational Roles list (you can use the standard Windows Ctrl and Shift select techniques to select multiple roles).

7. Click Grant to assign the selected role(s) to the identity you are adding. You can also assign all available roles at the same time by clicking Grant All.
The newly assigned role(s) move from the Organizational Roles list to the Roles Assigned list.

To remove role assignment(s), highlight the role(s) in the Roles Assigned list and click the Revoke or Revoke All buttons.

8. When finished, click OK to return to the Define Identity dialog box.

9. In the Manager text box, enter the name of the identity’s manager or supervisor.

10. Click the Information tab to enter personal information about the identity.

Figure 3-42 Define Identity (Information) Dialog Box

11. Enter additional information about the user.

12. Click the Mail tab to open a tab for specifying Mail address information about the identity.
3. The E-Mail Address should be the user’s e-mail address.

   This field is required if you are using the Send Mail process component in Process Builder. For more information, refer to the ApplicationXtender Workflow Process Builder Administrator’s Guide.

14. Click the Custom Attributes tab to display fields for entering any custom information.
15. Enter any custom attributes that will be useful for categorizing identities. For instance, you might adopt a system in which you use Custom Attribute 1 for cellular phone number.

16. Click OK when done. The new identity is added to the AppXtender Workflow system (and to the SQL database if a new SQL Login ID was entered for the user) and the Identities dialog box reappears.

To modify an existing identity:
1. From the Identities dialog box, select an existing identity in the Identities list and click Modify. The Modify Identity dialog box is the same as the Define Identity dialog box except the identity name is read only.
2. Make any needed changes.
3. Click OK to save your changes.

To delete an identity:
1. From the Identities dialog box, select an existing identity in the Identities list.
2. Click Delete.
3. Click OK in the confirmation dialog box. The selected identity is removed from the Identities list and the AppXtender Workflow system.

Before you can delete an identity, verify that the identity is not assigned to any organizational or business process roles by checking both the Assign Organizational Roles dialog box and the Business Process Definition (Role Mapping) dialog box. If there are any roles assigned to the identity, remove them. For information on removing organizational roles, see Identities on page 3-39. For information on removing business process roles, see Modifying and Deleting Business Processes on page 3-60.

To check the status of work for an identity:
1. From the Identities dialog box, select the identity for whom to check the work status.
2. Click Status to open the Work Status dialog box.
Using the Process Administrator

This dialog box displays information about the number of workflows in which the selected identity is or was a participant. When you select role of user to run statistics on, the Statistics field shows both "open" and "closed" workflows for that user as that role (or for all roles if you select all).

"Open" workflows are workflows in an active business process instance in which the identity has some work pending (or may have work pending in the future). "Closed" workflows are workflows in which the identity participated (these workflows are now closed but they are part of a business process that is not yet closed).

The example below shows statistics for all roles for User Four. For all business process instances, User Four, in the role of “anyone,” has work pending in 3 workflows and was a participant in 0 Closed Workflows. User Four also has work pending as “OrgRole Four” in 3 workflows and was a participant in 0 Closed Workflows.

![Figure 3-45 Work Status Dialog Box](image)

3. From the Select roles of the user to run statistics on drop-down list, select a role (or all roles) for which you want to view workflow information in the Statistics list box.

If you need to transfer this user’s work (as described in the following section), you can use this information to help you decide how to transfer the work to other users.

To transfer work from one identity to another:

1. From the Work Status dialog box, click Transfer to open the Transfer the Work dialog box.
Using the Process Administrator

Figure 3-46 Transfer the Work Dialog Box

2. From the Under What work of the user would you like to transfer? drop-down list, select the role of the user to whom the work is to be transferred to. The work that will be transferred will be only the work assigned to the identity as that role.

3. From the Under To whom? drop-down list, select the user to whom the work should be transferred. The available list will include only those individuals also assigned the role selected above.

4. From the In what workflows? drop-down list, select the workflows to which the transfer applies.

5. Click Do Now to send the request for immediate processing by the server.

   Only work that is currently assigned to the user for the selected role is transferred. If you also want any work that will be assigned in the future to this user to be transferred, use the “Automatic transfer of future work” section of this dialog box to request an automatic transfer of future work or to review pending transfer requests.

6. To request an automatic transfer of all future work for this user, click Add. All work for this identity, in the role(s) specified for the workflow(s) specified, that would have been assigned to this identity will be reassigned to the new identity specified. The
Using the Process Administrator

Current Future Work Transfers dialog box appears, showing the transfer you just added, as well as any other transfers you have made.

To open the Current Future Work Transfers dialog without adding a new entry, click the Review button.

![Current Future Work Transfers (General) Dialog Box]

Figure 3-47  Current Future Work Transfers (General) Dialog Box

7. To delete a future work transfer, select the role to be transferred in the list box and click Delete.

8. When finished, click Close.

To find an identity:

1. From the Identities dialog box, click Find in the Find Identity dialog box.

2. Enter the name, or part of the name, of the identity you want to find; select the Match Case check box if appropriate; and click OK.

The search function will find the first instance of an identity that matches the text string. If the identity is found it will be highlighted in the Identities dialog box. Otherwise, the “String Not Found” message appears.
Using the Process Administrator

Figure 3-48  Find Identity Dialog Box

To print a listing of identities:

1. From the Identities dialog box, select the identities for which to print a listing. You can use the standard Windows Shift and Ctrl for multiple selection techniques.

2. Click Print to open the standard Print dialog box.

3. Click OK to print a list of identities. The printout will include the identity name and mail address and all roles assigned to that identity.

Roles

You use the Roles command to add organizational roles to the AppXtender Workflow system so that these roles can be used in workflows and assigned to AppXtender Workflow users. Organizational roles are determined by the needs of each organization. For information on assigning organizational roles to users, see Identities on page 3-39.

Select Roles from the Organization menu to open the Organizational Roles dialog box for defining roles for your organization.
Using the Process Administrator

To add an organizational role:

1. Click Add to open the Define Organizational Role dialog box.

2. Enter the name of the new role and a description in the appropriate text boxes. You can enter up to 255 characters (approximately 3 lines of text) in the Description box.

3. Click the Assignments tab to assign identities to this role.
Using the Process Administrator

Figure 3-51  Define Organizational Role (Assignment) Dialog Box

The Identities list contains all of the identities assigned to this role. (When creating a new role, this list will be empty.) These identities are also referred to as organizational identities.

4. Click Assign to open the Assign Identities dialog box.

Figure 3-52  Assign Identities (General) Dialog Box

5. Use the usual selection techniques to select one or more identities in the Organizational Identities list. This lists all of the identities that have been added to the Manager on the currently connected server.

6. Click Grant to assign the identities to the role or click Grant All to assign all of the identities in the list to the role. The selected identities are moved to the Assigned Identities list.

7. To change your selections, select the identities and use the Revoke and Revoke All buttons as appropriate.
8. Click OK when done.
9. Click OK in the Define Organizational Roles dialog box to finish adding the new role.

To modify an existing organizational role:
1. From the Organizational Roles dialog box, select an existing role in the Organizational Roles list and click Modify. The Modify Organizational Role (General) dialog box appears. You can alter the Description or make changes in the Assignments tab but you cannot change the name of the organizational role.
2. Make any needed changes and click OK when done.

To delete an organizational role:
1. From the Organizational Roles dialog box, select an existing role in the Organizational Roles list and click Delete.
   If the organizational role is currently assigned to any identities, the Delete button is unavailable. Click the Modify button and remove any assignments in the Assignments tab of the Modify Organizational Role dialog box.
2. Click OK in the confirmation dialog to confirm the deletion. The selected role is removed from the list of available roles in the Organizational Roles list.

To print a list of organizational roles:
1. From the Organizational Roles dialog box, click Print.
2. Select the appropriate settings in the Print dialog box and click OK. The printout includes the name and description for each role and the name of each person assigned to that role.

**Business Processes**

You can install a Business Process definition on a server to which you are connected. From the Business Process Definitions dialog box, business processes can be added, modified, deleted, and taken on and off line. Map files can be retrieved from the business process definition (for use in the Process Builder). You can also view information about specific instances of business process definitions.

Any external DLLs that are needed by the business process definition should be installed before you add the business process. For information on how to install a DLL, see DLL Registry on page 3-30.

To add a new business process:

![Business Process Definitions (General) Dialog Box](image)

**Figure 3-53 Business Process Definitions (General) Dialog Box**

2. Click Add to the Install New Business Process dialog box appears.

![Install Business Process Definition Dialog Box](image)

**Figure 3-54 Install Business Process Definition Dialog Box**

You can also open this dialog box using the Install New Business Processes command from the Organization menu.
3. Select an AppXtender Workflow object file (identified by the .AWO extension). For information on creating these business process definition files, refer to the ApplicationXtender Workflow Process Builder Guide.

4. Click Open, the Add Business Process Definition dialog box appears. This dialog box has four tabs for setting role mapping, external links, calendars, and script execution.

![Figure 3-55: Add Business Process Definition (Role Mapping) Dialog Box](image)

**Mapping Roles**

To understand more about how the AppXtender Workflow system uses roles, refer to the ApplicationXtender Workflow Process Builder Guide. A brief overview is included here.

When a business process is created in the AppXtender Workflow Process Builder, business process roles for that definition are created as well. These roles are assigned to the workflows within the definition. A simple example could be a process in which a sales person asks a credit manager to run a credit check on a customer. In this process, the developer creates one workflow, “run credit check.” “Sales person” role is created and assigned to the workflow role of customer, and a role “credit manager” is created and assigned to the workflow role of performer.

When this business process is installed on a Process Manager for an organization, that organization may not have the specific roles “sales
person” and “credit manager.” Fortunately, the AppXtender Workflow system is designed to accommodate this situation.

Role mapping makes it possible for business processes to be organization independent. When you install a business process definition to the Manager server for your organization, you map the business process roles to the Organizational Roles. For example, you may want work done by the Sales Person (the business process role) to be performed by a role defined in your organization as “Customer Rep.”

In the role mapping tab, you review the Business Process Roles list and the assignment in the Performed By list and make changes as needed. The initial default mapping to the organizational role is Anyone.

In the AppXtender Workflow system, at run time, work can go to a specific individual or to a role. Work sent to a role goes to a voluntary queue where anyone who signs in as that role can perform it. If you want work in a business process to automatically go to a specific person, you can map a Business Process role to a specific default identity. For instance in the example above, the Business process role of “credit manager” might be mapped to the organization role of “credit rep.” There might be more than one person with the role of credit rep but if Bob is the credit rep who usually runs the credit checks, then the default identity can be set as “Bob.”

To map a business process role to an organizational role:

1. In the Role Mapping tab, select a business process role from the list and enable the A List of Organizational Roles radio button.

   Any organizational roles currently assigned to the selected business process role appear (when installing a new business process, the only entry is “anyone”) and the Add and Delete buttons are enabled.

2. Click Add to open the Select Organization Roles dialog box.
Using the Process Administrator

3. Select one or more roles.

4. Click OK to add the roles to the Performed By list in the Add Business Process Definition dialog box.

5. To delete an organizational role from the Performed By list, select the role and click Delete.

Roles can be deleted from this list only one at a time (multi select is not available).

6. To set a Default Identity, scroll through the list box and choose a new default.

This list will include only those identities in your organization that have been assigned the organizational roles mapped to the selected business process role.

External Links
If the business process definition contains scripts requiring calls to external DLLs, these business process DLLs must be mapped to DLLs already registered on your system. For information on how to register a DLL, see DLL Registry on page 3-30.

Because the actual DLLs to be used are specified only at installation, the developer has greater flexibility. When creating the business process definition in the Process Builder, the developer could specify something imprecise like “MAIL.DLL,” then map it to different specific DLLs for different installations.
If a business process is triggered by mail sent to an e-mail address, you specify the address in the External Links tab.

To map a business process DLL to a registered DLL:
1. Click the External Links tab to view DLL mapping information.

![Business Process Definition (External Links) Dialog Box](image)

Each DLL specified in the business process appears in the Business Process Module Name list.

2. For each DLL, click the Registered Name field to the combo box and select from the list of registered DLLs.

To set a business process so that it will be triggered by e-mail:
- In the External Links tab of the Add Business Process Definition dialog box, use the Mailbox Name text box for specifying how e-mail will trigger the business process. Enter the name part of the e-mail address to which users may send email to start the business process.

For example a business process definition is registered with “correspondence” as its Mailbox Name. The server, Cyclops, gathers mail from escyclops@cyclops.company.com. Mail to correspondence@cyclops.company.com is forwarded to escyclops from where the AppXtender Workflow Manager will gather it. When the AppXtender Workflow Manager gathers mail addressed to “correspondence,” it begins the business process.
Using the Process Administrator

Calendar
Within any organization, different groups may work on different calendars. The calendar feature allows you to set multiple calendars that specify working days and times. Calendar settings affect business processes that are governed by cycle times expressed in offsets (such as performance that is supposed to occur three working days after a request). If your organization has multiple calendars (such as one for administration and one for manufacturing), it can be important to specify which one the business process you are installing should use.

To specify an organizational calendar for the business process definition:

1. Click the Calendar tab.

![Business Process Definition (Calendar) Dialog Box](image)

2. Select the calendar you want to use for the business process.
   
   In many cases, the Master Calendar is the only one you will need. For information on adding or modifying calendars, see Calendar on page 3-65.

Script Execution
All the standard BASIC scripting will run in the multi-threaded environment without problems. However, if you have special scripting requirements such as OLE calls or external library (DLL)
calls that are single threaded, use the Script Execution customization tab.

To control how scripts are executed:
1. Click the Script Execution tab.

2. Each transaction is processed by a separate thread in the Manager. Between transactions, the business process instance may be cached in the memory and when a transaction arrives, it is dispatched to a thread. OLE stores some thread specific data. To facilitate this, enable the option Initialize Basic subsystem for each transaction, if you are using OLE calls. Note that there will be some decrease in performance.

The Basic subsystem requires registering all variables in the language, which can degrade performance. Ordinarily, this operation needs to be performed only once on a business process instance and need not be done on each transaction on the business process instance. Each transaction is processed by a different thread and does not pose a problem for most occasions.

However, there are instances where, for each transaction on a business process instance, this initialization should be performed. When the user uses OLE calls (CreateObject) in the script, Initialize Basic subsystem for each transaction options should be checked because OLE requires thread-specific initialization.
3. Click the check box if you wish to Allow only one active Business Process instance.

The Manager processes multiple business process instances of the same business process definition in multiple threads. This means that different threads may execute the same script segment at the same time. If you are making external DLL calls, which are designed to be in a single threaded environment, they may fail. If you are making 16-bit DLL calls, running in a multi-threaded situation, they may crash the system because the calls may not be thread-safe. To disable multithreading of different instances, check this option. This will downgrade performance.

When this option is selected, only one business process instance of a particular business process definition’s transaction will be processed at a time.

4. When you have finished reviewing information and making changes in all four tabs, click OK to return to the Business Process Definitions dialog box. The new business process definition is now listed, and the Online check box is selected.

When a business process definition is online, new instances can be created for that business process definition. When a definition is offline, no new instances can be created for the business process.

**Modifying and Deleting Business Processes**

To modify a business process:

1. From the Business Process Definitions dialog box, select the business process to modify from the Name list.

2. Click Modify to open the Modify Business Process Definitions dialog box.

3. Review the information on the Role Mapping, External Links, Calendar, and Script Execution tabs.

4. Enter any necessary changes on the Role Mapping or Calendar tabs and click OK when done.

You cannot make any changes on the DLL Mapping tab; you can only view current DLL Mapping information.

To delete a business process:
1. From the Business Process Definitions dialog box, select the business process from the Name list and click Delete.

If there is currently an active instance of the business process, the Delete button will be unavailable. (To open a dialog box for deleting active instances, click the Instances button in the Business Process Definitions dialog box.)

2. Click Yes to confirm the deletion. The business process is deleted and removed from the list.

**Retrieving Business Processes**

After a business process has been installed, you may wish to modify the map file on which it was based. If you do not have the original map file, you can extract it from the installed definition, then reopen it in the AppXtender Workflow Process Builder and make any needed modifications.

To retrieve a business process:

1. From the Business Process Definitions dialog box, select the business process from the Name list and click Retrieve. A dialog box appears for specifying where you wish to save the map file.

2. Enter or select a filename, file type, and a directory in which to save the file. Click OK to recover the BP object file (a file with the .AWO extension).

**Viewing Instances**

For each installed business process, you can view information about specific instances that have been started.

To view instances:

1. From the Business Process Definitions dialog box, select the business process definition for which to view instances and click Instances to open the Business Process Instances dialog box.

The name and state of all of the instances for the selected business process are displayed. The state of an instance can be “In Progress,” “Completed,” “Error,” or some other value as set through the API.
Using the Process Administrator

2. To view detailed information, select an instance from the list and click View.

Figure 3-60 Business Process Instances Dialog Box

Figure 3-61 Business Process Instance (Process) Dialog Box

The Business Process Instance Information dialog box contains additional information. Note that the Status entry is defined through the API or the Process Builder.
3. To view workflow information—the Customer, Performer, Observers, state of the workflow and workflow ID, click the Workflows tab.

![Business Process Instance Information](image)

**Figure 3-62** Business Process Instance (Workflows) Dialog Box

4. If you have had the dialog box open for a while, click Refresh to refresh with any information that may have changed.

5. When finished, click Close and return to the Business Process Instances dialog box.

To delete instances:

1. From the Business Process Instances dialog box, select the business process instance to delete and click Delete.

2. Click Yes in the confirmation dialog that appears. The instance is deleted from the list.

3. When finished, click Close and return to the general Business Process Definitions dialog box.

To mark instances for archiving:

1. From the Business Process Instances dialog box, use the usual selection techniques to select one or more business process instances and click Archive.

   In the Mark Business Process instance dialog box, you can click Yes to approve archiving of each instance individually, or Yes to All.
2. Click OK in the dialog box that informs you that archiving will occur during the next archiving transaction for the business process definition.

Archiving involves moving all records of an instance of a business process from the main database to the archive database. Archiving occurs on a schedule. For more information, see Scheduler on page 3-21. When you mark an instance for archiving, the actual archiving occurs only according to the parameters of an archive schedule that you have created for that particular business process (or for all business processes) and with a status of “Marked for Archive.”

To print a listing of business processes:
1. From the general Business Process Definitions dialog box, select the business processes for which to print a listing and click Print.
2. Select the appropriate settings in the Print dialog and click OK.

**Isolated Workflows**

Some workflows are not associated with any business process, such as OnTrack workflows and those created with the AppXtender Workflow APIs.

To view information about these workflows, such as the name, state and workflow participants:
1. Select Isolated Workflows from the Organization menu. The Isolated Workflows dialog box appears.
2. Select an isolated workflow in the list and click View to the open View Isolated Workflow dialog box.

![View Isolated Workflow Dialog Box](image)

3. Review the information and click Close to exit.

**Calendar**

Different groups or individuals within an organization may use separate calendars with different work hours and work days. You can define calendars to accommodate these variances, then assign the appropriate calendar to a given business process. For more information on setting a calendar for a business process, see *Calendar* on page 3-65.

To view and modify the organizational calendar(s):

- Select Calendar from the Organization menu. The Organizational Calendar dialog box appears.
Using the Process Administrator

The Master Calendar (with the conventional defaults) is automatically installed during the Manager installation.

To create a new calendar or modify an existing calendar:

1. To create a new calendar, make any changes (including days off) to an existing calendar and click Save As.

2. When you are prompted for a name for the new calendar, enter a name and click OK. To modify an existing calendar, select the calendar, make any needed changes, and click Save.

3. When finished, click Close. Your new or modified calendar is saved and the dialog box closes.

To change the days off:

1. From the Organizational Calendar dialog box, select the calendar for which to add, modify, or remove days off.
2. To add days off, click Add, or to modify days off, select the days you want to change and click Modify. The Select Month and Day dialog box appears.

![Select Month and Day Dialog Box](image)

3. Select the correct month, year, time, and date to add or change. Click OK.

To delete a calendar:

1. From the Organizational Calendar dialog box, select the calendar to delete.

   **CAUTION**
   
   Do not select the Master Calendar for deletion. If you delete the master calendar, you can recreate it manually.

2. Click Remove. If the calendar is currently in use, the Remove button will be unavailable.

To open a dialog for installing new business process definitions, select Install New Business Processes from the Organization menu.
Using the Process Administrator

Figure 3-68  Install BP Definition Dialog Box

You can install a new business process by selecting the Install New Business Processes command from the Organization menu or by clicking the Add button on the Business Process Definitions dialog box, which is displayed when you select the Business Processes command from the Organization menu.

For information on installing a new business process, see Business Processes on page 3-52.

Import Identities

End users of AppXtender Workflow client applications must be registered identities. You can add identities for your organization with the Identities command (see Identities on page 3-39) or you can import existing lists of identities with the Import Names Assistant.

The Import Names Assistant uses registered DLLs to import different types of lists, such as Exchange Users or NT Users. Select Import Identities from the Organization menu to the Assistant.
There are six default services included when you install the Manager. For information on how to add services for importing other types of lists, see Import Names Registry on page 3-32.

If you chose a Custom installation type and didn’t choose to install the Import Names Utility, this feature will not be available. For more information, see Installing the ApplicationXtender Workflow Process Manager on page 2-13.

When you use these services you import the following information:

- Comma Separated Values - (for files created with the Export command) all identity information
- LDAP - all identity information
- Microsoft Exchange Users - name and e-mail address
- Microsoft SQL Server users - name only
- Windows NT Users - name only
- ApplicationXtender Users - all identity information

To import names:

1. In the Import Names Assistant (Names Service) dialog box, select the names service for the type of file to import.
2. Click Next to open a dialog for selecting the file to import.
Using the Process Administrator

Figure 3-70 Importing a names file (for a CSV import)

3. Select the appropriate server, or directory and file name, and click OK. The Import Names Assistant dialog box appears. This dialog contains the identities (in the Source Names list box) that can be imported.

Figure 3-71 Import Names Assistant (Identities) Dialog Box (for a CSV import)

4. In the Source Names list, select the identities to be imported. Use the Select All and Invert Selection buttons to help you make your selection.

5. Select the Setup as Users check box if you want these identities automatically set up as authenticated AppXtender Workflow users with user authorization rights.
Using the Process Administrator

This option is useful when you have a large number of identities to set up as users in AppXtender Workflow; otherwise, use the Identities command to add each of the imported identities to AWS so that they can be authenticated by AppXtender Workflow as valid users.

6. Click Finish to close the dialog box. The Manager begins importing the selected identities. This process may take several minutes. As identities are imported, system messages are displayed.

7. Click OK to close the message dialog box.

Export Identities

All information for each registered identity on your system can be exported to a single file. This .CSV file can be opened in any spreadsheet program or imported in any other installation of the Manager. To open a dialog box for exporting identity information, select Export Identities from the Organization menu.

Figure 3-72 Export Identities Dialog Box

Help Menu Commands

The Help menu provides these commands for accessing online help and the product information dialog box.

The following table describes available commands for the Help menu.
### Table 3-5 Help Menu Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>To display a listing of online help topics for the Administrator.</td>
</tr>
<tr>
<td>About</td>
<td>To display product information about the Administrator, including the version and serial numbers.</td>
</tr>
</tbody>
</table>
Importing User Identities

You can perform a batch import of identities into the Process Administrator for use with your business processes.

To import identities from Windows NT:

1. Open AppXtender Workflow Process Administrator.

   You must log into the AppXtender Workflow Process Administrator as “sa” rather than the default of “awsadmin.”

2. From the Organization menu, select Import Identities. The Import Names Assistance dialog box appears.

3. From the Name Service list in the Import Names Assistant window, select Windows NT Users.

4. Click Setup. The Server dialog box appears.

   Figure 3-73 Import Names Assistant Dialog Box

   3. From the Name Service list in the Import Names Assistant window, select Windows NT Users.

   4. Click Setup. The Server dialog box appears.
Using the Process Administrator

5. In Server list, select the server from which to import the identities and click OK. Depending on the size of the server, this may take several minutes.

In most cases, you will wish to import your domain users. If so, you should select the Primary Domain Controller here.

CAUTION

Certain characters are not supported in the server names. These include, but are not limited to a period, a backslash, and a dash (./-).

6. You are then returned to the Import Names Assistant window; click the Next button.

To import identities from a CSV file rather than from Windows NT, see Import Identities from a CSV File on page 3-76.

7. A new list called Source Names appears. Highlight the name(s) you want to select and enable the Setup As Users check box. Click Next to complete the import.

Importing Identities from LDAP

An LDAP administrator must perform the procedure below.

To import identities from LDAP:

1. Open the Process Administrator.
You must log into the AppXtender Workflow Process Administrator as “sa” rather than the default of “awsadmin.”

2. From the Organization menu, select Import Identities. The Import Names Assistance dialog box appears.

![Import Names Assistant Dialog Box](image)

3. From the Name Service list in the Import Names Assistant window, select LDAP.

4. Click Setup. The Find People dialog box appears.

![Find People Dialog Box](image)

5. Enter the Server name in the text box or select a previously entered server from the drop-down list.
Using the Process Administrator

6. If your LDAP server requires authentication, enable that check box and enter the appropriate information in the text boxes.

7. Enable the Filter entries check box and configure your filter options from the drop-down lists.

8. Click the Options button. The Options dialog box appears.

9. Enter the Port number in the text box. The default LDAP port is 389.

10. Enter the Search Base in the text box. The default entry is c=us.

11. Configure the AW Properties mappings.

   You must map the OS User Name in order to use integrated security. The user name must be in the form of domain\user or it will not be imported.

12. Click OK to be returned to the Options dialog box, and OK again to be returned to the Import Names Assistant dialog box.

13. Click Next. The Import Names Assistant dialog box appear with the Source Names list.

14. Highlight the names you want to select and enable the Setup as Users check box. Click Next to complete the import.

Import Identities from a CSV File

Fields 1 and 2 are required; fields 3 through 23 are optional. Each line after the first should have at least the first two (and probably three, if you know your users’ passwords) of the fields listed below, with each item separated by a comma.

Importing User Identities

Using the Process Administrator

- // identity name
- // SQL ID
- // SQL password
- // email address
- // roles
- // manager
- // comment
- // postal address
- // phone
- // phone extension
- // fax
- // department
- // organization
- // location
- // custom attribute 1
- // custom attribute 2
- // custom attribute 3
- // custom attribute 4
- // custom attribute 5
- // custom attribute 6
- // custom attribute 7

You must make sure that the SQL IDs in the CSV file are written in the same manner that they are in your SQL list (just as they are, for instance, in the “Logins” folder in the SQL Server Manager window of the SQL Enterprise Manager).

The format is: first initial and last name, without space (for example, SSilver).

To import your ApplicationXtender users:

1. From the Organization menu, select Import Identities. The Import Names Assistant dialog box appears.
Using the Process Administrator

Figure 3-78 Import Names Assistant Dialog Box

2. From the Name Service list, select ApplicationXtender Users.

3. Click Setup. The Data Link Properties wizard appears. Select the appropriate database and server configuration and click OK to be returned to the Import Names Assistant dialog box.
This chapter provides instructions for using the ApplicationXtender (AppXtender) Workflow Administrator. It also provides a systematic reference for each menu option provided by the Microsoft Management Console (MMC). This information is also available in online help format, from the Help menu.

- Introduction ................................................................. 4-2
- Opening ApplicationXtender Workflow Administrator .... 4-3
- Toolbar Buttons ................................................................. 4-4
- Action Menu ..................................................................... 4-5
- View Menu ......................................................................... 4-9
- Common Features in the AppXtender Workflow Administrator... 4-12
- Managing AppXtender Workflow Servers through the AppXtender Workflow Administrator .................................. 4-15
- Managing Business Processes Using the AppXtender Workflow Administrator ...................................................... 4-27
- Managing Business Process Instances............................. 4-56
- Managing Users ................................................................. 4-76
- Exiting the AppXtender Workflow Administrator ............... 4-89
Introduction

The Microsoft Management Console (MMC) can be used to create, save, and administrative tools that manage the hardware, software, and network components of your Windows system. The MMC itself does not perform administrative functions, but hosts the tools to do so. The primary tool, which you can add to the console, is the AppXtender Workflow Administrator, which is discussed further in this chapter. To access MMC online help in AppXtender Workflow Administrator, select the Console Root node and <F1> simultaneously.

This chapter contains the following terminology:

- **Microsoft Management Console (MMC)** hosts tools that system administrators can use to administer networks, computers, services, and other system components. In the case of AppXtender Workflow, the AppXtender Workflow MMC Snap-in is a tool used to manage AppXtender Workflow users, business processes, and instances.
- **Snap-in** is a basic component of the MMC. Snap-ins always reside inside the MMC console. When a component is installed on the Windows operating system and has a Snap-in associated with it, the Snap-in becomes available to anyone creating a console. You can add single or multiple Snap-ins to a console.

For more information, see the following sections:

- **Opening ApplicationXtender Workflow Administrator** on page 4-3, below
- **Action Menu** on page 4-5
- **View Menu** on page 4-9
- **Common Features in the AppXtender Workflow Administrator** on page 4-12
- **Managing AppXtender Workflow Servers through the AppXtender Workflow Administrator** on page 4-15
- **Managing Business Processes Using the AppXtender Workflow Administrator** on page 4-27
- **Managing Business Process Instances** on page 4-56
- **Managing Users** on page 4-76
Opening ApplicationXtender Workflow Administrator

When you open the AppXtender Workflow Administrator, the MMC opens and automatically loads the AppXtender Workflow Administrator.

To AppXtender Workflow Administrator:

- From the Windows Start menu, select Programs, then ApplicationXtender Workflow. From the ApplicationXtender Workflow programs group, select Workflow Administrator.

The ApplicationXtender Workflow Administrator appears.
Using the ApplicationXtender Workflow Administrator

Toolbar Buttons

The following table explains the use of each button on the toolbar. The tool’s purpose and corresponding menu commands are shown and for each icon, the menu equivalent is shown with selection letters underlined. (For example, File, then Open means <Alt+f> to open the File menu, then O to select the command.)

You can also view a “tool tip” for each tool by holding the pointer of the cursor over the tool for a second. The tool tip displays the name of the corresponding function. The status bar can also provide more detail description of this command.

Table 4-1 Toolbar Buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Button Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Back</td>
<td>Moves to your previous position.</td>
</tr>
<tr>
<td></td>
<td>Forward</td>
<td>Moves forward from your current position.</td>
</tr>
<tr>
<td></td>
<td>Up one level</td>
<td>Moves up one level from your current position.</td>
</tr>
<tr>
<td></td>
<td>Show/Hide Console Tree/Favorites</td>
<td>Displays or hides items in the left pane of the AppXtender Workflow Administrator.</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
<td>Displays the properties of the currently selected item, provided the option is available for that item. For more information, see Server Properties on page 4-18, Business Process Properties on page 4-35, and Instance Properties on page 4-65.</td>
</tr>
<tr>
<td></td>
<td>Refresh</td>
<td>Refreshes the current node. For more information, see Refresh on page 4-12.</td>
</tr>
<tr>
<td></td>
<td>Export List</td>
<td>Exports the contents of the currently selected item to a specific file format. For more information, see Export List on page 4-12.</td>
</tr>
<tr>
<td></td>
<td>Help</td>
<td>Displays help for the AppXtender Workflow Administrator. By selecting the Console Tree and pressing &lt;F1&gt;, you will be able to see Microsoft Online Help. By pressing &lt;F1&gt; without selecting the Console Tree, you will be able to see AppXtender Workflow Snap-in Online Help.</td>
</tr>
</tbody>
</table>
Action Menu

The Action Menu provides commands for managing the AppXtender Workflow Administrator. Depending on which node you have selected, different options appear in the Action menu. The same menu options can be accessed from the shortcut menus, by right-clicking on a node.

The following table describes the available options in the Action menu when Administration node is selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect/Disconnect</td>
<td>Connects to or disconnects from an AppXtender Workflow server. For more information, see Connect on page 4-16 and Disconnect on page 4-17.</td>
</tr>
<tr>
<td>About</td>
<td>Displays the About dialog box for the AppXtender Workflow Administrator. For more information, see About on page 4-14.</td>
</tr>
<tr>
<td>New Window from Here</td>
<td>Displays a new MMC window. For more information, see New Window from Here on page 4-12.</td>
</tr>
<tr>
<td>Export List</td>
<td>Exports the displayed contents of the AppXtender Workflow Administrator node. For more information, see Export List on page 4-12.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays AppXtender Workflow Administrator online help. For more information, see Help on page 4-13.</td>
</tr>
</tbody>
</table>

The following table describes the available options in the Action menu when the Server node is selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect/Disconnect</td>
<td>Connects to or disconnects from a AppXtender Workflow server. For more information, see Connect on page 4-16 and Disconnect on page 4-17.</td>
</tr>
<tr>
<td>DB Cleanup</td>
<td>Cleans up the current state of the AppXtender Workflow databases. For more information, see Database Cleanup on page 4-18.</td>
</tr>
<tr>
<td>New Window from Here</td>
<td>Displays a new MMC window. For more information, see New Window from Here on page 4-12.</td>
</tr>
</tbody>
</table>
The following table describes the available options in the Action menu when a Business Process node is selected.

Table 4-4  Action Menu Options - Business Process Node

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window from Here</td>
<td>Displays a new MMC window. For more information, see New Window from Here on page 4-12.</td>
</tr>
<tr>
<td>Export List</td>
<td>Exports the displayed contents of the Business Process node. For more information, see Export List on page 4-12.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the Business Process Properties dialog box. For more information, see Business Process Properties on page 4-35.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the AppXtender Workflow Administrator online help. For more information, see Help on page 4-13.</td>
</tr>
</tbody>
</table>

The following table describes the available options in the Action menu when an Instance node is selected.

Table 4-3  Action Menu Options - Server Node (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>Refreshes the Server node. For more information, see Refresh on page 4-12.</td>
</tr>
<tr>
<td>Export List</td>
<td>Exports the displayed contents of the Server node. For more information, see Export List on page 4-12.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the Server Properties dialog box. For more information, see Server Properties on page 4-18.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the AppXtender Workflow Administrator online help. For more information, see Help on page 4-13.</td>
</tr>
</tbody>
</table>
The following table describes the available options in the Action menu when the Reports node is selected.

### Table 4-5  Action Menu Options - Instance Node

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Page</td>
<td>Moves to the first page of the result set. For more information, see <em>Navigating through Business Process Instances</em> on page 4-61.</td>
</tr>
<tr>
<td>Previous Page</td>
<td>Moves to the previous page of the result set. For more information, see <em>Navigating through Business Process Instances</em> on page 4-61.</td>
</tr>
<tr>
<td>Next Page</td>
<td>Moves to the next page of the result set. For more information, see <em>Navigating through Business Process Instances</em> on page 4-61.</td>
</tr>
<tr>
<td>Last Page</td>
<td>Moves to the last page of the result set. For more information, see <em>Navigating through Business Process Instances</em> on page 4-61.</td>
</tr>
<tr>
<td>Go To</td>
<td>Allows you to select a page in the result set. For more information, see <em>Navigating through Business Process Instances</em> on page 4-61.</td>
</tr>
<tr>
<td>New Window from Here</td>
<td>Displays a new MMC window. For more information, see <em>New Window from Here</em> on page 4-12.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the selected Instance node. For more information, see <em>Refresh</em> on page 4-12.</td>
</tr>
<tr>
<td>Export List</td>
<td>Exports the displayed contents of the Instance node. For more information, see <em>Export List</em> on page 4-12.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the AppXtender Workflow Administrator online help. For more information, see <em>Help</em> on page 4-13.</td>
</tr>
</tbody>
</table>

### Table 4-6  Action Menu Options - Reports Node

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Allows you to create a new report. For more information, see <em>Managing Reports</em> on page 4-65.</td>
</tr>
</tbody>
</table>
### Table 4-6  Action Menu Options - Reports Node (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window from Here</td>
<td>Displays a new MMC window. For more information, see New Window from Here on page 4-12.</td>
</tr>
<tr>
<td>Export List</td>
<td>Exports the displayed contents of the Reports node. For more information, see Export List on page 4-12.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the AppXtender Workflow Administrator online help. For more information, see Help on page 4-13.</td>
</tr>
</tbody>
</table>

The following table describes the available options in the Action menu when the Users node is selected.

### Table 4-7  Action Menu Options - Users Node

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reconcile</td>
<td>Allows you to access the Reconcile Users dialog box. For more information, see User Reconciliation on page 4-77.</td>
</tr>
<tr>
<td>New Window from Here</td>
<td>Displays a new MMC window. For more information, see New Window from Here on page 4-12.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the contents of the Users node. For more information, see Refresh on page 4-12.</td>
</tr>
<tr>
<td>Export List</td>
<td>Exports the displayed contents of the Users node. For more information, see Export List on page 4-12.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the AppXtender Workflow Administrator online help. For more information, see Help on page 4-13.</td>
</tr>
</tbody>
</table>
View Menu

The View Menu provides commands for configuring display of icons in the AppXtender Workflow Administrator.

### Table 4-8 View Menu Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose Columns</td>
<td>Allows users to add or remove columns in the right pane of the AppXtender Workflow Administrator. This option can only be seen if one of the Instance nodes is selected. The Detail option must also be selected in order to see the Choose Columns option. For more information, see Choosing Columns on page 4-9.</td>
</tr>
<tr>
<td>Large</td>
<td>Displays icons in a large format.</td>
</tr>
<tr>
<td>Small</td>
<td>Displays icons in a small format.</td>
</tr>
<tr>
<td>List</td>
<td>Displays items in a list without column headers.</td>
</tr>
<tr>
<td>Detail</td>
<td>Displays items and details about each item with column headers.</td>
</tr>
<tr>
<td>Filter</td>
<td>Displays the filter text boxes. This option can only be seen if one of the Instance nodes is selected. For more information, see Applying Filters on page 4-27.</td>
</tr>
<tr>
<td>Customize</td>
<td>Displays the Customize Views text box. For more information, see Customizing MMC Views on page 4-11.</td>
</tr>
</tbody>
</table>

For more information on these commands, see Microsoft Online Help (select the Console Root node and press <F1>).

### Choosing Columns

You can choose which columns you display in the right pane of the AppXtender Workflow Administrator:

To add or remove columns:

1. Select a node from which you wish to add or remove columns.
2. Select Choose Columns from the View Menu. The Modify Columns dialog box appears.
Using the ApplicationXtender Workflow Administrator

3. You can perform one of the following:
   • To display a hidden column, select the displayed column in the Displayed columns list window and click the Add button. The column appears in the Displayed columns list window.
   • To hide a displayed column, select the hidden column in the Hidden columns list window and click the Remove button. The column appears in the Hidden columns list window.
   • To reset the column settings and display all available columns, click the Reset button.

4. Click OK to save the new column settings and exit the Modify Columns dialog box.

The following table describes the available buttons and their functionality in the Modify Columns dialog box.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Allows you to add a column.</td>
</tr>
<tr>
<td>Remove</td>
<td>Allows you to remove a column.</td>
</tr>
<tr>
<td>Reset</td>
<td>Allows you to reset the current column settings and displays all available columns.</td>
</tr>
<tr>
<td>Move Up</td>
<td>Allows you to move up in the Displayed columns list window.</td>
</tr>
</tbody>
</table>
Customizing MMC Views

The Customize View dialog box allows you to show or hide the console tree, Action and View menus, and tabors in the MMC Console.

To customize MMC Console views:

1. Select Customize from the View Menu. The Customize View dialog box appears.

2. Perform one of the following:
   • To show a specific option in the MMC Console, select the check box corresponding to the option you wish to show.
   • To hide a specific option in the MMC Console, unsettle the check box corresponding to the option you wish to hide.

3. Click OK to save the new settings and exit the Customize View dialog box.
Common Features in the AppXtender Workflow Administrator

The MMC Console of the AppXtender Workflow Administrator has common features which can be used for every node in the AppXtender Workflow Administrator. You can a new MMC Console Window, refresh the contents of a selected node, export the displayed contents of a selected node, and access the online help files.

For more information, see:

- New Window from Here on page 4-12
- Refresh on page 4-12
- Export List on page 4-12
- Help on page 4-13
- About on page 4-14

New Window from Here

You can open a new MMC window from any node within the AppXtender Workflow Administrator.

To a new MMC window:

- You can start a new windows from any AppXtender Workflow Administrator node. To do so, right-click on the node and select New Window From Here from the shortcut menu. The new MMC window appears.

Refresh

The Refresh feature updates currently displayed information for the selected node.

To refresh the displayed information:

1. Select a node for which you wish to refresh the displayed information.
2. Select Refresh from the Action menu or click the Refresh button on the toolbar.

Export List

You can export the displayed information for any node to a file.

To export a list:

1. Display the contents of the node to export to a file.
2. Select Export List from the View menu or right-click the node from which you displayed the information and select Export List from the shortcut menu. The Save As dialog box appears.

![Save As Dialog Box]

**Figure 4-4** Save As Dialog Box

3. Choose a location for the file to be saved.
4. Type in the file name.
5. Select a file type. There are four file types available:
   - Text (Tab Delimited) (*.txt)
   - Text (Comma Delimited) (*.csv)
   - Unicode (Tab Delimited) (*.txt)
   - Unicode (Comma Delimited) (*.csv)
6. To save only the selected rows, enable the Save Only Selected Rows check box.
7. Click Save.

In Save as type, Unicode file formats are only available if you are using Windows 2000.

**Help**

Two online help files are available in the AppXtender Workflow Administrator: AppXtender Workflow Administrator online help and Microsoft Management Console online help.

To access online help for the AppXtender Workflow Administrator:

- Select Help on AppXtender Workflow from the Help menu or select a node and click <F1>.
Using the ApplicationXtender Workflow Administrator

To access online help for the MMC:
- Select Help Topics from the Help menu or select the Console Root node and click <F1>.

About

The About dialog box displays version and copyright information. The AppXtender Workflow Administrator has two About dialog boxes: one for the AppXtender Workflow Administrator and the other for the Microsoft Management Console.

To access the About dialog box for the AppXtender Workflow Administrator:
- From the AppXtender Workflow Administration node, select About from the Action menu or right-click on the AppXtender Workflow Administration node and select About from the shortcut menu.

To access the About dialog box for the MMC:
- Select About Microsoft Management Console from the Help menu.
Managing AppXtender Workflow Servers through the AppXtender Workflow Administrator

You can use the AppXtender Workflow Administrator to manage connections to AppXtender Workflow servers, AppXtender Workflow server properties, the databases on the AppXtender Workflow servers, as well as export information regarding the AppXtender Workflow servers and refresh the displayed AppXtender Workflow server information. The server shortcut menu provides commands for managing the server and related server functions. When you right-click on a server node in the AppXtender Workflow Administrator, the Server shortcut menu appears.

![Server Shortcut Menu](image)

The following flow chart represents all of the available server features.
**Using the ApplicationXtender Workflow Administrator**

**Figure 4-6 Server Features**

For more information, see:
- *Connect* on page 4-16
- *Disconnect* on page 4-17
- *Database Cleanup* on page 4-18
- *Server Properties* on page 4-18

**Connect**

You must connect to a server in order to use any of the functionality of the AppXtender Workflow Administrator. If you are not connected to a server, your available menu options will be limited.
You may be connected to more then one server at a time. Until you manually disconnect from a server, you will remain connected.

To connect to a server:

1. Right-click on a server, and from the Server shortcut menu select Connect. The AppXtender Workflow Login dialog box appears.

![AppXtender Workflow Login Dialog Box](image)

2. If you are logging in for the first time, you will need to enter the following:
   - User Name
   - Password
   - Server name
   - Database name
   In order to view the Server and Database text boxes, click the More button.

3. Click OK to connect to the server.

If you have not previously connected to the AppXtender Workflow server, the default Username, Password, Server, and Database are specified in the ApplicationXtender (AppXtender) Data Source Configuration. For more information, refer to the ApplicationXtender Installation Guide.

Disconnect

You can disconnect from the server to which you are currently connected. While you are disconnected from the server, there is a limited set of available menu commands.
To disconnect from a server:
- Right-click on the server, and select Disconnect.

### Database Cleanup

Database Cleanup allows you to cleanup discrepancies in an AppXtender Workflow database. For example, an administrator deletes a report definition and reports that were created under that report definition are deleted as well. If a user has a report ed under the removed report definition, then it is not removed from the database. Therefore, an orphaned report will remain in the database. The Database Cleanup feature will delete the report and fix any discrepancies.

Discrepancies in the database can be seen through Microsoft SQL Server. DB Cleanup does not take a lot of time or network resources. To perform this action, you must be connected to a server where the database is located. For more information regarding report definition, see Report Properties on page 4-66. For more information regarding deleting a report definition, see Deleting Reports on page 4-73.

To access DB Cleanup:
- Right-click on the server where the database is located, and select DB Cleanup.

### Server Properties

The ApplicationXtender Workflow Server Properties dialog box provides access to keyword substitution and configuration of the query result set, as well as the license server, IP address configuration, transaction server service monitoring/control, and modification of the Settings table in the AppXtender Workflow database.

To access server properties:
- Right-click on the server and select Properties. The Server Properties dialog box appears.

For more information, see:
- Configuration Tab on page 4-19
- Keyword Substitution Tab on page 4-20
- Service Tab on page 4-21
- Settings Table Tab on page 4-23
In the Configuration tab in the Server Properties dialog box, you can enter the name or IP address of the computer where the License Server is located, and you can segment the results of a query into pages to improve display performance. You can also specify which license server to connect to for each server, as part of multiple data source support. This tab also lets you to configure navigation through the query result set. For more information regarding navigation, see Navigation on page 4-27.

To specify a license server name or IP address for the selected server:

1. Right-click on the server and select Properties. The Configuration tab is activated by default.

2. Type in the License Server Name or IP address in the text box.

If multiple servers are connected, changes made in paging affect all of the servers.

To segment results of a query:

1. Right-click on the server and select Properties. The Configuration tab is activated by default.
Using the ApplicationXtender Workflow Administrator

**Server Properties Dialog Box - Configuration Tab**

2. In the Page Size text box, type in the maximum number of instances you wish to see per page (enter 0 to display instances as continuous data, no page breaks).

3. In the Number of Pages to Retrieve text box, type in the maximum number of pages you wish to retrieve (enter 0 to retrieve an unlimited number of pages).

4. Click Apply to save new settings or click OK to save new settings and close the Server Properties dialog box.

**Keyword Substitution Tab**

Keywords are used to label columns in the AppXtender Workflow Workbox. Using keywords can assist the users in completion of specific tasks by readily identifying information with familiar terms in the Business Process. AppXtender Workflow provides sixteen keywords (8 Task keywords and 8 Business Process keywords). Substitution names can be added, changed, or deleted from the Keyword Substitution tab of each server’s properties dialog box.

- **A Business Process Keyword** is associated with a specific business process.

- **A Task Keyword** is associated with a particular workflow within the business process.

Business Process and Task keywords are assigned to each column when the business process is defined and created. For more information regarding which Task and/or Business Process keyword corresponds to which column in the AppXtender Workflow Workbox, see your Business Process Map. For more information about creating business process maps, refer to the *ApplicationXtender Workflow Process Builder Guide*.
To rename a keyword:

1. Right-click on the server and select Properties. Server Properties dialog box appears.
2. Click on the Keyword Substitutions tab in order to activate it.

3. Right-click in the substitution column next to the keyword to be substituted and select Rename.
4. Type in the substitution name.
5. To save changes, click Apply. To save changes and close the Server Properties dialog box, click OK. To exit without saving changes, click Cancel.

To clear a substitution name:

1. Right-click on the server and select Properties. Server Properties dialog box appears.
2. Click on the Keyword Substitutions tab in order to activate it.
3. Right-click in the substitution column across from the keyword to be substituted and select Clear.
4. To save your changes, click Apply. To save changes and exit the Server Properties dialog box, click OK. To exit without saving changes, click Cancel.

**Service Tab**

The Service tab in the Server Properties dialog box allows administrators to stop, start, and pause the Transaction Manager Service. If errors occur while the Transaction Manager is running and the option to “Monitor business process transaction and notify when
errors occur” is selected, a message box indicating that an error has occurred appears. It is recommended that this feature remain enabled at all times.

AppXtender Workflow uses two phases to execute actions taken by users. The first phase is when a user executes an act, which is written to a table. This table triggers the second phase. The second phase takes place when the Transaction Manager or an NT Service processes the act. The Services feature allows you to start, stop, pause and continue the service. This feature is helpful when there are many acts performed in the Workflow system thus creating a backup. The system administrator can stop or pause a service in order to help the Workflow system to clear the back up. You can also perform this task in AppXtender Workflow Process Administrator.

A stoplight in the dialog box shows the status of the service. If the light is green, then the service is running. A yellow light indicates that the service has been paused. A red light indicates that the service has been stopped. An error message may appear telling you if any errors have occurred in the transaction manager.

Figure 4-11 Error Notification Dialog Box

To enable monitoring of the business process transactions:

1. Right-click on the server and select Properties.
2. Click on the Service tab in order to activate it.
Using the ApplicationXtender Workflow Administrator

Managing AppXtender Workflow Servers through the AppXtender Workflow Administrator

Figure 4-12 Server Properties Dialog Box - Services Tab

3. Select the Monitor business process transactions and notify when error occurs check box.

To manage the Transaction Manager Service:

1. Right-click on the server and select Properties.
2. Click on the Service tab in order to activate it.
3. You can perform one of the following:
   • To start the Transaction Manager Service, if it is stopped, click the Start button.
   • To stop the Transaction Manager Service, click the Stop button.
   • To pause the Transaction Manager Service, click the Pause button.
   • To restart the Transaction Manager Service, click the Continue button.

Settings Table Tab

The Settings Table tab in the Server Properties dialog box allows easy access to global settings for a business process. Using the Settings Table tab, you are able to add, delete, and modify business process specific information in the Settings table of the AppXtender Workflow database. For example, if you have a requirement for dynamic default values for your business process, you can easily make changes to the Settings table in the AppXtender Workflow database that can facilitate this requirement.

The associated APIs (Application Program Interfaces) for the Settings table are GetSetting and SetSetting. For more information, refer to the
Appendix B: Using the ApplicationXtender Workflow Script Debugger in the ApplicationXtender Workflow Process Builder Guide.

To add information to the Settings table in the AppXtender Workflow database:

1. Right-click on the server and select Properties.
2. Click on the Settings Table tab in order to activate it.

3. Right-click within the Settings Table tab window and select Add. The Settings Entry dialog box appears.

---

Figure 4-13  Server Properties Dialog Box - Settings Table Tab

Figure 4-14  Settings Entry Dialog Box

ApplicationXtender Workflow Administrator’s Guide
4. Enter the information in the provided text boxes. The following table lists and describes the available columns in the Settings table.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Allows you to specify the type of the setting (default name).</td>
</tr>
<tr>
<td>Applies To</td>
<td>Allows you to specify what the new setting applies to (business process).</td>
</tr>
<tr>
<td>Label</td>
<td>Allows you to specify a label for the setting.</td>
</tr>
<tr>
<td>Value</td>
<td>Allows you to specify a value for the setting.</td>
</tr>
</tbody>
</table>

5. Click the OK button to exit the Settings Entry dialog box.

6. To save your changes, click Apply. To save changes and exit the Server Properties dialog box, click OK. To exit without implementing changes, click Cancel.

To modify information in the Settings table of the AppXtender Workflow database:

1. Right-click on the server and select Properties.
2. Click on the Settings Table tab in order to activate it.
3. Double-click on the database column to be modified or right-click on the database column to be modified and select Modify from the shortcut menu. The Settings Entry dialog box appears.
4. Modify the database column information.
5. Click the OK button to exit the Settings Entry dialog box.
6. To save your changes, click Apply. To save changes and exit the Server Properties dialog box, click OK. To exit without implementing changes, click Cancel.

To delete a column from the Settings table in the AppXtender Workflow database:

1. Right-click on the server and select Properties.
2. Click on the Settings Table tab in order to activate it.
3. Double-click on the database column to be deleted or right-click on the database column to be deleted and select Delete from the shortcut menu.

4. To save your changes, click Apply. To save changes and exit the Server Properties dialog box, click OK. To exit without implementing changes, click Cancel.
Managing Business Processes Using the AppXtender Workflow Administrator

All business processes are listed beneath the server node. The Business Process shortcut menu provides commands for managing business processes in the AppXtender Workflow Administrator. To view the Business Process shortcut menu, right-click on a business process and make a selection.

For more information, see:
- Navigation on page 4-27
- Applying Filters on page 4-27
- Removing Filters on page 4-35
- Business Process Properties on page 4-35

Navigation

The First Page, Previous Page, Next Page, and Last Page features provide easier navigation through the result set. You can limit the number of instances displayed on each page by segmenting results of a query in the Configuration tab of the Server Properties dialog box. For more information, see Configuration Tab on page 4-19.

To navigate through the query result set:

1. Right-click on the All, In Progress, Completed, or Archived node and the Business Process shortcut menu appears.

2. Select one of the following:
   - First Page (if you are on the first page of the query result set, this feature will not be available)
   - Previous Page (if you are on the first page of the query result set, this feature will not be available)
   - Next Page (if you are on the last page of the query result set, this feature will not be available)
   - Last Page (if you are on the last page of the query result set, this feature will not be available)

Applying Filters

Filters display items in the result set based on criteria entered into the text box under the column name. You can apply and remove filters.
Filtering in the Reports node works very much like a directory search (*\042htm\042), therefore the List of Values and Search Expression dialog boxes are not available. You can apply filters to a list of previously run reports and not report definitions. When applying a filter against reports, the List of Values and Search Expression options will not be available from the Filter shortcut menu. For more information regarding reports, see Managing Reports on page 4-65.

Filter text is case-sensitive. The information entered in the Filter text box must be entered in identical format as it is displayed in the AppXtender Workflow Administrator.

The Filter option allows the use of wildcards in the filter text. The wildcard option allows you to substitute for characters, which are not known to you. You can use the percent sign (%) or an asterisk (*) as your wildcard character. The Filter option allows filters to be put on several columns at one time. Thus, the items in the column will be filtered according to filter specifications. You must select the Funnel button to apply the filter to the column.

**CAUTION**

Wildcards like * and % can only be used for Equal to and Not equal to search operators. If you use the * and % with Between, Greater then, Greater then or equal, Less then, and Less then or equal search operators, the * and % will be interpreted as text characters and the filter will not return correct values. Wildcards are not supported in the Status column of the AppXtender Workflow Administrator.

To apply a filter:

1. Display the contents of a node you wish to filter.
2. Right-click on the node and select View.
3. Select Filter from the View menu. The Filter text boxes appear beneath the column headers.

For the Filter option to appear in the View menu, you must display the contents of the node.
Figure 4-15  **Filter Text Boxes**

4. In column(s) to be filtered, type the information to be used as a filter in the filter text box.

5. Click the Funnel button. The Filter shortcut menu appears.

---

<table>
<thead>
<tr>
<th>Instance Name</th>
<th>Task Name</th>
<th>Task Start</th>
<th>State</th>
<th>Performer</th>
<th>Customer</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSERT W/F: DOCUMENT M/</td>
<td>102: TravelReq</td>
<td>2000-04-18 12:07</td>
<td>Acceptance</td>
<td>TestReq</td>
<td>TestReq</td>
</tr>
<tr>
<td>AZAR HAGAN - NEW YORK</td>
<td>103: TravelReq</td>
<td>2000-04-18 12:29</td>
<td>Acceptance</td>
<td>TestReq</td>
<td>TestReq</td>
</tr>
</tbody>
</table>

---

**Figure 4-16  Filter Shortcut Menu**

6. Select Apply Filter from the Filter shortcut menu.

For more information, see the following sections:

- **Resetting Filter Values** on page 4-29
- **List of Values** on page 4-29
- **Search Expression** on page 4-32
- **Removing Filters** on page 4-35

---

**Resetting Filter Values**

Once you have entered filter values in the Filter text boxes, you can remove all the values at once.

To reset filter values:

1. Click on the Funnel button. The Funnel shortcut menu appears.

2. Select Reset Values from the Filter shortcut menu. All previously defined filter parameters are removed.

---

**List of Values**

The List of Values dialog box allows you to define as many alternatives for a filter parameter as you wish. For example, if you wish to search for instances which were last modified on different dates by a specific person – you can enter those dates and apply them to the Last Modified column, as well as enter the name of the performer and apply it to the Instance Name column. AppXtender...
Using the ApplicationXtender Workflow Administrator

Workflow Administrator locates all instances that contain any entries you specify. By allowing you to specify more alternatives, the List of Values operation provides inclusive searches that retrieve a larger set of instances.

The List of Values dialog box consists of Field Value text box, Add, Replace, Delete, and Delete All buttons, Field Value List window, Apply and Close buttons, as well as a Column and Filter window. The Field Value text box allows you to enter filter parameters. The Add, Replace, Delete, and Delete All buttons allow you to add, replace, and delete previously entered filter parameters. The Field Value List window displays all previously defined filter parameters placed on a column. The Apply button allows you to insert the filter parameters you have defined in the Filter text box(es). The Close button allows you to exit the List of Values dialog box.

The List of Values dialog box is not available in the Reports node.

To insert a list of values as filter parameters:

1. Display the contents of a node you wish to filter.
2. Right-click on the node and select View.
3. Select Filter from the View menu. The Filter text boxes appear beneath the column headers.

For the Filter option to appear in the View menu, you must display the contents of the node.

4. Click on the Filter button and select List of Values from the Filter shortcut menu. The List of Values dialog box appears.
5. Double-click on the column that you wish to apply a filter to. It will appear in the header of the List of Values dialog box. For example, if you selected the Instance Name column, the header of the List of Values dialog box will appear as “List of Values – Instance Name.”

6. In the Field Values text box, enter the filter parameters you wish to apply to the column you selected. AppXtender Workflow Administrator allows you to add as many values for the selected column as you want.

To enter a list of values without using the List of Values dialog box, you can enter the filter parameters as follows: List: ‘John Smith’, ‘Jane Doe’.

7. Click Add.
The following table explains each of the buttons available in the List of Values dialog box.

**Table 4-11  List of Values Dialog Box Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Allows you to add filter parameter values entered into the Field Value text box.</td>
</tr>
<tr>
<td>Replace</td>
<td>Allows you to overwrite the selected filter parameter with a corrected filter parameter.</td>
</tr>
<tr>
<td>Delete</td>
<td>Allows you to delete an unwanted filter parameter.</td>
</tr>
<tr>
<td>Delete All</td>
<td>Allows you to delete all filter parameters in the Field Values List.</td>
</tr>
<tr>
<td>Apply</td>
<td>Allows you to apply entered filter parameters.</td>
</tr>
<tr>
<td>Close</td>
<td>Allows you to exit the List of Values dialog box.</td>
</tr>
</tbody>
</table>

8. To add more than one filter parameter per column, repeat Steps 6 through 7 for each filter parameter you want to add.

To select filter parameters for more than one column, repeat steps 5 through 7 for each additional column.

9. Click Apply to insert the newly entered filter parameters in the filter text box. The following is an example of a list of values expression that will appear in the filter text box, `Lst: 'John Smith', 'Jane Doe'.`

10. Click Close to exit the List of Values dialog box.

Once you select the Apply button, the filter parameters you have entered will appear in the Filter text box(es) underneath the column(s) you have selected in the List of Values dialog box. In order for the filter to be applied, you must click the Funnel button. For more information, see *Applying Filters* on page 4-27.

**Search Expression** You can also define filter parameters by entering a range of possibilities for each column using the Search Expression dialog box. This feature gives you more flexibility for specifying filter parameters by allowing you to use search expression syntax to specify a range of possibilities.
CAUTION

Wildcards like * and % can only be used for Equal to and Not equal to search operators. If you use the * and % with Between, Greater than, Greater than or equal, Less than, and Less than or equal search operators, the * and % will be interpreted as text characters and the filter will not return correct values. A warning will appear at the bottom of the Search Expression dialog box. Wildcards are not supported in the Status column of the AppXtender Workflow Administrator.

The List of Values dialog box is not available in the Reports node.

To insert a search expression in filter parameters:
1. Display the contents of a node you wish to filter.
2. Right-click on the node and select View.
3. Select Filter from the View menu. The Filter text boxes appear beneath the column headers.

For the Filter option to appear in the View menu, you must display the contents of the node.

4. Click on the Filter button and select Search Expression from the Filter shortcut menu. The Search Expression dialog box appears.
5. Double-click on the column that you wish to apply a filter to. It will then appear in the header of the Search Expression dialog box. For example, if you selected the Instance Name column, the header of the Search Expression dialog box will appear as “Search Expression – Instance Name.”

6. Designate the type of search to be performed by selecting an option from the Type of Comparison drop-down list. The following table lists the available search operators and their examples.

<table>
<thead>
<tr>
<th>Search Operator</th>
<th>Expression Example as It Appears in the Expression Text Box</th>
<th>AppXtender Workflow Finds Documents with</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between [ ]</td>
<td>Xpr: ['07/01/2001'; '08/01/2001']</td>
<td>Documents which were last modified between the dates 07/01/2001 and 08/01/2001</td>
</tr>
<tr>
<td>Greater Than &gt;</td>
<td>Xpr: &gt;07/01/2001</td>
<td>Documents which were modified after 07/01/2001</td>
</tr>
<tr>
<td>Greater Than or Equal &gt;=</td>
<td>Xpr: &gt;=07/01/2001</td>
<td>Documents which were modified starting and after 07/01/2001</td>
</tr>
<tr>
<td>Less Than &lt;</td>
<td>Xpr: &lt;07/01/2001</td>
<td>Documents which were modified before 07/01/2001</td>
</tr>
<tr>
<td>Less Than or Equal &lt;=</td>
<td>Xpr: &lt;=07/01/2001</td>
<td>Documents which were modified including and before 07/01/2001</td>
</tr>
<tr>
<td>Not Equal To &lt;&gt;</td>
<td>Xpr: &lt;&gt;07/01/2001</td>
<td>Documents which were last modified on any date other than 07/01/2001</td>
</tr>
<tr>
<td>Equal To =</td>
<td>Xpr: =07/01/2001</td>
<td>Documents which were last modified on 07/01/2001</td>
</tr>
</tbody>
</table>

**CAUTION**

Wildcards like * and % can only be used for Equal to and Not equal to search operators. If you use the * and % with Between, Greater than, Greater than or equal, Less than, and Less than or equal search operators, the * and % will be interpreted as text characters and the filter will not return correct values.
The status column only supports the Equal to and Not Equal to search operators.

7. In the Value text box, enter the appropriate Search Expression value(s). If you have selected the Between expression operator, also enter a value in the And text box.

8. Click Apply to insert the newly entered filter parameters in the Filter text box.

To select filter parameters for more than one column, repeat steps 5 through 8 for each additional column.

9. Click Close to exit the Search Expression dialog box.

Once you click the Apply button, the filter parameters you have entered will appear in the Filter text box(es) underneath the column(s) you have selected in the Search Expression dialog box. In order for the filter to be applied, you must click the Funnel button. For more information, see Applying Filters on page 4-27.

Removing Filters

After a filter has been applied, you must remove the filter in order to view all available instances.

To remove a filter:

- You can perform one of the following:
  - Click on the Funnel button and select Reset Values from the Filter shortcut menu. The filter parameters are removed from the filter text box. Click on the Funnel button and select Apply Filter from the Filter shortcut menu to remove the filter.
  - Select an icon view mode from the View menu.
  - Manually select the text in the Filter text box, click <DELETE>, and click on the Funnel button and select Apply Filter from the Filter shortcut menu to remove the filter.

The filters are removed.

Business Process Properties

The Business Process Properties dialog box provides details for the current business process. It also allows you to add, modify and remove AppXtender Application associations, and create, modify and remove user defined lists for the business process. The Business
Using the ApplicationXtender Workflow Administrator

Process Properties dialog box also allows you to hide the display of business processes in the Business Process tab of the Workbox, thus disabling the ability to start a new business process instance for the hidden business process. For more information regarding the Business Process tab of the Workbox, refer to the ApplicationXtender Workflow User’s Guide.

For more information, see the following sections:
- Details Tab on page 4-37
- Association Tab on page 4-38
- User Defined List on page 4-49

The following flow chart represents all of the options available for the Business Process Properties dialog box.

![Figure 4-19 Business Process Properties Dialog Box Options](Image)

To access the Business Process Properties dialog box:
- Right-click on a server and select Properties. The Business Process Properties dialog box appears.
The Details tab of the Business Process Properties dialog box allows you to view information regarding a business process. The information provided in this tab is read-only and cannot be edited.

To access the Details Tab of the Business Process Properties dialog box:

- Right-click on a business process and select Properties. The Business Process Properties dialog box appears with the Details tab activated by default.
The following table provides a description for all of the information available in the Details tab of the Business Process dialog box:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID Number</td>
<td>A unique number that identifies the business process.</td>
</tr>
<tr>
<td>Name</td>
<td>The unique name of the business process.</td>
</tr>
<tr>
<td>Suite</td>
<td>For documentation purposes, this description allows you to distinguish between similar business processes.</td>
</tr>
<tr>
<td>Version</td>
<td>The unique version number of the business process.</td>
</tr>
<tr>
<td>Is Offline</td>
<td>Indicates whether the business process is offline.</td>
</tr>
</tbody>
</table>

**Association Tab**

The Association tab of the Business Process Properties dialog box allows you to add, modify, and remove links to ApplicationXtender index fields, as well as set up conditional start parameters for business processes involving ApplicationXtender documents. You are also able to hide the business processes in the Business Process tab of the Workbox, thus disabling the ability to start a new business process instance for the hidden business process. For more information regarding the Business Process tab of the Workbox, refer to the *ApplicationXtender Workflow User’s Guide*.

For more information, see the following sections:

- Adding AppXtender Index Fields Associations on page 4-39
- Modifying AppXtender Index Fields Associations on page 4-44
- Removing AppXtender Index Fields Associations on page 4-46
- Configuring Prerequisites on page 4-46

To access the Association tab:

2. Click the Association tab to activate it.
To hide a business process:

1. Right-click on a business process that you wish to hide and select Properties. The Business Process dialog box appears.
2. Click the Association tab to activate it.
4. Click the OK button to save your changes and exit the Business Process Properties dialog box.

Adding AppXtender Index Fields Associations

You can add associations between AppXtender index fields and AppXtender Workflow Business Process fields. Before you can add the associations, you must set up an AppXtender data source(s). Once the AppXtender data source(s) have been set up, you will need to log into the AppXtender data source before you can proceed to add the associations. For more information regarding AppXtender data sources, refer to the ApplicationXtender Installation Guide.

To set up a new connection to an AppXtender data source:

2. Click the Association tab to activate it.
3. Click the Add button. If you have not previously set up a data source connection, the AppXtender Data Source Name dialog box appears.

Figure 4-22  Business Properties Dialog Box - Association Tab

To hide a business process:

1. Right-click on a business process that you wish to hide and select Properties. The Business Process dialog box appears.
2. Click the Association tab to activate it.
4. Click the OK button to save your changes and exit the Business Process Properties dialog box.

Adding AppXtender Index Fields Associations

You can add associations between AppXtender index fields and AppXtender Workflow Business Process fields. Before you can add the associations, you must set up an AppXtender data source(s). Once the AppXtender data source(s) have been set up, you will need to log into the AppXtender data source before you can proceed to add the associations. For more information regarding AppXtender data sources, refer to the ApplicationXtender Installation Guide.

To set up a new connection to an AppXtender data source:

2. Click the Association tab to activate it.
3. Click the Add button. If you have not previously set up a data source connection, the AppXtender Data Source Name dialog box appears.
Using the ApplicationXtender Workflow Administrator

Figure 4-23  AppXtender Data Source Name Dialog Box

4. Type in the name of the new AppXtender data source and click the OK button. The Provider tab of the Data Link Properties dialog box appears.

Figure 4-24  Data Link Properties Dialog Box - Provider Tab

5. Select a data provider.

Depending on the data provider you choose, your choices in the Connection tab may be different.

6. Click the Next button or activate the Connection tab.
Figure 4-25  Data Link Properties Dialog Box - Connection Tab

7. Specify the server name.


9. Enter the user name and password required to log into the database server.

10. To leave the password blank, enable the Blank password check box. To allow saving of the password, enable the Allow saving password checkmarks.

11. Enter the initial catalog/database to use.

When you choose a database in the Connection tab, make sure that you are connecting to the ApplicationXtender database and not to the AppXtender Workflow database.

12. Test your connection by clicking the Test Connection button. A dialog box will appear letting you know if the connection has succeeded or failed. If the connection fails, repeat Steps 1 through 10 with correct information.

To add an AppXtender index field association:

2. Click the Association tab to activate it.

3. Select an AppXtender Application, where you wish to add an association and click the Add button.
   - If you have not previously connected to the AppXtender data source, you will need to set up a new connection before proceeding. For more information, see To set up a new connection to an AppXtender data source: on page 4-39.
   - If you have previously connected to the AppXtender data source, the AppXtender Database Login dialog box appears.

4. Type in your user name and password in the corresponding text boxes.

5. Choose the AppXtender data source from the Data Source Name drop-down list.

6. Click OK. The AppXtender Applications dialog box appears.

Figure 4-26  AppXtender Database Login Dialog Box

- To set up a connection to another AppXtender data source, click the More button. The AppXtender Database Login dialog box expands.
- Click the New button, and repeat To set up a new connection to an AppXtender data source: on page 4-39.
7. Select an AppXtender application and click OK. The Application Link dialog box appears.


9. Select an AppXtender index field from the Application Fields display window.

10. Select an AppXtender Workflow business process field from the Business Process Fields display window.
11. Click the Add button. The newly added association is shown in the lower display window.

   To add more associations, repeat Steps 7 through 10.

   To remove any of the associations you have made, select the association from the lower display window and click the Remove button.

12. Click OK to save changes and exit, or click Cancel to exit without saving changes.

**Modifying AppXtender Index Fields Associations**

You can modify associations between AppXtender index fields and AppXtender Workflow Business Process fields. Before you can modify the associations, you must set up an AppXtender data source(s). Once the AppXtender data source(s) have been set up, you will need to log into the AppXtender data source before you can proceed to add the associations. For more information regarding AppXtender data sources, refer to the ApplicationXtender Administrator’s Guide.

To modify an AppXtender index field association:


2. Click the Association tab to activate it.

3. Select an AppXtender Application and click the Modify button.

   - If you have not previously connected to the AppXtender data source, you will need to set up a new connection before proceeding. For more information, see *To set up a new connection to an AppXtender data source:* on page 4-39.

   - If you have previously connected to the AppXtender data source, the AppXtender Database Login dialog box appears.
4. Type in your user name and password in the corresponding check boxes.

5. Click OK, the Application Link dialog box appears.

6. Select the AppXtender field and the corresponding BP field in the bottom display window and click the Remove button. The association is removed.

7. Now you can set up a new association by doing the following:
   - Select the application field from the Application Fields display window.
   - Select the business process field from the Business Process Fields display window.
   - Click the Add button.
Using the ApplicationXtender Workflow Administrator

8. Click OK to save changes and exit, or click Cancel to exit without saving changes.

Removing AppXtender Index Fields Associations

You can remove associations between AppXtender index fields and AppXtender Workflow Business Process fields.

To remove an AppXtender index field association:
2. Click the Association tab to activate it.
3. Select an AppXtender Application and click the Remove button.
4. Click OK to save changes and exit, or click Cancel to exit without saving changes.

CAUTION

There is no deletion confirmation for the removal of the AppXtender application link and the corresponding business process document.

Configuring Prerequisites

Prerequisites allow you to specify which newly imported AppXtender documents will start a business process instance. You can filter documents based on their AppXtender index field values. The Prerequisites feature supports operators greater than (>), less than (<), equal to (=), not equal to (<>), in, and not in. For example, if you would like to only start a business process when re-billable travel requests are imported and indexed in AppXtender, then you would enter “Yes” for the Application Value for the “Rebillable” Application field.

The “in” operator allows you to specify a list of index values, unlike the equal to (=) operator which only allows you to specify one index value. The “not in” operator also allows you to specify a list of non-matching index values, unlike the not equal to (<> ) operator which only allows you to specify one non-matching index value.

To set up prerequisites:

2. Click the Association tab to activate it.

3. Select an AppXtender application and corresponding business process document; all buttons in the dialog box are activated.

4. Click the Prerequisites button. The Conditional Start Parameters dialog box appears.

Figure 4-31 Business Properties Dialog Box - Association Tab

Figure 4-32 Conditional Start Parameters Dialog Box
5. Right-click on the Application Value field next to the corresponding Application Field and select Rename from the shortcut menu.

![Figure 4-33 Conditional Start Parameters Dialog Box Shortcut Menu](image)

**Figure 4-33  Conditional Start Parameters Dialog Box Shortcut Menu**

6. Type in the new application value. You can perform one of the following:

   - If the prerequisite is to be less than an index value, type $[<]$ and then type the index value (for example, $[<] 1000$).
   - If the prerequisite is to be greater than an index value, type $[>]$ and then type the index value (for example, $[>] 1000$).
   - If the prerequisite is to be equal to a specific index value, type the index value or type $[=]$ and then type the index value (for example, $[=] Yes$).
   - If the prerequisite is to be not equal to a specific index value, type $[<>]$ and then type the index value (for example, $[<>] 1000$).
   - If the prerequisite is to be equal to a list of index values, type the list of index values separated by a comma or $[in]$ and then type the list of index values separated by a comma (for example, $[in] PO, Accounts Payable$).
   - If the prerequisite is to be not equal to a list of index values, type $[not in]$ and then type the list of index values separated by a comma (for example, $[not in] PO, Accounts Payable$).
   - Click OK to exit the Conditional Start Parameters dialog box and return to the Association tab.
7. Click Apply to save the changes and continue working, or click OK to save the changes and exit the Properties dialog box.

To remove prerequisites:
2. Click the Association tab to activate it.
3. Click the Prerequisites button. The Conditional Start Parameters dialog box appears.
4. Right-click on the Application Value field next to the corresponding Application Field and select Clear from the shortcut menu.

CAUTION
There is no deletion confirmation dialog box when you clear a prerequisite. If you accidentally clear a prerequisite, you will need to rename it again.

User Defined List
The User Defined List feature allows you to create drop-down lists in the Work On dialog box of the AppXtender Workflow Workbox. For example, if you would like to limit what information users can enter in the index fields, you can define a list of choices from which they can select index field values. For more information regarding the Work On dialog box, refer to the ApplicationXtender Workflow User’s Guide. For steps on how to add, modify, or remove user defined lists, see the procedures below.

To add a user defined list:
2. Click the User Defined List tab to activate it.

4. Select a Business Process field and click OK. The User Defined List dialog box appears.
5. Type in the information and click Add. The newly added item appears in the lower part of the dialog box. To enter another item, repeat this step. Click the OK button to save the list and exit the User Defined List dialog box.

6. Repeat Steps 1-5 to add additional User Defined Lists. Click Apply in the Business Process Properties dialog box to save the changes and continue working, or click OK to save the changes and to exit the Properties dialog box.

To modify a user defined list:


2. Click the User Defined List tab in order to activate it.
Using the ApplicationXtender Workflow Administrator

3. Select a Field Name and click Modify. The User Defined List dialog box appears.

4. Right-click on the item and select Modify or double-click on the item. The item appears in the New Item text box.
5. Type in your changes, and click the Modify button.

You can also add new items for the selected index field as part of the modification of the index field.

6. Click OK to exit the User Defined List dialog box.

7. Click Apply in the Business Process dialog box to save the changes and continue working or click OK to save the changes and exit the Properties dialog box.

To remove a user defined list:

2. Click the User Defined List tab to activate it.
3. Select a Field Name by highlighting it.
4-54 ApplicationXtender Workflow Administrator's Guide

Using the ApplicationXtender Workflow Administrator

Figure 4-40 Business Process Properties Dialog Box - User Defined List Tab

4. Click the Remove button.

CAUTION
There is no deletion confirmation dialog box for the removal of a User Defined List.

5. Click Apply to save the changes and continue working, or click OK to save the changes and to exit the Properties dialog box.

File Path
The File Path tab of the Business Process Properties dialog box is used by the AppXtender Workflow Client application. The file path entered on this tab is used to store files imported into the AppXtender Workflow Client application.
To configure the File Path tab:

1. In the UNC Path text box, enter the file path where you want the file imported into the AppXtender Workflow Client application stored. You can enter this path manually or click Browse to navigate to the appropriate file path.
Managing Business Process Instances

The following flow chart represents all available features in the All, In Progress, Archived, Reports, and Users nodes.

Figure 4-42 Commands Available for the Business Process Instance

For complete functionality of the Business Process Instance nodes, see the following sections:

- All Node on page 4-57
- Completed Node on page 4-57
Managing Business Process Instances

In Progress Node on page 4-58
Archived Node on page 4-58
Reports Node on page 4-59
Users Node on page 4-60
Working with Business Process Instances on page 4-60
Managing Reports on page 4-65

All Node

The All node displays all instances in a business process. The number inside the parenthesis next to the node represents the total number of instances in that business process. You can archive, pause/restart, delete, and view properties of instances in the All node.

To access the All node:
1. Double-click a business process in order to expand the node. The All node appears underneath the business process node.
2. Double-click on the All node to display all instances of the business process in the right pane of the AppXtender Workflow Administrator.

Completed Node

The Completed node displays instances that have been completed within a business process. The number inside the parenthesis next to the node represents the total number of completed instances in the business process. You can archive, delete, and view properties of an instance in the Completed node.

To access the Completed node:
1. Double-click a business process in order to expand the node. The Completed node appears underneath the business process node.
2. Double-click on the Completed node to display all completed instances of the business process in the right pane of the AppXtender Workflow Administrator.

The In Progress node displays instances that are currently running within a business process. The number inside the parenthesis next to the node represents the total number of running instances in the business process. You can archive, pause/restart, delete, and view properties of instances in the In Progress node.

To access the In Progress node:
1. Double-click a business process in order to expand the node. The In Progress node appears underneath the business process node.
2. Double-click on the In Progress node to display all running instances of the business process in the right pane of the AppXtender Workflow Administrator.

The Archived node allows you to view instances that have been archived. The number inside the parenthesis next to the node...
represents the total number of archived instances in the business process. You can restore, delete, and view properties of instances in the Archived node.

To access the Archived node:

1. Double-click a business process next to the node. The Archived node appears underneath the business process node.

2. Double-click on the Archived node to display all archived instances of the business process in the right pane of the AppXtender Workflow Administrator.

The Reports node allows you to view, create, generate, and delete reports. For more information, see Managing Reports on page 4-65. The number inside the parenthesis next to the node represents the total number of report definition sin the Reports node.

To access the Reports node:

1. Double-click a business process next to the node. The Reports node appears underneath the business process node.

2. Double-click on the Reports node to display all available report definitions underneath the Reports node.
Using the ApplicationXtender Workflow Administrator

**Users Node**

The Users node allows you to reassign items in the Workflow system to different users. You can also reconcile users, as well as change task priority in the Users node.

To access the Users node:

- Double-click on the Users node to view all users that participate in the workflow.

**Working with Business Process Instances**

AppXtender Workflow Administrator allows you to perform several actions with business process instances. In the AppXtender Workflow Administrator, you can sort all business process instances in ascending and descending orders in order to easily find needed instances. Navigation options are also available in the Business Process shortcut menu to allow for easier navigation through the result set. You can also archive, restore, pause, restart, and delete business process instances. An Instance Properties dialog box is also available to view instance’s state in the business process, as well as its history.

For more information, see:
Navigating through Business Process Instances

The Business Process Instance Node shortcut menu provides options for business Process instance navigation. If the Paging option in the Configuration tab in the AppXtender Workflow Server Properties dialog box is set to zero, these options are not available. For more information, see Configuration Tab on page 4-19.

The following options can be used to navigate through the result set:
- First Page
- Previous Page
- Next Page
- Last Page
- Go To

To access navigation options:
- Right-click on a node through which you wish to navigate (All, Completed, In Progress, or Archived node) and select the needed option from the Business Process Instance Node shortcut menu.

To access the Go to option:

1. Right-click on a node through which you wish to navigate (All, Completed, In Progress, or Archived node) and select the Go To option from the Business Process Instance Node shortcut menu.

The Go to page dialog box appears.
Using the ApplicationXtender Workflow Administrator

2. Enter the page number you would like to view to in the Go to page spin box and click OK.

Sort

The Sort feature allows you to sort all instances in ascending and descending order. An arrow pointing up in the column header indicates that the column has been sorted in ascending order, and an arrow pointing down in the column header indicates that the column has been sorted in descending order.

To sort an instance:

◆ Click inside the column header of the column you wish to sort. The arrow indicator appears inside the column header.

Archiving an Instance

You can archive any instances in a business process that are still running. This feature is best to use for archiving completed instances. Running instances can also be archived, but that is not recommended.

To archive more than one instance, you can multi-select several instances at once. You can archive instances in the All, Complete, and In Progress nodes. To view instances in the Archived node, refresh its contents. For more information, see Refresh on page 4-12.

To archive an instance:

1. Right-click on an instance you wish to archive. The Instance shortcut menu appears.

   The available choices in the Instance shortcut menu vary depending on which node you have selected.
2. Select Archive. An Archive Confirmation dialog box appears.

![Archive Confirmation Dialog Box](image)

3. Click OK to archive or click Cancel to cancel the command. The instance is transferred to the Archived node. For more information, see Archived Node on page 4-58.

### Restoring an Instance

Any archived instances can be restored. After a completed instance is restored, it is transferred to the Completed node. After a running instance is restored, it is transferred to the In Progress node. All restored instances are added to the All node. For more information on the Completed node, see Completed Node on page 4-57. For more information on the In Progress node, see In Progress Node on page 4-58.

You can multi-select several instances to restore more than one instance at a time. To view the restored instances, refresh the contents of the tab. For more information, see Refresh on page 4-12.

To restore an instance:

1. Double-click on the Archived node and the contents of the node is displayed in the right pane.

   The available choices in the Instance shortcut menu vary depending on which node you have selected.

2. Right-click on an archived instance in the Archived tab, and select restore from the Instance shortcut menu appears.

### Pausing an Instance

You can pause any running instance. This feature is useful when you do not want an instance to appear in the AppXtender Workflow Workbox or you wish to free up your server resources. You can multi-select several instances in order to pause more than one instance at a time. To view the paused instances, refresh the contents of the tab or highlight another item. For more information, see Refresh on page 4-12.
Using the ApplicationXtender Workflow Administrator

To pause an instance:

1. Right-click on an instance that is in the running state. The Instance shortcut menu appears.

The available choices in the Instance shortcut menu vary depending on which node you have selected.

2. Select Pause. The Confirm Pause dialog box appears.

3. Select OK to pause the instance or click Cancel to cancel the command. Select a different item or select Refresh to see the status change.

Restarting an Instance

After an instance has been paused, you can restart that instance. After an instance is restarted, it will re-appear in the AppXtender Workflow Workbox. You can multi-select several paused instances to restart more than one instance at a time. To view the restarted instances, refresh the contents of the tab. For more information, see Refresh on page 4-12.

To restart an instance:

1. Right-click on a paused instance, the Instance shortcut menu appears.

The available choices in the Instance shortcut menu vary depending on which node you have selected.

2. Select Restart, the instance is restarted and identified as running.

Deleting an Instance

You can delete any instances currently used by AppXtender Workflow. You can delete instances within the All, Completed, In Progress, and Archived nodes. To view the new changes, refresh the contents of the tab. For more information, see Refresh on page 4-12.

To delete an instance:

1. Right-click on an instance, the Instance shortcut menu appears.

The available choices in the Instance shortcut menu vary depending on which node you have selected.

2. Select Delete. The Confirm Delete dialog box appears.

3. Select OK, and the instance is deleted. Click Cancel to terminate your selection.
Instance Properties

The Instance Properties dialog box allows you to view detailed information regarding an instance. It consists of the Workflows and Act History tabs. The Workflows tab lists the Workflow and the state the instance is in. It provides information on the last act taken. The Act History tab includes the history of acts taken on an instance, what the acts were and who performed the acts. This feature is read-only and cannot be edited.

To access the Instance Properties dialog box:

- Right-click on an instance and select Properties from the Instance shortcut menu. The Instance Properties dialog box appears.

Managing Reports

The Reports node allows you to view, create, generate, delete, and print reports. Before running a report, you must define report properties first. After report properties have been defined, you can
run the same report at different time intervals and as many times as needed. You can also schedule to run reports at specific times.

For more information, see:
- Report Properties on page 4-66
- Running Reports on page 4-71
- Viewing Reports on page 4-73
- Deleting Reports on page 4-73
- Printing Reports on page 4-73
- Report Scheduling on page 4-74

**Report Properties**

The Reports Properties feature allows you to create definitions for new reports prior to running them.

To create a new report definition:
1. Expand a business process node from which you wish to create a new report definition. The Reports node appears.
2. Right-click on the reports node and the Reports shortcut menu appears.
4. Right-click on the Temp node. The Reports Definition shortcut menu appears.

**Figure 4-54** Temp Node

4. Right-click on the Temp node. The Reports Definition shortcut menu appears.
6. Type in the title of the report in the Title text box. The default title for any report is “Temp.”

7. Type in the description of the report in the Description text box. The default description for any report is “This is a temporary report. To make permanent, change the properties and save.”

8. Select the report type from the Reports Type drop-down list. The following table provides descriptions of all available report types.

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process</td>
<td>Reports how many instances of a given business process definition were initiated.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Reports how many instances of a given workflow definition were initiated.</td>
</tr>
<tr>
<td>Performer’s Role</td>
<td>Reports how many instances of a given performer’s role definition were initiated.</td>
</tr>
</tbody>
</table>
Using the ApplicationXtender Workflow Administrator

**Table 4-14 Report Type Options (continued)**

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer's Role</td>
<td>Reports how many instances of a given customer's role definition were initiated.</td>
</tr>
<tr>
<td>Performer</td>
<td>Reports how many times a user has carried out a performer's role.</td>
</tr>
<tr>
<td>Customer</td>
<td>Reports how many times a user has carried out a customer's role.</td>
</tr>
</tbody>
</table>

9. Select the grouping of the report from the Group by drop-down list. The following table provides descriptions of all available grouping options.

**Table 4-15 Group By Options**

<table>
<thead>
<tr>
<th>Group by</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>Groups the information according to days.</td>
</tr>
<tr>
<td>Month</td>
<td>Groups the information according to months.</td>
</tr>
<tr>
<td>Year</td>
<td>Groups the information according to years.</td>
</tr>
</tbody>
</table>

10. Select the database for the report from the Database drop-down list. The following table provides descriptions of all available database options.

**Table 4-16 Database Options**

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both</td>
<td>Retrieves information from the active and archive databases.</td>
</tr>
<tr>
<td>Active</td>
<td>Retrieves information from the active database.</td>
</tr>
<tr>
<td>Archive</td>
<td>Retrieves information from the archive database.</td>
</tr>
</tbody>
</table>

11. Select the status of instances for the report from the Status drop-down list. The following table provides descriptions of all available Instance status options.
12. Select a time range of instances for the report from the Time drop-down list. The following table provides descriptions of all available time options.

<table>
<thead>
<tr>
<th>Time</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Reports all events since the installation of the specific business process version.</td>
</tr>
<tr>
<td>Today</td>
<td>Reports current day's events.</td>
</tr>
<tr>
<td>Week to date</td>
<td>Reports events that occurred from the beginning of the current week through the current day.</td>
</tr>
<tr>
<td>Month to date</td>
<td>Reports events that occurred the beginning of the current month through the current day.</td>
</tr>
<tr>
<td>Year to date</td>
<td>Reports events that occurred the beginning of the current year through the current day.</td>
</tr>
<tr>
<td>Range</td>
<td>Reports events within a date range that you specify in the From and To text boxes. The format for the date ranges is yyyy-mm-dd.</td>
</tr>
</tbody>
</table>

13. If needed, type in a user defined statement in the User Defined filter text box. The User Defined filter allows you to run reports based on conditions you specify. The format for a User Defined filter is <TableName.FieldName>=<Value>. While typing in a User Defined query the following syntax limitations apply:

- If you are typing a string - use single quotes (')
If you are typing numbers/integers - do not use quotes
Do not use double quotes (") in User Defined queries.

CAUTION
You should have knowledge of SQL before using this feature.

Data for the User Defined filter option is retrieved from specific database tables and can be viewed through the SQL Server Query Analyzer. To verify that you typed the User Defined filter correctly, click the Verify button. If the syntax is incorrect, a dialog box with a description of the error(s) will appear.

The following is a list of all database tables from which data can be retrieved:
- PBP
- PDEFBP
- PWF
- PDEFFORMFIELD
- PDEFWF
- PDEFAPPDATA
- PBAPXLink
- IXBPAPPDATA
- IXWFAPPDATA

14. You can also choose to display all report properties on the actual report by selecting the Include details on the report check box. If you choose this option, the report details will appear on the bottom of the report.

15. You can also choose which information will appear in the report by selecting either the Summary, Details, or Both radio buttons.

The Summary option has the following columns on the report:
- Business Process Definition
- Total
- Date Started

The Details option has the following columns on the report:
- Business Process Definition Name
- Business Process Id
Managing Business Process Instances

Using the ApplicationXtender Workflow Administrator

- Business Process Name
- Business Process Status
- Business Process State
- Business Process Start
- Business Process Last Modified
- Business Process End

The Both option allows you to include the columns from the Summary and Details options.

Running Reports

After defining the properties for a report, the next step is to run the report. If you have previously defined reports, you can run them numerous times. Reports are named with a data/time stamp and are listed under the Report Name node.

To run a report:

1. Select a business process from which you wish to run the report.
2. Expand the Reports node.
3. Right-click on a Report Definition node. The Reports Definition shortcut menu appears.
Reports are displayed as Web pages. A shortcut menu similar to the one in an Internet browser can be used for navigation and processing of the report. Since the reports are not displayed within a Web browser, some of the options on the Report Browser shortcut menu will not be available.

The following table describes available menu options in the Report browser options shortcut menu.

### Table 4-19 Report Browser Shortcut Menu Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>This feature is unavailable.</td>
</tr>
<tr>
<td>Forward</td>
<td>This feature is unavailable.</td>
</tr>
<tr>
<td>Save Background As</td>
<td>This feature is unavailable.</td>
</tr>
<tr>
<td>Set as Wallpaper</td>
<td>This feature is unavailable.</td>
</tr>
<tr>
<td>Copy Background</td>
<td>This feature is unavailable.</td>
</tr>
<tr>
<td>Select All</td>
<td>Allows you to highlight all of the information displayed in the report.</td>
</tr>
</tbody>
</table>
Viewing Reports

You can view existing reports. To view a report:

1. Select a business process from which you wish to view the report.
2. Expand the Reports node.
3. Expand a Report Definition node (Temp is the default name).
4. Click on a report and it will appear in the right pane of the AppXtender Workflow Administrator.

Deleting Reports

Any previously created report definitions or reports can be deleted from the AppXtender Workflow Administrator.

To delete a report:

1. Select a business process from which you wish to delete a report.
2. Expand the Reports node.
3. Right-click a report definition or a report, then select Delete from the shortcut menu. The Delete Verification dialog box appears.
4. Click OK to delete the report or click Cancel to terminate the deletion process.

Printing Reports

The Report printing feature allows you to print any previously created report. Since reports are displayed as Web pages, a shortcut menu similar to the one in an Internet browser is used to print reports.
To print a report:
1. Select a business process from which you wish to print a report.
2. Expand the Reports node.
3. Display the report as described in Viewing Reports on page 4-73.
4. Right-click on the report and select Print from the Report browser shortcut menu. The Print dialog box appears.

5. Select the printer settings you wish to use and click OK.

**Report Scheduling**

You can schedule to run AppXtender Workflow Administrator reports through SQL. The stored procedure name is xp_RunWfxRpt.

The parameters of the stored procedure are:
- Report ID
- Database
- Output File Name

To run the stored procedure, you will need to enter the following in the ISQL Query Analyzer window:

```
Exec xp_RunWfxRpt <Database Name>, <report ID>, <Output file name>
```
Refer to the Microsoft SQL Server Manuals for more information regarding the scheduling and running of extended stored procedures.
**Managing Users**

The Users node allows you to reassign items in the Workflow system to different users. For example, if one user is sick or unable to keep up with his or her workload, the system administrator can reassign items to different users who perform the same role within the Workflow system. You are also able to reconcile users by assigning AppXtender Workflow users to ApplicationXtender and vice versa. You can also change task priority, thus allowing instances to be processed at a different priority level in the Workflow system.

For more information, see the following sections:

- *User Reconciliation* on page 4-77
- *User Reassignment* on page 4-86
- *Changing Task Priority* on page 4-87

You must expand the Users node before all features are available.

The following flow chart represents AppXtender Workflow Administrator user management.

![Users Node Features](Figure 4-58)
**User Reconciliation**

User Reconciliation allows you to import AppXtender Workflow users into ApplicationXtender and vice versa. This tool is useful because it does not require system administrators to manually add existing AppXtender users into AppXtender Workflow and vice versa.

If this is your first time accessing user reconciliation, then you will be required to set up an ApplicationXtender data source. You can set up more than one AppXtender data source in order to access different servers.

**CAUTION**

User Reconciliation can only be used with Content Management (CM) Security. It cannot be used with AppXtender applications using the NT Security model. For more information, see ApplicationXtender Administrator’s Guide.

To set up an AppXtender data source:

1. Right-click on the Users node and select Reconcile from the shortcut menu. The AppXtender data source name dialog box appears.

   ![AppXtender Data Source Name Dialog Box](image)

   **Figure 4-59 AppXtender Data Source Name Dialog Box**

2. Type in a name for the AppXtender data source. It is recommended that the name of the data source be the same name as the data source used in ApplicationXtender.

3. Click OK. The Provider tab of the Data Link Properties dialog box appears.
4. Select a provider. The provider you select may vary depending on which ApplicationXtender database is being used. For more information, refer to the ApplicationXtender Installation Guide.

5. Select or enter a server name.
6. Enter the server logon information. If not using Windows NT Integrated Security, choose the Use a specific user name and password radio button. Enter the user name and password in the corresponding text boxes. If you choose to leave the password blank, then select the Blank password check box.

7. Select the database on the server or attach a database file as a database name.

8. Click the Test Connection button to make sure that the data source connection is successful. If the data source connection is successful, then the Data Link dialog box appears letting you know that the connection has succeeded.

9. Click OK.

After you have set up all of the required data sources, you may start to reconcile users from ApplicationXtender to AppXtender Workflow and vice versa.

To reconcile AppXtender Workflow users with AppXtender:

1. Right-click on the Users node and select Reconcile. The AppXtender Database Login dialog box appears.

![Figure 4-62 AppXtender Database Login Dialog Box](image)

2. Click the More button to expand the dialog box.

3. Type in your username and password in the corresponding text boxes.

4. Select the data source you wish to connect to from the Data Source Name drop-down list.
To set up a new data source, click the New button and repeat the procedure above.

To delete a data source, click the Delete button. A confirmation message will appear. Confirm the deletion and all of the information in the AppXtender Database Login dialog box will be deleted.

5. Click OK. The Reconcile AppXtender Workflow Users with AppXtender Users dialog box appears.

6. Select the AppXtender Workflow user you wish to add to AppXtender in the AppXtender Workflow Users list window and click the Add to AppXtender button.

You can use the multi-select feature to select more than one user at a time.

The Group Selection dialog box appears.
7. Select the AppXtender group(s) to which to assign the new user and click the OK button. The user is now listed in the Users of AppXtender and AppXtender Workflow to Reconcile list window. The selected AppXtender group(s) are displayed in the Groups list window with a check mark in the corresponding check box.

If a user has not been assigned to a group, a check mark will not appear in the corresponding check box.
To add the user to any additional groups, you can select the check box corresponding to the group you wish to assign in the Groups list window.

8. Assign a password to the new AppXtender user by selecting one of the radio buttons in the Password section of the Reconcile AppXtender Workflow Users with AppXtender Users dialog box. You have the following choices:
   - Blank (a password will not be required upon login into AppXtender)
   - ‘PASSWORD’ (the word “PASSWORD” will be used as the password upon login into AppXtender)
   - User Name (the user’s user name will be used as the password upon login into AppXtender).

If you are reconciling more than one user at a time, the chosen password setting will be applied to all selected users.
9. Click OK. The AppXtender Workflow user is added to the AppXtender list of users. You can use Application Generator in AppXtender to confirm that the user has been reconciled. For more information regarding Application Generator, refer to the ApplicationXtender Administrator’s Guide.

To reconcile AppXtender users with AppXtender Workflow:

1. Right-click on the Users node and select Reconcile from the shortcut menu. The AppXtender Database Login dialog box appears.

2. Click the More button to expand the dialog box.

3. Type in your username and password in the corresponding text boxes.

4. Select the data source you wish to connect to from the Data Source Name drop-down list.
   To set up a new data source, click the New button and repeat the procedure above.
   To delete a data source, click the Delete button. A confirmation message will appear. Confirm the deletion and all of the information in the AppXtender Database Login dialog box will be deleted.

5. Click OK. The Reconcile AppXtender Workflow Users with AppXtender Users dialog box appears.

6. Select the AppXtender user you wish to add to AppXtender Workflow in the AppXtender Users list window and click the Add to AppXtender Workflow button.
   You can use the multi-select feature to select more than one user at a time.
   The Role Selection dialog box appears.
Using the ApplicationXtender Workflow Administrator

Figure 4-66  Role Selection Dialog Box

7. Select the AppXtender Workflow role(s) you wish to assign to the user and click OK. The new user appears underneath the To AppXtender Workflow node in the Users of AppXtender and AppXtender Workflow to Reconcile list window. The roles assigned to the user roles appear in the Roles list window with a check mark in the corresponding check box.

If a user has not been assigned to a specific role, a check mark will not appear in the corresponding check box.
To assign any additional roles to the user, you can select the check box corresponding to the role you wish to assign in the Roles list window.

8. Assign a password to the new AppXtender Workflow user by selecting one of the radio buttons in the Password section of the Reconcile AppXtender Users with AppXtender Workflow Users dialog box. You have the following choices:

- Blank (a password will not be required upon login into AppXtender Workflow)
- 'PASSWORD' (the word “PASSWORD” will be used as the password upon login into AppXtender Workflow)
- User Name (the user’s user name will be used as the password upon login into AppXtender Workflow).

If you are reconciling more than one user at a time, the chosen password setting will be applied to all selected users.

9. Click OK. The AppXtender user is added to the AppXtender Workflow list of users.
The User Reassignment feature allows you to reassign items in the Workflow system to different users who perform the same role within a workflow. In order to be able to reassign instances to different users, the role of the original user must be assigned to more than one user in the Workflow system. The role assignment in the business process is defined in the business process map. For more information, refer to the *ApplicationXtender Workflow Process Builder Guide*. You can reassign one or multiple items at one time, but all of those items must be assigned to the same role.

To reassign a user:

1. Expand the Users node. The list of all the users for all of the workflows in the business process appears in the right pane of the AppXtender Workflow Administrator.
2. Click on the user whose items you wish to reassign. The items assigned to that user appear in the right pane of the AppXtender Workflow Administrator.
3. Right-click on the item you wish to reassign and select Reassign from the Workflow User shortcut menu.

   You can multi-select more than one item by pressing the Ctrl key and selecting items simultaneously or holding down the Shift key and selecting the items continuously.

   If the selected items are not all assigned to the same role, when the administrator right-clicks, the menu displayed will not contain the Reassign option, it will only contain the Refresh and Help options.

The AppXtender Workflow Users dialog box appears with the list of all users who perform the same role in the workflow.
Managing Users

Using the AppXtender Workflow Administrator

CAUTION

If there is only one user performing a role within a workflow, the AppXtender Workflow Users dialog box will be empty, which means that you cannot reassign the item to another user. Click the Cancel button to exit out of the dialog box.

4. Select the user you wish to re-assign the items to and click the OK button. The item is moved to the new users node in the AppXtender Workflow Administrator in the user’s Inbox in the AppXtender Workflow Workbox.

Changing Task Priority

The Change Task Priority feature allows you to change the task priority of a business process instance. This feature is helpful if certain items within the workflow system need to be processed at a different priority level. For example, if you need a certain task processed immediately due to unforeseen circumstances, the system administrator can change the priority of the instance so that it will be processed at the higher priority level. The task priority can be changed for multiples instances simultaneously.

To change task priority:

1. Expand the Users node and select the user whose task priority you would like to change.

2. In the right pane of the screen, right-click on the business process instance you would like to change the priority for.

   You can use the multi-select feature to select more than one item at a time. To use the multi-select feature, select the <Ctrl> key and select the items simultaneously or use the <Shift> key and select a list of items.

   Right-click on the selected item(s). The Workflow User shortcut menu appears.

4. If selecting one item, the current priority of the selected item is shown in the Enter the Priority text box. If you selected more than one item, the priority will be set to 50.

Type in or select the new priority for the selected item(s).

5. Click OK to exit. The priority of the selected item(s) has been changed.

Figure 4-69  Priority Dialog Box
Exiting the AppXtender Workflow Administrator

After you have finished your administrative tasks, you can exit the AppXtender Workflow Administrator.

To exit the AppXtender Workflow Administrator:

1. Select Exit from the Console menu or click the Close button ( ). The Microsoft Management Console dialog box appears.

2. You can perform one of the following:
   - To save you console settings to wfx.msc, click Yes. Your settings are saved and the AppXtender Workflow Administrator closes.
   - To not save your settings to wfx.msc, click No. Your settings are not saved and the AppXtender Workflow Administrator closes.
   - To cancel your exit command, click Cancel. The AppXtender Workflow Administrator remains open.
This chapter describes how to use the ApplicationXtender Workflow (AppXtender Workflow) Import Utility.

- Introduction ................................................................. 5-2
- Starting the ApplicationXtender Workflow Import Utility .... 5-3
- Monitored Directories ................................................. 5-4
- ApplicationXtender Workflow Import Utility Service ....... 5-9
- Error Logs ................................................................. 5-10
Introduction

The ApplicationXtender (AppXtender) Workflow Import Utility works in conjunction with the AppXtender Workflow Standalone Client to allow users to configure monitored directories which will initiate new workflow instances when a file is added to those directories with the new file attached. The Import Utility acts as a service as discussed in ApplicationXtender Workflow Import Utility Service on page 5-9.
Starting the ApplicationXtender Workflow Import Utility

To start the AppXtender Workflow Import Utility:

1. From the Windows Start menu, select Programs and then ApplicationXtender Workflow. From the ApplicationXtender Workflow program group, select Import Utility Configuration. The ApplicationXtender Workflow Import Utility dialog box appears.

2. In the Workflow User Name text box, enter a valid user name. The user entered here is the user who the system will start the business process as. Therefore, the user must have privileges to start all of the business processes initiated by the configuration.

3. In the Workflow User Password text box, enter a valid password.

4. In the Workflow Server text box, enter a valid server name.

5. In the Workflow Database text box, enter a valid database name.
Monitored Directories

Two directories must be configured using the AppXtender Workflow Import Utility: a directory to be monitored, and a directory to store files. A directory that is monitored will send notifications to the import utility if a file is dropped (or pasted) into it. For normal file system files, the import utility will start a new instance of a business process. The dropped file is immediately moved out of the monitored directory to the directory to store files and is attached to the new business process. A specially formatted XML file can also be dropped (or pasted) into the monitored directory, allowing business process fields to be populated. For more information about the XML file, see Batch Imports on page 5-7.

Adding Monitored Directory Configurations

To add directories to be monitored:

1. In the Monitored Items section of the ApplicationXtender Workflow Import Utility dialog box, click Add.

   The Configuration dialog box appears.

   ![Configuration Dialog Box](image)

   Figure 5-2 Configuration Dialog Box

2. In the Directories section, enter the file paths to the directory to monitor and the directory to store files in the respective text boxes. You can enter the file paths manually or click Browse to navigate to the directory.
5. In the Business Process to Start section, select the business process from the drop-down list.

If the business process has required fields that this utility cannot automatically populate, the tool will not work properly.

4. Click Next. The Scheduling dialog box appears.

5. From the Monitoring schedule section of the Scheduling dialog box, select when you want the directory monitored. You have the following options:

- Always - the directory is constantly monitored for new files.
- Daily - the directory is monitored each day but only between the hours selected in the Start and Stop boxes.
- Weekly - the directory is monitored weekly between the hours and days selected in the Start and Stop boxes and drop-down lists.

Figure 5-3 Scheduling Dialog Box
Using the ApplicationXtender Workflow Import Utility

6. From the Purging schedule section of the Scheduling dialog box, select when you files purged from the COMPLETED directory, which is a subdirectory of the directory to monitor. For more information about the COMPLETED directory, see Batch Imports on page 5-7. You have the following options:
   - Never - the files are never purged from the directory.
   - Daily - the files are purged each day at the time selected from the Start drop-down list. If the AM check box is not enabled, then PM is assumed.
   - Weekly - the files are purged once a week on the day and time selected from the Start drop-down lists.

7. Select how old the files to be purged should be. You can select any number of days, weeks, or months.

8. Click Finish. The monitored directory configurations are displayed in the Monitored Items list box of the ApplicationXtender Workflow Import Utility dialog box.

Deleting Monitored Directory Configurations

To delete items from the Monitored Items list box:

1. Select the item(s) to delete from the Monitored Items section of the ApplicationXtender Workflow Import Utility dialog box, click Delete.

A confirmation message appears.
Using the ApplicationXtender Workflow Import Utility

2. Click Yes to delete the selected item(s) or click No to return to the ApplicationXtender Workflow Import Utility dialog box without deleting.

Modifying Monitored Directory Configurations

To modify items from the Monitored Items list box:

1. Select the item from the Monitored Items section of the ApplicationXtender Workflow Import Utility dialog box, click Modify.

2. Make any necessary changes and then click Next. The Scheduling dialog box appears.

3. Make any necessary changes and then click Finish to return to the Import Utility dialog box.

Batch Imports

The ApplicationXtender Workflow Import Utility allows both single and batch imports.

To perform a single import:

- Drop or paste a file system file into a monitored directory.

If a user attempts to paste a file into the directory to start a business process, and does not have the appropriate rights, nothing will happen. The file will not get moved, the business process will not start, and no error is reported.

The file is attached to a new business process, but with the following limitations:

- Only one file can be attached to the new business process and the field values of the business process cannot be specified.

If the business process has required fields that this utility cannot automatically populate, the tool will not work properly.
A batch import remedies these limitations by allowing the user to list multiple files to attach to each business process, and define the field values in a specially formatted XML file.

To perform a batch import:

1. Drop (or paste) all files to be attached to business processes into the FILES subdirectory of the monitored directory.
2. Construct the XML file and drop (or paste) it into the monitored directory.

A sample XML file is listed below:

```xml
<Batch>
  <Fields>
    <Field Label="BPInstanceName" Value="John's LEAVEREQUEST form" />
    <Field Label="AX_Document" Value="LEAVEREQUEST.doc" />
    <Field Label="a_Name" Value="John Doe" />
    <Field Label="b_City" Value="Chicago" />
    <Field Label="c_Social" Value="222222222" />
  </Fields>
  <Fields>
    <Field Label="BPInstanceName" Value="Joe's two LEAVEREQUEST forms" />
    <Field Label="AX_Document" Value="LEAVEREQUEST1.doc" />
    <Field Label="AX_Document" Value="LEAVEREQUEST2.doc" />
    <Field Label="a_Name" Value="Joe Green" />
    <Field Label="b_City" Value="Atlanta" />
    <Field Label="c_Social" Value="333333333" />
  </Fields>
</Batch>
```

This sample XML file creates two business processes: "John's Leave Request", which has one attached document ("LEAVEREQUEST.doc"), and "Joe's Two Leave Requests", which has two attached documents ("LEAVEREQUEST1.doc" and "LEAVEREQUEST2.doc"). The three DOC files must be in the FILES subdirectory before the XML file can be dropped (or pasted) into the monitored directory. The XML file is immediately moved to either the COMPLETED or FAILED subdirectory of the monitored directory, depending on whether or not the batch was successfully imported.
Using the ApplicationXtender Workflow Import Utility

ApplicationXtender Workflow Import Utility Service

The ApplicationXtender Workflow Import Utility service can be started or stopped from two places: the ApplicationXtender Workflow Import Utility dialog box or the Windows Services console. The service must be restarted if any changes are made to the ApplicationXtender Workflow Import Utility dialog box.

Starting the ApplicationXtender Workflow Import Utility Service

To start the ApplicationXtender Workflow Import Utility service:

- You have the following options:
  - From the Service section of the ApplicationXtender Workflow Import Utility dialog box, click Start.
  - From the Windows Services console, right-click the AppXtender Workflow Import Utility Service and select start.

Stopping the ApplicationXtender Workflow Import Utility Service

To stop the ApplicationXtender Workflow Import Utility service:

- You have the following options:
  - From the Service section of the ApplicationXtender Workflow Import Utility dialog box, click Stop.
  - From the Windows Services console, right-click the AppXtender Workflow Import Utility Service and select Stop.
Using the ApplicationXtender Workflow Import Utility

Error Logs

Error logs for the AppXtender Workflow Import Utility are stored in the Windows Event Viewer.

Log Levels

The log level option allows you to define what type of log information is recorded by the ApplicationXtender Workflow Import Utility. You have three choices: Error, Batch, and Item. Error level allows you to log all errors. Batch level allows you to log all errors plus information on each batch of imports (start/stop time, number of business processes initiated). Item level allows you to log all errors plus batch information plus information on each business process initiated.

All log information can be viewed in the Event Viewer.

To configure the log level:

- From the Service section of the ApplicationXtender Workflow Import Utility dialog box, select one of the following options from the Log level drop-down list:
  - Error Level
  - Batch Level
  - Item Level
This chapter describes how to use the ApplicationXtender Monitor.

- Introduction .................................................................6-2
- File Menu .........................................................................6-5
- View Menu .......................................................................6-6
- Help Menu .......................................................................6-8
- ApplicationXtender Monitor Polling Intervals .................6-9
- Monitoring Services ......................................................6-12
- Exiting the ApplicationXtender Monitor .......................6-17
Using the ApplicationXtender Monitor

Introduction

The ApplicationXtender Monitor polls the Event Log for errors recorded for ApplicationXtender Workflow (AppXtender Workflow) services that are being monitored on remote machines. It then audits and records those errors and displays error message text in its interface. The ApplicationXtender Monitor can poll the AppXtender Workflow Automated Task Manager, the Transaction Manager, and SQL Server services.

The ApplicationXtender Monitor tray icon appears as a stoplight with red, yellow, and green colors. The tray icon appears in the bottom-right corner of your screen when the ApplicationXtender Monitor is running (in the Windows Task bar system tray). A green light signifies that there are no errors in any of the monitored services. A yellow light signifies that there have been errors, but you have seen them already. A red light signifies that new errors have occurred.

The ApplicationXtender Monitor also has powerful scripting capabilities. Scripts can be attached to each service being monitored. For example, you can write a script that will send you an e-mail with specific error information each time an error occurs. Scripts can be written to perform an array of different functions, thus providing you with greater error handling flexibility.

Figure 6-1 ApplicationXtender Monitor Tray Icon

For more information, see the following sections:

- Starting the ApplicationXtender Monitor on page 6-3
- File Menu on page 6-5
- View Menu on page 6-6
- Help Menu on page 6-8
- Monitoring Services on page 6-12
- ApplicationXtender Monitor Polling Intervals on page 6-9
- Exiting the ApplicationXtender Monitor on page 6-17
Starting the ApplicationXtender Monitor

Use the following procedure to start the ApplicationXtender Monitor.

To start the ApplicationXtender Monitor:

- You can perform one of the following:
  - If the ApplicationXtender Monitor is not running on your machine, select Start, then Programs, choose AppXtender Workflow, and then select ApplicationXtender Monitor.
  - If the ApplicationXtender Monitor is running on your machine and the interface is not displayed, right-click or double-click on the stop light tray icon and select Open from the shortcut menu.

Figure 6-2 ApplicationXtender Monitor Tray Icon Shortcut Menu

The ApplicationXtender Monitor interface appears.

Figure 6-3 ApplicationXtender Monitor
Using the ApplicationXtender Monitor

For more information, see:
- Exiting the ApplicationXtender Monitor on page 6-17
File Menu

The File menu only allows you to exit the ApplicationXtender Monitor interface. For more information, see Exiting the ApplicationXtender Monitor on page 6-17.
Using the ApplicationXtender Monitor

View Menu

The View menu allows you to toggle display of the toolbar, status bar, as well as refresh the displayed error list, and access the Settings dialog box.

- The toolbar allows you to display items in the right pane of the ApplicationXtender Monitor as large and small icons, in a list, or in a list with items details information. You are also able to access online help from the toolbar. For more information, see Help Menu on page 6-8.
- The status bar allows you to view ToolTips, whether a script is attached to a service, as well as basic information about an ongoing task.
- The Refresh option allows you to refresh the displayed error list in the right pane of the ApplicationXtender Monitor interface. For more information, see Refreshing the Error List on page 6-16.
- The Settings option allow you to access the Settings dialog box, where you can define the maximum number of errors displayed per monitored service. For more information, see Settings Dialog Box on page 6-6.

Settings Dialog Box

The Settings dialog box for the ApplicationXtender Monitor allows you to define the maximum number of errors displayed per monitored service. The default number of displayed errors is 100. If you set the number to 0, the ApplicationXtender Monitor will display an unlimited number of errors.

To define the maximum number of errors displayed:

1. If you have the ApplicationXtender Monitor interface displayed, select Settings from the View menu or right-click on the ApplicationXtender Monitor tray icon and select Settings from the shortcut menu. The Settings dialog box appears.
2. Type in the number of errors you wish to be displayed per service (where 0 indicates that an unlimited number of errors can be displayed).

3. Click OK to save your new settings and exit the Settings dialog box.
The Help menu for the ApplicationXtender Monitor contains commands for online help options, product version and copyright information.

The following table lists and describes all available options in the Help menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents…</td>
<td>Displays the help file Table of Contents.</td>
</tr>
<tr>
<td>Search…</td>
<td>Displays the help file Search tab.</td>
</tr>
<tr>
<td>Index…</td>
<td>Displays the help file index.</td>
</tr>
<tr>
<td>About Monitor</td>
<td>Displays the copyright information for the ApplicationXtender Monitor in the About dialog box.</td>
</tr>
</tbody>
</table>
ApplicationXtender Monitor Polling Intervals

By default, the ApplicationXtender Monitor will check for new errors every 10 minutes. The polling interval for the ApplicationXtender Monitor can be changed through the Scheduled Tasks of your operating system.

To change a polling intervals:

1. Select Scheduled Tasks. The ApplicationXtender Monitor task has been automatically added during the installation.
   
   In Windows 2000, the Scheduled Tasks can be accessed from the Control Panel. Refer to your operating system documentation if you do not know how to access Scheduled Tasks on your machine.

2. Double-click on the ApplicationXtender Monitor task or right-click on the ApplicationXtender Monitor task and select Properties from the shortcut menu. The ApplicationXtender Monitor Properties dialog box appears.

3. Click on the Schedule tab in order to activate it.

Figure 6-5 ApplicationXtender Monitor Properties Dialog Box - Task Tab
Using the ApplicationXtender Monitor

Figure 6-6  ApplicationXtender Monitor Properties Dialog Box - Schedule Tab

4. Click the Advanced button. The Advanced Schedule Options dialog box appears.

Figure 6-7  Advanced Schedule Options Dialog Box

5. Ensure the Repeat task check box is enabled.
6. Type in how often the ApplicationXtender Monitor will poll for errors and select whether the ApplicationXtender Monitor will poll on an hourly or minute basis.
7. Select a duration for the polling using one of the following methods:
   - Enable the Time radio button and enter a specific time within the Time spin box.
   - Enable the Duration radio button and enter the number of hours and minutes the monitor will poll in the hour(s) and minute(s) spin boxes.
8. To stop polling at the time specified in Step 7, enable the If the task is still running, stop at this time check box.
9. Click OK to exit the Advanced Schedule Options dialog box.
10. Click OK to exit the ApplicationXtender Monitor Properties dialog box.

You must have administrative privileges in order to change polling intervals for the ApplicationXtender Monitor on your machine. Contact your system administrator to find out whether you have administrative privileges on your machine.
Monitoring Services

The ApplicationXtender Monitor can monitor several machines with multiple services running simultaneously. It observes three services:

- AppXtender Workflow Automated Task Manager
- AppXtender Workflow Transaction Manager
- SQL Server.

The ApplicationXtender Monitor interface displays all monitored servers along with the services that are being monitored on that server. Each server and service have their own node. From those nodes, a shortcut menu can be accessed which will provide you with the Attach and Detach Script options, Start and Stop Monitoring options, Refresh option, and Clear option.

The shortcut menu options accessed from different nodes in the ApplicationXtender Monitor interface will perform different functions based on the node from which the option is being accessed.

- If you access the shortcut menu from the ApplicationXtender Monitor node, the option you select from the shortcut menu will apply to all servers and services being monitored.
- If you access the shortcut menu from a specific server node, the option you select will apply to all services being monitored for that specific server.
- If you access the shortcut menu from a service node, the option you select will only apply to that service.

For more information, see:

- Start Monitoring on page 6-12
- Stop Monitoring on page 6-14
- Attaching a Script on page 6-14
- Detaching a Script on page 6-15
- Refreshing the Error List on page 6-16
- Clearing the Error List on page 6-16

Start Monitoring

Before you can start monitoring a new service, you must first add the service to the ApplicationXtender Monitor.

To start monitoring:
1. You can perform one of the following:
   - To start monitoring new services on a new server, right-click on the ApplicationXtender Monitor node and select Start Monitoring from the shortcut menu.
   - To add an additional service to be monitored, right-click on the server node where you want to add the service, and select Start Monitoring from the shortcut menu.

   The Monitor dialog box appears.

   If you are adding more services to be monitored under a previously added server node, the server text box will be disabled.

2. If this is a new server you are adding - enter the server name to monitor in the Server text box.

3. Select the service(s) you wish to monitor by enabling the corresponding check box(es).

4. Click OK.
Once you are monitoring a service, you can stop monitoring that service.

To stop monitoring:

- You can perform one of the following:
  - To stop monitoring all services on a specific server, right-click the on that server node and select Stop Monitoring from the shortcut menu. All services being monitored on that server will no longer be monitored by the ApplicationXtender Monitor and the server node is removed from the ApplicationXtender Monitor interface.
  - To stop monitoring a specific service, right-click on that service node and select Stop Monitoring from the shortcut menu. The service node is removed from the ApplicationXtender Monitor interface and is no longer monitored.

You can attach a script to a server node or a specific service. Once you attach a script to a server node, it will run for every service being monitored on that server. When you attach a script to a specific service, the script will run only for that service.

To attach a script:
1. You can perform one of the following:
   - To attach a script to all services being monitored on a specific server, right-click on that server node and select Attach Script from the shortcut menu.
   - To attach a script to a specific service, right-click on that service node and select Attach Script from the shortcut menu.

The Open dialog box appears.

2. Navigate to the location of your script.
3. Select the script you wish to attach and click Open. The script is attached.

Once the script is attached, its path is displayed in the status bar on the bottom of the ApplicationXtender Monitor interface when a service or a server node are selected.

**Figure 6-11** Status Bar

---

**Detaching a Script**

Once a script has been attached to a server node or a service, you can detach that script.

To detach a script:
You can perform one of the following:

- To detach a script from a server node, right-click on that server node and select Detach Script from the shortcut menu.
- To detach a script from a specific service, right-click on that service node and select Detach Script from the shortcut menu.

The script is detached and is no longer displayed in the status bar.

---

**Refreshing the Error List**

When errors occur, they are displayed in the right pane of the ApplicationXtender Monitor interface. The error list is automatically refreshed during each polling interval. You can also manually refresh it. For more information regarding polling intervals, see *ApplicationXtender Monitor Polling Intervals* on page 6-9.

To refresh the error list:

- Right-click on any node and select Refresh from the shortcut menu or select Refresh from the View menu. The error lists for all monitored services are refreshed.

---

**Clearing the Error List**

You can clear the displayed error list if you no longer wish to see those errors in the ApplicationXtender Monitor interface.

To clear the error list:

- You can perform one of the following:
  - To clear all errors, right-click on the ApplicationXtender Monitor node and select Clear from the shortcut menu.
  - To clear errors for a specific server, right-click on that server node and select Clear from the shortcut menu.
  - To clear errors for a specific service, right-click on that service node and select Clear from the shortcut menu.
Exiting the ApplicationXtender Monitor

Closing the ApplicationXtender Monitor interface is not the same as exiting the ApplicationXtender Monitor. When you close the ApplicationXtender Monitor interface, the stop light tray icon will remain in your Windows Task bar system tray.

To exit the ApplicationXtender Monitor:

- You can perform one of the following:
  - To exit from the ApplicationXtender Monitor interface, select Exit from the File menu.
  - To exit using the ApplicationXtender Monitor tray icon, right-click on the tray icon and select Exit from the shortcut menu.
The ApplicationXtender (AppXtender) Workflow Web Access Administration site provides a secure environment for system administrators to manage settings, user profiles, workflow sessions, transactions, and errors. The Administration window is a secure area of AppXtender Workflow Web Access to which only administrators have access.

- Starting the ApplicationXtender Workflow Web Access Administration Site..........................................................7-2
- Logging Out of the ApplicationXtender Workflow Web Access Administrator’s Site.........................................................7-4
- Configuring AppXtender Workflow Web Access Settings ..........7-5
- Managing User Profiles.................................................................7-12
- Managing Sessions...........................................................................7-14
- Monitoring Transactions ...............................................................7-15
- Viewing Transaction Errors ..........................................................7-20
Starting the ApplicationXtender Workflow Web Access Administration Site

Use the following procedure to start the AppXtender Workflow Web Access Administrator.

To start the AppXtender Workflow Web Access Administration site:

1. To launch the site, you have the following options:
   - From the Windows Start menu, select Programs and then ApplicationXtender Workflow. From the ApplicationXtender Workflow program group, select Workflow Web Administrator.
   - Using Internet Explorer, enter the URL for the AppXtender Workflow Web Access Administration site in the Address bar. The URL is typically http://servername/WfX/Admin/Default.aspx

The AppXtender Workflow Web Access Administration Login page appears.
Starting the ApplicationXtender Workflow Web Access Administration Site

2. Enter the following information:
   • In the Server text box, enter the name of the server to which you are connecting.
   • In the Database text box, enter the name of the database to which you are connecting.
   • The User Name text box is automatically populated with the awsadmin user name, and is read-only.
   • In the Password text box, enter the password for the awsadmin user name.

3. Click OK. The AppXtender Workflow Web Access Administration window appears, with the Settings page displayed by default.

For more information, see:
   • Logging Out of the ApplicationXtender Workflow Web Access Administrator’s Site on page 7-4
Logging Out of the ApplicationXtender Workflow Web Access Administrator’s Site

You can logout of the Administrator’s site at anytime, from any of the pages.

To logout of the AppXtender Workflow Web Access Administrator’s site:

1. From any of the AppXtender Workflow Web Access Administrator pages, choose one of the following options:
   - From the File menu, select Logout.
   - Click the Logout toolbar button.

2. If you have not saved your changes, a dialog box appears asking whether you would like to save your changes before closing the site. Click Yes to save, or click No to close without saving.

   If you are on the Settings page and logout before saving your changes your changes will be lost.

For more information, see:

- Starting the ApplicationXtender Workflow Web Access Administration Site on page 7-2
Configuring AppXtender Workflow Web Access Settings

The Settings page of the AppXtender Workflow Web Access Administration window allows you to manage workflow settings, ApplicationXtender Web Access settings, the impersonation account, and page visibility.

To view the Settings page:

- From the View menu of the AppXtender Workflow Web Access Administration window, select Settings. The Settings page appears.

Figure 7-3 ApplicationXtender Workflow Administration Site - Settings Page

For more information, see:
- Saving Settings on page 7-6
Managing ApplicationXtender Workflow Web Access

- Configuring Workflow Settings on page 7-7
- Configuring ApplicationXtender Web Access Settings on page 7-9
- Configuring the Impersonation Account on page 7-10
- Configuring Page Visibility on page 7-11

Saving Settings

You must save any changes that you make to the Settings page of the AppXtender Workflow Web Access Administration window before closing.

To save changes made on the Settings page:

1. Click the Save toolbar button

![Save Button](image)

A message appears indicating that all open sessions will be terminated upon saving changed settings. Click OK to continue or Cancel to return to the Settings page without saving your changes or terminating the open sessions.

2. The Validation Results page appears if one or more settings failed to validate. This page will show you which settings are incorrectly configured and ask whether you wish to continue despite the error. Click Yes to continue or click No to return to the Settings page without saving.

Clearing All Cached Items

AppXtender Workflow Web Access allows you to clear cached settings including the keyword substitutions, the columns, and the workflow server settings.

When customizing settings, if you discover the changes are not occurring, clearing the cached items may help. Also, if a user gets locked out of the system, clearing the cache will clear out that user’s session allowing them to log back in to the system.

To clear the cached items:

- Click the Clear Cache toolbar button.
Validating Administrative Settings

Before saving your settings and logging out of the Settings page, you can validate your settings to ensure their accuracy.

To validate settings:
1. Click the Validate toolbar button.

The Validation Results page appears indicating whether the validation failed or was successful.
2. Click OK to return to the Settings page.

Configuring Workflow Settings

The Workflow Settings section of the Settings page allows you to configure the Workflow server and database for your system. It also allows you to enable or disable performance counters.

To configure the Workflow settings:
1. In the Server Name text box, enter the name of your AppXtender Workflow Web Access server.
Managing ApplicationXtender Workflow Web Access

2. In the Database Name text box, enter the name of your AppXtender Workflow database that was created during the installation of ApplicationXtender Workflow.

3. If you want a non-AppXtender Workflow user to be able to access business process items that are e-mailed to them on the web, in the Workon URL User text box, enter the generic user information. For more information, refer to the ApplicationXtender Workflow Process Builder Administrator’s Guide.

4. If you want to enable performance counters for AppXtender Workflow Web Access, select the Performance Counters option.

5. Save your changes as described in Saving Settings on page 7-6.

The Performance Counters option uses the Windows Performance Monitor to track the performance of ApplicationXtender Workflow web server.

To view the Windows Performance Monitor:

- From the Windows Start menu, select Programs and then Administrative Tools. From the Administrative Tools program group, select Performance. The Performance dialog box appears.

![Figure 7-8 Performance Dialog Box](image)
Configuring ApplicationXtender Web Access Settings

The ApplicationXtender Web Access Settings section allows you to configure the ApplicationXtender Web Access integration information for ApplicationXtender Workflow Web Access. This information may have been configured during the installation of ApplicationXtender Workflow.

Figure 7-9 Settings Page - ApplicationXtender Web Access Section

To configure ApplicationXtender Web Access settings:

1. In the URL text box, enter the URL used to connect to ApplicationXtender Web Access when opening documents from the Work On window.

2. Click Setup, to the right of the Web Service User text box. The Setup User Setup dialog box appears.

3. In the User text box, enter your ApplicationXtender Web Access user name.

4. In the Password text box, enter the password for the ApplicationXtender Web Access user name entered in the User text box.

5. In the Confirm Password text box, enter the password again. This ensures data entry accuracy.
Managing ApplicationXtender Workflow Web Access

6. Click OK. The ApplicationXtender Web Access User Setup dialog box closes and the Settings page is displayed.

7. Save your changes as described in Saving Settings on page 7-6.

Configuring the Impersonation Account

This section allows you to configure the user’s rights to access files in the file system.

To configure file access:

1. Click Setup, to the right of the User Account text box. The User Account Setup dialog box appears.

2. In the User text box, enter the domain and user name.

3. In the Password text box, enter the password for the user entered in the User text box.

4. In the Confirm Password text box, enter the password again. This ensures data entry accuracy.

5. Click OK. The Setup User dialog box closes and the Settings page is displayed.

6. Save your changes as described in Saving Settings on page 7-6.
Configuring Page Visibility

The Pages section of the Settings page allows you to configure which Workbox pages can be viewed by a user, depending on their privileges. For more information, see Identities on page 3-39.

To configure which pages can be viewed:

1. Select either the Admin or User option.
2. Enable each Workbox page that the specified type of user will be able to view.

   A user with Admin privileges will be able to view only the pages that are enabled when the Admin option is selected. A user with User privileges will be able to view only the pages that are enabled when the User option is selected.
3. Save your changes as described in Saving Settings on page 7-6.
Managing User Profiles

The User Profiles page of the AppXtender Workflow Web Access Administration site allows you to view and delete user profiles from the system. A user profile is created once a user logs into and then out of the AppXtender Workflow Web Access system. That information is then saved in the database. Deleting a user profile from the User Profiles page simply deletes the saved settings information from the database table. That user will still be able to log into the system. Their settings will return to the default user settings.

To view the User Profiles page:

- From the View menu, select User Profiles. The User Profile page appears.

To view user profiles:

- Double-click the name of the user. A new browser window opens and displays the user profile in XML format.

To delete user profiles:

- Click the Delete button in front of the user’s name. That user’s profile is deleted from the database.

To set the default user profile:

- Select the user with the profile that you want to set as the default. Click the Default button in front of that user’s name.

To refresh the data on the User Profiles page, use one of the following methods:
From the File menu, select Refresh.
Click the Refresh toolbar button.

Figure 7-15  Refresh Button


Managing ApplicationXtender Workflow Web Access

Managing Sessions

The Sessions page of the Administration window allows you to monitor and delete current ApplicationXtender Workflow Web Access sessions. From this page system administrators can monitor who is logged into the AppXtender Workflow Web Access system and for how long.

To view the Sessions page:

- From the View menu, select Sessions. The Sessions page appears.

<table>
<thead>
<tr>
<th>Session ID</th>
<th>User</th>
<th>Start Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>6e3e5397</td>
<td>Clay</td>
<td>14:50 08/16/2004</td>
</tr>
<tr>
<td>8cba54c9</td>
<td>Clay</td>
<td>14:42 08/16/2004</td>
</tr>
</tbody>
</table>

Figure 7-16  AppXtender Workflow Web Access Administration Site - Sessions Page

To delete sessions:

- Click the Delete button to the left of the Session ID. That session is deleted. If the user still has the AppXtender Workflow Web Access window open and attempts to work on any items, they will be redirected to the Login page to login again.

To refresh the data on the Sessions page, use one of the following methods:

- From the File menu, select Refresh.
- Click the Refresh toolbar button.
Monitoring Transactions

The Transaction Queue allows you to monitor each transaction, as it is committed, in the AppXtender Workflow Web Access system. You can set the data to automatically refresh, and/or you can manually refresh the data.

To view the Transaction Queue page:
- From the View menu, select Transaction Queue. The Transaction Queue page appears.

![Transaction Queue](image)

To manually refresh data:
- You have one of the following options:
  - From the File menu, select Refresh.
  - Click the Refresh toolbar button.

![Refresh Button](image)

To automatically refresh data:
- From the drop-down list labelled Automatically refresh data every, select one of the following options:
  - None
  - 30 Seconds
  - 45 Seconds
Managing ApplicationXtender Workflow Web Access

- 1 Minute
- 2 Minutes
- 5 Minutes
- 10 Minutes
Viewing ASP .NET Errors

The ASP .NET Error Log page allows you to view ASP .NET errors, which can also be viewed through the Windows Event Viewer. The Error Log page shows you the time the error occurred, as well as the first 60 characters of the error’s details.

To access the ASP .NET Error Log page:

To view the Error Log page:

◆ From the View menu, select Error Log. The Error Log page appears.

To view details about an error:

◆ Double-click the error for which you wish to see details. The Event Properties page appears.
Managing ApplicationXtender Workflow Web Access

To clear the error log:

- You have one of the following options:
  - From the File menu, select Clear Log.
  - Click the Clear Log toolbar button.

To refresh the data in the Error Log page:

- You have one of the following options:
  - From the File menu, select Refresh.
  - Click the Refresh toolbar button.
Figure 7-22  Refresh Button
Managing ApplicationXtender Workflow Web Access

Viewing Transaction Errors

The Transaction Error Log page allows you to view AppXtender Workflow transaction errors.

To view the Transaction Error Log page:

- From the View menu, select Error Log. The Error Log page appears.

![Transaction Errors](image)

Figure 7-23 AppXtender Workflow Web Access Administrator Site - Transaction Error Log Page

To resubmit a transaction to the Administrator:

1. Click the Resubmit button on the toolbar. A confirmation message appears.
2. Click OK to continue.
This appendix describes how to modify the appearance of reports.

◆ Introduction ................................................................. A-2
◆ WfxRpt.tpl ................................................................. A-4
◆ WfxTemp.xsl ............................................................. A-6
Reports in the ApplicationXtender Workflow (AppXtender Workflow) Administrator version 5.30 uses Microsoft’s Internet Explorer (IE) 6.0. The new report generator was developed in order to take advantage of features available in IE 6.0 to display. Specifically, IE supports XML data, which provides a greater potential for generating customized reports. The following diagram provides a visual representation of the new architecture, which allows end-user modification of report format.

![Figure A-1 Report Generation Architecture](image)

To customize reports, you must have knowledge of HTML, JavaScript, XML, and XSLT programming languages. This appendix is not intended to be a step-by-step procedure. This appendix is meant to provide administrators with specific concepts on how to change report presentation in AppXtender Workflow Administrator.

Two files are provided with ApplicationXtender Workflow installation, which help you customize reports: WfxRpt.tpl (template file) and WfxTemp.xsl. They are located in the WfXReports network share that was created during the installation of the product. The AppXtender Workflow extended stored procedure takes data from AppXtender Workflow database and merges that data with the WfxRpt.tpl to generate the actual HTML report. The WfxTemp.xsl file is used during display to transform XML into HTML for viewing.
Therefore, by modifying the WfxTemp.xsl file, you can change the look and feel of your reports.
Modifying Report Presentation

WfxRpt.tpl

The following is the WfxRpt.tpl file, which is used to generate the report. The extended stored procedure replaces the $XMLDATA in the template file with the XML data from the ApplicationXtender Workflow database.

```
<HTML>
<SCRIPT LANGUAGE="javascript">
function window_onload()
{
   var xsl;
   var xml;
   var xmlLoaded;
   var szOutput;

   xsl = new ActiveXObject("Microsoft.XMLDOM");
   xml = new ActiveXObject("Microsoft.XMLDOM");
   if ( xsl == null || xml == null )
   {
      alert("Failed to load XML DOM.");
      return;
   }
   xml.async = false;
   xsl.async = false;
   if(xsl.load("../wfxtemp.xsl") == false)
   {
      alert("Failed to load xsl file.");
      return;
   }
   xmlLoaded = xml.loadXML("$XMLDATA");
   if (xmlLoaded == false)
   {
      alert("Failed to load xml data.");
      return;
   }
   if ( xml.parseError.errorCode == 0 )
   szOutput = xml.transformNode(xsl.documentElement);
   else
   szOutput = "<H2><FONT color=red>Failed to parse XML</FONT></H2><H3>Error description: " + xml.parseError.reason + "<BR><FONT color=red>Line Error: " + xml.parseError.srcText + "</Font></H3>";
   if (szOutput == null || szOutput == "")
   alert("Failed to retrieve XML content.");
   else
   ResultDiv.innerHTML = szOutput;
}
</SCRIPT>
```
Modifying Report Presentation

```html
<BODY LANGUAGE="javascript" onload="return window_onload()">
  <div id="ResultDiv" align="left" width="100%" height="100%">
    <h2><br>Retrieving Results...<br></h2>
  </div>
</BODY>
</HTML>
```
The following is an example of XML data file. You can use this information to create your own XSL file or to modify the existing WfxTemp.xsl file provided.

```xml
<WfxReport Title='Report Title' Description='Report Description' TimeRun='14:54:43 11/02/00'>
    <SumQuery>
        SELECT RTRIM(PDEFBP.BPDefName) as Definition, count(*) as Total, SUBSTRING(BPStartTime, 1, 8) as Started FROM PBP, PDEFBP WHERE PBP.BPDefID = 1 and PDEFBP.BPDefID = PBP.BPDefID and SUBSTRING(BPStartTime, 1, 6) = convert(varchar(6), GetDate(), 112) GROUP BY PDEFBP.BPDefName, SUBSTRING(BPStartTime, 1, 8) ORDER BY SUBSTRING(BPStartTime, 1, 8)
    </SumQuery>

    <SumHeaders>
        <SumHeader HdrName='Business Process Definition'/>
        <SumHeader HdrName='Total'/>
        <SumHeader HdrName='Date Started'/>
    </SumHeaders>

    <SumCol>
        <SumItem ItemName='State machine' ItemAlign='left'/>
        <SumItem ItemName='5' ItemAlign='right'/>
        <SumItem ItemName='Nov 02, 2000' ItemAlign='right'/>
    </SumCol>

    <DetQuery>
        SELECT RTRIM(PDEFBP.BPDefName) as Definition, BPID, RTRIM(BPName), RTRIM(BPStateName), BPStartTime as Started, BPLastModified, BPEndTime as Completed FROM PBP, PDEFBP WHERE PBP.BPDefID = 1 and PDEFBP.BPDefID = PBP.BPDefID and SUBSTRING(BPStartTime, 1, 6) = convert(varchar(6), GetDate(), 112) ORDER BY BPID
    </DetQuery>

    <DetHeaders>
        <DetHeader HdrName='BP Def Name'/>
        <DetHeader HdrName='BP Id'/>
        <DetHeader HdrName='BP Name'/>
        <DetHeader HdrName='BP Status'/>
        <DetHeader HdrName='BP Start'/>
        <DetHeader HdrName='BP Last Modified'/>
        <DetHeader HdrName='BP End'/>
    </DetHeaders>

    <DetCol>
        <DetItem ItemName='State machine'/>
        <DetItem ItemName='2833'/>
        <DetItem ItemName='something'/>
        <DetItem ItemName='In Progress'/>
    </DetCol>
</WfxReport>
```
Modifying Report Presentation

<DetItem ItemName='09:18 Nov 02, 2000'/>
<DetItem ItemName='09:18 Nov 02, 2000'/>
<DetItem ItemName='N/A'/>
</DetCol>
</WfxReport>
This appendix describes the steps required to implement integrated security into your ApplicationXtender Workflow system. For more information, see:

- Implementing Integrated Security for AppXtender Workflow.. B-2
- Implementing Integrated Security for AppXtender Workflow Web Access................................................................. B-3
Implementing Integrated Security for AppXtender Workflow

To implement integrated security for AppXtender Workflow, you must configure the OS User name for each workflow identity. For detailed instructions, see Identities on page 3-39 and Importing User Identities on page 3-73.
Implementing Integrated Security for AppXtender Workflow Web Access

There are two steps that must be taken before you can use integrated security with AppXtender Workflow Web Access. You must configure the authentication methods in IIS as well as the web.config file for the AppXtender Workflow website.

For more information, see:

- Configuring IIS for Integrated Security on page B-3
- Editing the Web.Config File on page B-5

Configuring IIS for Integrated Security

Use the following procedure for setting the authentication methods in IIS for integrated security.

To configure IIS:

1. Open Internet Information Services (IIS), which can be found in the Administrative Tools.

Figure B-1  IIS Main Window

2. Right-click the server name and select Properties. The server Properties dialog box appears.
3. In the Master Properties section, click Edit. The WWW Service Master Properties dialog box appears.
4. Click the Directory Security tab to enable it.
5. In the Anonymous access and authentication control section, click Edit. The Authentication Methods dialog box appears.

Figure B-4  Authentication Methods Dialog Box

6. Disable the Anonymous access check box.
7. Enable the Integrated Windows authentication check box.
8. Click OK.

Use the following procedure for Editing the web.config file to use integrated security.

To edit the web.config file:

1. Open the web.config file (c:\inetpub\wwwroot\wfx\web.config, where C is the drive where AppXtender Workflow is installed).
2. Make sure it says <identity impersonate="true"/>.
A
about dialog box 4-14
action menu commands 4-5
active database 4-68
ad hoc workflow, definition 1-4
adding AppXtender index fields association 4-39
administration, remote 3-3
administrator’s site 7-2
all node 4-57
application field 4-48
application value field 4-48
ApplicationXtender 1-9
ApplicationXtender Web Access settings 7-9
ApplicationXtender Workflow for the Web
starting 7-2
ApplicationXtender Workflow Web Access Administrator’s site 7-2
impersonation account 7-10
logging in 7-3
logging out 7-4
monitoring transactions 7-15
page visibility 7-11
saving settings 7-6
sessions management 7-14
settings 7-5
user profiles 7-12
viewing errors 7-20
AppXtender data source 4-77
set new connection 4-39
AppXtender field association 4-38
add 4-39
configure 4-46
modify 4-44
remove 4-46
AppXtender Workflow
uninstalling 2-37
upgrading 2-42
AppXtender Workflow Administrator, exit 4-89
AppXtender Workflow Administrator, open 4-3
AppXtender Workflow environment 1-5
AppXtender Workflow Process Administrator
main window 3-4
menu bar 3-5
server menu commands 3-5
configure manager 3-7
connect 3-5
disconnect 3-6
pause/resume 3-7
start manager 3-7
stop manager 3-7
start 3-2
use 3-1
AppXtender Workflow Standalone Client
installation 2-43
uninstalling 2-48
AppXtender Workflow Web Access
introduction 1-11
archive database 4-68
archive instances command 3-13
archive instances immediately 3-18
deactivate an archive definition 3-17
delete a request from archive schedule 3-17
modify archive schedule 3-17
archived node 4-58
archiving an instance 4-62
assignments tab 3-50
association
**Index**

add 4-42  
modify 4-44  
remove 4-46  
association tab 4-38  
attach script 6-14  
authentication 3-41  
awsadmin 3-40  
awsmanager 3-40  
awssuser 3-40

**B**

before uninstalling 2-37  
between 4-34  
business process  
definition 1-3  
definition cache 3-9  
disable manual creation 4-39  
hide display of 4-38, 4-39  
instance cache 3-9  
instance navigation 4-61  
instances 4-56  
keyword 4-20  
printing a list 3-64  
properties 4-35  
report type 4-67  
transactions, monitor 4-22, 4-24, 4-25

business process command 3-52  
add a business process 3-53  
calendar 3-58  
delete a business process 3-61  
delete a business process instance 3-63  
external links 3-56  
installing a business process 3-53  
mapping roles 3-54  
mark a business process instance for archiving 3-63  
modify a business process 3-60  
printing a list of business processes 3-64  
retrieve a business process 3-61  
script execution 3-58  
view a business process instance 3-61  
view instances 3-61

business process shortcut menu 4-27  
apply filters 4-27  
navigation 4-27  
properties 4-35

association tab 4-38  
prerequisites 4-46  
details tab 4-37  
user defined list tab 4-49  
remove filter 4-35  
buttons 4-4

**C**

cache  
  business process 3-9  
  business process instance 3-9  
  workflow 3-9  
calendar 3-58  
  modify 3-65  
  view 3-65  
calendar commands 3-65  
  change the days off 3-66  
  create or modify a calendar 3-66  
  delete a calendar 3-67  
clear command 3-56  
calendar commands 3-58  
client, AppXtender Workflow  
  installing 2-43  
  uninstalling 2-48

columns  
  add 4-9  
  choose 4-9  
  remove 4-9

completed node 4-57

collection

configuration  
  mail 3-11  
  manager 3-7  
    housekeeping tab 3-10  
    tuning tab 3-8  
  Microsoft Exchange Server and Client 2-8  
  Microsoft SQL Server 2-6  
  on a single machine 2-9  
  on separate machines 2-11  
  Windows NT/2000 Server 2-7

collection, server properties 4-19

configuring  
  ApplicationXtender Web Access settings 7-9  
  impersonation account 7-10  
  page visibility 7-11  
  workflow settings 7-7

connection 3-5, 4-16  
connection, test 4-79
considerations, preliminary 1-5
copy command 3-36
copy to command 3-36
copyright information 4-14
CSV file, import user identities 3-76
current future work transfers 3-48
custom attributes tab 3-44
customer
   definition 1-3
   report type 4-68
Customer support xi
customer’s role, report type 4-68

data link properties
   adding 4-39
   modify 4-44
   remove 4-46
data source 4-77
   delete 4-79, 4-83
   new 4-79, 4-83
   set new connection 4-39
database
   active 4-68
   archive 4-68
   cleanup 2-40, 4-18
   settings table 4-23
day 4-68
definition
   ad hoc workflow 1-4
   business process 1-3
   customers 1-3
   observers 1-3
   performers 1-3
   rules 1-4
   workflow 1-3
delayed process command 3-28
   change the initiation time 3-29
   delete a delayed process instance 3-29
delete
   instance 4-64
   list of values 4-32
   reports 4-73
detach script 6-15
details tab 4-37
disable manual creation of a business process
   4-39
disconnect 3-6, 4-17
displaying reports 4-72
DLL registry command 3-30
   add DLL modules to the registry 3-30
   delete DLL attributes 3-32
   register files 3-30
   view DLL attributes 3-31
Documentation, related x

e
edit menu commands 3-34
   clear 3-36
   copy 3-36
   copy to 3-36
   filter 3-35
   find 3-37
   pause loggin/resume logging 3-35
e-mail
   address 3-12, 3-44
   triggering of business process 3-57
environment
   AppXtender Workflow 1-5
   equal to 4-34
   errors
   viewing 7-20
ESM
   log level 5-10
ESM properties page 2-32
exit
   AppXtender Workflow Administrator 4-89
   command 3-34
   Process Administrator 3-34
export identities 3-71
export list 4-12
expression operator 4-34
   between 4-34
   equal to 4-34
   greater than 4-34
   greater than or equal 4-34
   less than 4-34
   less than or equal 4-34
   not equal to 4-34
   external links 3-56
Index

F
factory ordinal 3-13
filter
  apply 4-27
  command 3-35
  list of values 4-29
  remove 4-35
  reset values 4-29
  set 3-36
  first page 4-27

G
go to page 4-61
greater than 4-34
greater than or equal 4-34

H
Help xi
help 4-13
help menu commands 3-71
hide, display of business process 4-38, 4-39
housekeeping tab 3-10

I
ID number 4-38
identities command 3-39
  add an identity 3-40
  check the status of an identity 3-45
  delete an identity 3-45
  export 3-71
  find an identity 3-48
  modify an identity 3-45
  print a list of identities 3-49
  transfer work 3-46
import
identities command 3-68
  setting up names service 3-69
identities from a CSV File 3-76
identities from Windows NT 3-73, 3-74
names assistant 3-68
names registry command 3-32
  add DLL modules to the registry 3-33
  delete DLL modules 3-34
user identities 3-73
in progress node 4-58

installation 2-21
  AppXtender Workflow on one machine 2-9
  AppXtender Workflow Standalone Client
  2-43
  AppXtender Workflow Workbox on a client machine 2-34
  completing 2-32
  components 2-4
  ESM properties page 2-32
  Microsoft SQL Server 2-6
  new business processes 3-67
  on separate machines 2-11
  Process Manager 2-13
  ready to install the application page 2-32
  service pack for Windows NT 2-7
  starting setup 2-21
  Windows NT/2000 Server 2-7
instance 4-56
  archive 3-13, 4-62
  archive immediately 3-18
  deactivate an archive definition 3-17
  delete 3-20, 3-63, 4-64
  delete request from archive schedule 3-17
  find 3-20
  modify archive schedule 3-17
  navigation 4-61
  pause 4-63
  properties 4-65
  restart 4-64
  restore 4-63
  retrieve 3-18
  select for retrieval 3-18
  sort 4-62
  view 3-19, 3-61
  working with 4-60
integrated security 3-2
internet mail 1-8
introduction
  AppXtender Workflow Web Access 1-11
IP address 4-19
isolated workflows 3-64

K
keyword
  business process 4-20
  clear 4-21
rename 4-21
  task 4-20
keyword substitution tab 4-20

L
last page 4-27
less than 4-34
less than or equal 4-34
License Server 4-19
link association 4-38
list of values 4-29
  add 4-32
  apply 4-32
  delete 4-32
  delete all 4-32
  replace 4-32
log level 5-10
log status, Process Administrator 3-4
logging out
  ApplicationXtender Workflow Web Access 7-4
login
  ApplicationXtender Workflow Web Access 7-3

M
mail
  configuration 3-11
  server 1-8
  tab 3-43
mail system 3-12
main window, Process Administrator 3-4
managing
  sessions 7-14
  user profiles 7-12
mapping roles 3-54
Microsoft Management Console (MMC) 4-2
monitor
  business process transactions 4-22, 4-24, 4-25
  services 4-23
monitoring transactions 7-15
month 4-68
MS Exchange Server 5.0 1-8

N
name 4-38
names service 3-69
navigation 4-27
  business process instances 4-61
new window from here 4-12
next page 4-27
node
  all 4-57
  archived 4-58
  completed 4-57
  in progress 4-58
  reports 4-59, 4-65
  temp 4-66
  users 4-60
  not equal to 4-34

O
observer, definition 1-3
offline 4-38
OLE calls 3-58
online 4-38
online help 4-13
open
  ApplicationXtender Workflow Administrator 4-3
operator 4-34
  between 4-34
  equal to 4-34
  greater than 4-34
  greater than or equal 4-34
  less than 4-34
  less than or equal 4-34
  not equal to 4-34
organization menu commands 3-38
business processes 3-52
calendar 3-65
identities 3-39
import identities 3-68
install new business processes 3-67
roles 3-49
organizational role
  add 3-50
  delete 3-52
  modify 3-52
  print a list 3-52
Index

P
page 4-27
page visibility
configuring 7-11
pause logging/resume logging 3-35
pause/resume manager 3-7
pausing an instance 4-63
performer
definition 1-3
report type 4-68
performer’s role
report type 4-67
poll interval 3-13
XtenderSolutions monitor 6-9
POP account 3-12
POP3 server 3-12
port 3-12
preliminary considerations 1-5
prerequisites 1-8, 4-46
remove 4-49
setting up 4-47
previous page 4-27
printing
a list of business processes 3-64
a list of identities 3-49
a list of organizational roles 3-52
reports 4-73
priority
change 4-87
Process Administrator
main window 3-4
menu bar 3-5
server menu commands 3-5
configure manager 3-7
connect 3-5
disconnect 3-6
pause/resume 3-7
start manager 3-7
stop manager 3-7
start 3-2
use 3-1
Process Manager
installation 2-13
uninstalling 2-40
properties
business process 4-35

instance 4-65
server 4-18

Q
q entries 3-11
query, segment the results 4-19

R
ready to install the application page 2-32
reassign users 4-86
reconcile users
AppXtender to AppXtender Workflow 4-83
AppXtender Workflow to AppXtender 4-79
assign a group 4-81
assign a password 4-82
assign a role 4-84
refresh 4-12, 6-16
remote administration 3-3
remove
AppXtender Workflow from the server 2-37
Workbox 2-37
reports 4-65
creating new 4-66
delete 4-73
displaying 4-72
modify presentation A-2
node 4-59
print 4-73
properties 4-66
run 4-71
scheduling 4-74
view 4-73
reset filter values 4-29
restarting an instance 4-64
restoring an instance 4-63
resume manager 3-7
retrieve instances command 3-18
delete instances 3-20
find instances 3-20
select instances for retrieval 3-18
view instances 3-19
roles command 3-49
add an organizational role 3-50
delete an organizational role 3-52
modify an organizational role 3-52
print a list of organizational roles 3-52
rules, definition 1-4
run database cleanup 2-40
running reports 4-71

S
saving setting
  ApplicationXtender Workflow Web Access 7-6
scheduler command 3-21
  add a new entry
  one time event 3-22
  recurring event 3-23
  delete an entry 3-28
  modify an entry 3-28
  scheduling reports 4-74
script
  attach 6-14
  detach 6-15
  execution 3-58
search 3-37
  expression 4-32
security
  integrated 3-2
segment results of a query 4-19
send only 3-13
sendmail 1-8
server menu commands 3-5
  archive instances 3-13
  configure manager 3-7
    housekeeping tab 3-10
    tuning tab 3-8
  connect 3-5
  delayed process 3-28
  disconnect 3-6
  DLL registry 3-30
  exit 3-34
  import names registry 3-32
  mail configuration 3-11
  pause/resume 3-7
  retrieve instances 3-18
  scheduler 3-21
  start manager 3-7
  stop manager 3-7
  server shortcut menu 4-15
  server shortcut menu commands
    connect 4-16
database cleanup 4-18
  disconnect 4-17
  properties 4-18
Service xi
  service tab
    server properties dialog box 4-21
services 4-21
  monitor 4-23, 6-12
  start monitoring 6-12
  stop monitoring 6-14
sessions management 7-14
settings
  ApplicationXtender Workflow Web Access 7-5
settings table tab
  server properties dialog box 4-23
setup wizard 2-21
SMTP server 3-12
SMTP/POP3 3-12
sort 4-62
SQL
  database 3-42
  dead locks 3-9
  server login ID 3-41
  server option 4-78
  server user connections 3-8
SQL Statistics 3-11
start
  AppXtender Workflow Process
    Administrator 3-2
  manager command 3-7
  XtenderSolutions monitor 6-3
starting
  ApplicationXtender Workflow for the Web 7-2
  stop manager command 3-7
suite 4-38

T
task keyword 4-20
task priority, change 4-87
Technical support xi
temp node 4-66
test connection 4-79
third party components 1-8
time out 3-13
Index

toolbar buttons 4-4
transaction manager service 4-21
transaction threads 3-8
transactions 7-15
transferring work 3-46
tuning tab 3-8
  business process cache 3-9
  business process definition cache 3-9
  transaction threads 3-8
  workflow cache 3-9

U
uninstalling
  AppXtender Workflow 2-37
  AppXtender Workflow from the server 2-37
  AppXtender Workflow Standalone Client 2-48
  before 2-37
  Process Manager 2-40
  Workbox 2-37
upgrading, AppXtender Workflow 2-42
user defined list 4-49
  add 4-49
  modify 4-51
  remove 4-53
user defined query 4-70
user identities, import 3-73
user profiles 7-12
user reassignment 4-86
user reconciliation 4-77
users node 4-60

V
version 4-38
version information 4-14
view
  calendar 3-65
  instances 3-61
  menu commands 4-9
  reports 4-73
viewing
  errors 7-20
  views, customize MMC 4-11

W
Windows NT, import user identities 3-73, 3-74
Workflow
  client installation 2-34
  uninstalling 2-37
workflow
  ad hoc 1-4
  cache 3-9
  customers 1-3
  definition 1-3
  isolated 3-64
  observers 1-3
  performers 1-3
  report type 4-67
  rules 1-4
workflow settings
  configuring 7-7

X
XtenderSolutions monitor 6-1
  attach a script 6-14
  clear error list 6-16
  detach script 6-15
  file menu 6-5
  help menu 6-8
  monitoring services 6-12
  polling intervals 6-9
  refresh 6-16
  settings dialog box 6-6
  start 6-3
  start monitoring 6-12
  stop monitoring 6-14
  view menu 6-6

Y
year 4-68